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第 1章

シンボルの概要

ここでは、LTspiceが供給する回路図シンボルについて述べています。

1.1 序

1.1.1 前書き

他の SPICEが、必要でしょうか。

アナログ回路シミュレーションは、アナログ IC設計にとって切っても切り離せないも

のです。SPICEシミュレータは、チップ上に形成する前に回路を試験する唯一の方法で

す。さらに SPICEシミュレーションは、他の手段では実行することの出来ない電流や電

圧の測定を可能とします。これらのアナログ回路シミュレータの成功は、回路基板のシ

ミュレーションにも適用されました。多くの場合ブレッドボードよりも、シミュレートす

ることが簡単です。そして機能や問題点のシミュレーションにおいて回路を解析する能力

は、きちんと理解された強靱な回路の設計を高速に行えます。

多くの商用 SPICEシミュレータを用いるならば、どの様にシミュレータは記述される

べきでしょうか。あるアナログ関数は、商用の SPICEシミュレータでシミュレートする

ことが極端に困難です。スイッチ・モード電源は、ゆっくりと動作する全閉路応答と同時

に高速にスイッチする方形波があります。このことは、スイッチング・レギュレータの全

体応答を見るために 100,000,000回シミュレーションしなければならないことを示して

います。商用の SPICEシミュレータは、普通に用いられている手法で実行し、多くの時

間を費やしています。スイッチ・モード電源のシミュレーション時間は、役に立つシミュ

レーションとして時間ではなく分の単位でなければなりません。

スイッチ・モード電源シミュレーションを高速に行えるアナログ・シミュレーション方

法がありました。しかし簡略化の手間において、任意の制御ロジックを実行できません

し、スイッチング波形が複雑であるところを十分にシミュレートすることもできません。

スイッチ・モード制御を実現する論理的な原理が搭載された新しい SPICEは、より良い

結果を生み出します。これは、高速なシミュレーションや詳細な波形を与え、任意の回路

変更に対し融通の利く機能を与えます。

SwitcherCAD IIIは、ボード・レベルのスイッチング・レギュレータ・システムをモデ

ル化するために開発された新しい SPICEです。新しい SPICEに組み込まれたたこととし

て、実際のボード・レベル部品をモデル化した素子があります。容量やインダクタは、直
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列抵抗やその他のサブサーキットあるいは内部ノードを用いないで、それらの寄生特性を

モデル化することが出来ます。またシミュレーション回路素子は、サブサーキットや内部

ノードを用いることなくゲート電荷の特性を正確に示すパワー MOSFETを導入していま

す。ノードの数を減らすために、シミュレータはスイッチング波形の精度あるいは詳細を

曖昧にすることなく、実行するシミュレーション時間を減少します。もう一つの新しいシ

ミュレーション・デバイスの長所は、基板レベル素子のようにモデルが全ての周波数にお

いて有限のインピーダンスを持つことによって、収束問題を回避しています。

現代のスイッチ・モード電源は、多くの動作モードを持つ制御された論理を含んでい

ます。例えば、デバイスは回路動作に応じてパルス・スイッチ変調からバースト・モー

ドあるいは繰り返しスキップへと変化することが出来ます。オリジナルの新しいミック

ス・モード・コンパイラやシミュレータは、SwitcherCAD IIIに記述されています。この

シミュレータは、計算速度を上昇させる現実のモデルとするため、上記の内容が含まれて

います。

SwitcherCAD IIIにおいて約 700の Linear Technologyの技術があります。このプログ

ラムは、Linear Technologyウエッブサイトから自由にダウンロードすることが出来ます。

そしてこのプログラムは、高機能な汎用のシミュレータです。このプログラムに含まれて

いるのは、次のようなデモンストレーション用ファイルがあります。ステップ入力の負荷

特性、サイクルごとのスタートアップおよび過渡応答特性などです。SPICEに含まれるの

は、全ての機能を持つ新しい回路入力のための回路図入力です。

SwitcherCAD IIIは、設計エンジニアの三つのタイプによって用いられるように設計さ

れています：設計者が行っていることを知る、設計者が知るべきことを考える、スイッチ

ング・レギュレータについて何も知らないと感じているタイプです。経験豊かな設計者

は、what ifプログラムを必要としています。これは最適な設計を見つけるため、回路を素

早く変更することです。初心者は、最も簡単な入力に基づいた、信頼おける設計による料

理本的なアプローチを必要としています。中堅の技術者は、彼の自由意志を実行してくれ

るプログラムを求めています。しかしこの SwitcherCAD IIIは、致命的な流れから彼を救

い出す優れたプログラムでしょう。

終わりに、我々は、非常に柔軟性を持ったwhat ifな電子設計ツールである SwitcherCAD

III を作りました。我々は、基本的に電圧や電力の要求に基づいた完全な初期設計サイク

ルを持つプログラムを書きました。このことは、巧く機能している回路で始めることの出

来る恐るべき設計者を実現します。回路を変形することに躊躇しない経験豊かな設計者と

します。そして我々が期待することは、良くない設計を防ぐ十分なセーフガードを供給す

ることです。

しかし SwitcherCAD IIIは、トータル・ソリューションを目指してはいないことに注意

して下さい。設計手順を簡単にする道具にすぎません。設計手順には、ブレードボードや

テストも含めなければいけません。シミュレーション結果で共通の認識を使って下さい。

1.1.2 SwitcherCAD III概観

SwitcherCAD IIIは、Linear Technology社が開発した、第三世代スイッチング・レ

ギュレータ設計プログラムです。このプログラムは、マクロモデル Swich Mode Power

Supply(SMPS)コントローラおよびレギュレータの新しい SPICE素子を含んだミックス・
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モード・シミュレータを拡張した高機能な SPICEシミュレータから構成されています。

このプログラムは、使用者が編集することの出来る SMPS回路あるいは新しい回路設計を

行うことが出来る一つに纏められた改装された回路図入力プログラムを含んでいます。含

まれている波形ビューアーは、シミュレーションした波形を表示し、シミュレーション・

データを解析することが出来ます。ほとんどの Linear Technologyのパワー ICのデータ・

ベースが含まれていますし、多くの受動素子が含まれています。素子データ・ベース、回

路図編集、シミュレーション制御それと波形解析が、一つのプログラムに含まれています。

ミックス・モード・シミュレーション機能とこれまでの SPICEプログラムを越えた多

くの機能により、シミュレーション速度は、精度を保ったまま飛躍的に改善されました。

詳細なサイクルごとの SMPSシミュレーションは、数分の内に実行され解析することが

出来ます。使用者は、素子、SPICEあるいは回路図入力プログラムを知らなくても数回

マウスをクリックするだけで、パワーシステムの詳細な解析結果を得ることが出来ます。

合成されたあるいは前もって記述されたデモ回路が、異なった電源要求に適合するように

回路を再構築するためのスタートとして用いることが出来ます。新しい回路図を作成した

後、シミュレーションを実行し報告書を作成することが出来ます。

プログラムに一体として組み込まれた階層化回路図入力や SPICEシミュレータは、汎

用の用途として問題なく使うことが出来ます。SPICEシミュレータ・エンジンの改良さ

れた機能は、汎用のアナログ回路シミュレーションに有効ですし、全ての電子回路技術者

に興味を抱かせるでしょう。すでに 500,000コピー以上が配布されていますし、多くの使

用者が次のように報告してくれています。LTspice/SwitcherCAD IIIは、主に使っている

シミュレータであり回路図入力ツールだと。我々は皆さんがこのプログラムを使うのを喜

び、役に立つことを期待しています。
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1.1.3 必要なハードウエア

LTspice/SwitcherCAD IIIは、PCで動作する windows 95, 98, 2000, NT4.0, Me,あるい

は XP上で動きます。windows 3.1あるいは DOS上では、動きません。シミュレーション

は、数分間に数メガバイトのデータを生成することが出来ますので、ハードディスクの空

きスペース ( >200MB)、RAM( >128MB)が必要です。基本的にプログラムは、windows

95あるいはそれ以上を用いた任意の PC上で動作します。しかしシミュレーションは、も

しハードディスクの十分な空き容量がないと完了しないかもしれません。

LTspice/SwitcherCAD IIIは、Linux上でも動きます。このプログラムは、WINE version

20030219を用い RedHat 8.0上で試験されました。

1.1.4 ソフトウエアのインストール

SwitcherCAD III は、LTC ウエッブサイト http://www.linear.com/softwareからダ

ウンロードすることが出来ます。配布されているファイルへの直接のリンクは、

http://ltspice.linear.com/software/swcadiii.exeです。このファイル swcadiii.exeは、自動解

凍 gzipファイルで、SwitcherCAD IIIをインストールします。

SwitcherCAD IIIは、しばしばアップデートされます。SwitcherCAD IIIが最初にイン

ストールされた後、組み込まれたメニュー・コマンドを使うことが出来ます。ウエッブに

接続しますと、現在のバージョンをインストールしようとします。アップデート・プロセ

スは、Linearのウエッブサイトから最初にマスター・インデックスをダウンロードしま

す。それは配布されたファイルの大きさとチェックサムです。もしファイルに抜けがある

と、つまり大きさが違っていたりインデックス・ファイルのチェックサムと異なっている

と、ファイルが自動的にアップデートされます。素子のデーターベースは、インストール

されている素子であるならばアップデート過程で実施されます。これらの素子は、アップ

デートで失われることはありません。

1.1.5 ライセンス

SwitcherCAD III--License Agreement/Disclaimer

Copyright @ 2001, Linear Technology Corporation

All rights reserved.

SwitcherCAD IIIは、Linear Technology Corporationのスイッチ・モード電力源合成お

よびアナログ回路シミュレーション・ソフトウエアです。

このソフトウエアは、著作権があります。皆さんは、LTC製品を自分のためにのみ、人

に渡さず、別の製品に適用したりしない限り自由に使うことが出来ますし、汎用の回路シ

ミュレータとして無料で実行することが出来ます。しかしソフトウエアを変更したり、何

かへ変換したり、逆コンパイル、逆アセンブルしたりすることは出来ません。LTCあるい

は使用者によって提供されるシミュレータの中で用いられている第三者のモデルの精度に
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ついて、何の責任も持ちません。

SwitcherCAD IIIの機能を補償するためあらゆる努力をしていますが、エラーが含ま

れていないことを補償するものではありません。このプログラムのアップグレード、変

更、修正は、LTCの判断で厳格に行われます。LTC製品を選択し評価する目的のために

SwitcherCAD IIIをインストールし動作させるときに問題が生じる場合、次の所に電話を

し、技術サポートを受けることが出来ます。

Applications Department at (408) 432-1900, between 8:00 am

and 5:00 pm Pacific time, Monday through Friday

しかし LTC製品の評価ではなく、一般的な回路シミュレーションについての技術的サ

ポートは受け付けられません。非常に多くの PC互換性コンピュータや OSバージョン、

その他の用法のため、それら全てのシステムについて SwitcherCAD IIIの完璧な動作を保

証するものではありません。SwitcherCAD IIIを使うことが出来ないようなら、LTCは必

要性によっては LTCスイッチング・レギュレータ ICの設計サポートを行います。

ソフトウエアおよび関連資料は、現状あるがままとして供給され、何の保証もありませ

ん。Linear Technology Corporationは、全ての保証を行いませんし、公表しません。しか

し特定の目的に対して商業上の限られた保証は行っています。詳細にではありませんが

LTCは、このソフトウエアの使用によってあるいは実行不可能な直接あるいは関係したダ

メージに対して責任を持っています。その様なダメージの関係したことに対して修正しま

す。このソフトウエアの再配布は、全ての資料例えばファイル、シンボルあるいは変更し

たり付け加えられていないを資料添付して、完全な形である限り許可します。

このプログラムは、特に製品の宣伝やデモンストレーションあるいは販売で半導体製造

メーカによって用いることは出来ません。これらの応用に対して SwitcherCAD IIIを用い

るためには、特別な許可を Linear Technologyから受けなければなりません。
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第 2章

動作モード

2.1 概要

SwitcherCAD IIIには、シミュレーションを動かす二つのモードがあります。

1. 一般の目的を持つ回路図入力ポログラムとして、統合されたシミュレータを用いる

こと。メニュー・コマンド File=¿New,それと File=¿Open（ファイル・タイプ .asc）

2. 手入力のネットリストとか異なった回路図入力ツールで作成した別の種類のネット

リストを用いること。メニュー・コマンド File=¿Open（ファイル・タイプ .cir）

LTspice/SwitcherCAD IIIは、汎用の目的を持った回路図入力プログラムとして、統合

された SPICEシミュレータをを供給するものです。理想的には自分で回路図を描き（あ

るいは既に用意された例題回路で初め）そしてシミュレーションでその動作を観察する

ことです。望んだ回路動作がシミュレーションで達成されるまで繰り返し回路設計を行

います。LTspice/SwitcherCAD IIIの初期のバージョンは、ユーザーが供給する特性から

SMPS設計を導くような合成器を含んでいました。しかしその機能のモードは止めになり

ました。

回路図は最終的にシミュレータが理解できるテキスト形式の SPICEネットリストへ変

換されます。一方ネットリストは、LTspice/SwitcherCAD IIIで描かれた回路図から通常

抽出されます。インポートされたネットリストは、回路図を作ることなく直接走らせるこ

とが出来ます。このことはいくつかの方法があります。(i) リニア・テクノロジーのフィ

ルタ合成プログラム FilterCADは、LTspiceがフィルタの時間軸や周波数軸応答のネット

リストを合成することが出来ます。(ii) 他の SPICEプログラム対してよりも LTspiceの方

が簡単です。(iii)SPICE回路シミュレータに対して経験豊かな人は、テキスト形式のネッ

トリストで直接にシミュレーションすることに慣れているでしょう。と言うのも昔のシス

テムでは回路図入力が SPICEシミュレータに含まれていなかったからです。

2.1.1 回路例

LTspice/SwitcherCAD IIIには、いくつかの例題回路が入っています。ディレクトリ c:

Program files

LTC

SwCADIII
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examples

Educationalにあります。これらの例題回路は、異なった解析タイプや方法あるいはプロ

グラム形式の非商用回路例が入っています。C:

ProgramFiles

LTC

SwCADIII

examples

jigsには、LTspice/SwitcherCAD IIIのマクロモデルである全ての Linear Technologyデバ

イスの例題シミュレーションがあります。これらの jig 回路は、マクロモデルのテスト jig

であって必ずしも推奨する設計ではありません。最も重要なことは、Linear Technology

オフィスが貴方の必要な設計サポートを供給することが出来ると言うことです。

2.1.2 汎用回路図入力 SPICE

LTspice/SwitcherCAD IIIは、無料の汎用の回路図入力、SPICEプログラムです。この

プログラムは、SMPS設計のみならず多くのアナログ技術の面に対して役に立ちます。例

題回路は、ディレクトリ C:/program Files/LTC/SwCADIII/examples/Educationalに様々な

LTspiceの可能性を示してあります。
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2.1.3 外部作成ネットリスト

手入力あるいは他の回路図入力プログラムによって作られるネットリストを開くことが

出来ます。これらのファイルの拡張子は、通常.cirとなっていますが.netや.apも認識し

ます。ネットリストファイルに用いられている ASCIIエディターは、無制限のファイル

サイズをサポートし undo/redoにも制限がありません。メニュー・コマンド Tools-¿Color

Preferencesは、ASCIIエディターで用いられる色を調整するために用いられます。

2.1.4 有能な報告書

キーワード”定常”を含む時間領域.tran解析から DC-DCコンバータの有能な報告書を

得ることが出来ます。定常状態シミュレーションの後、有能な報告書がコメント・テキス

トのブロックとして回路図上に示すことが出来ます。

DC-DCコンバータの能力は、次の方法で導かれます。入力と出力を区別するため一つ

の電圧源と一つの電流源がなくてはなりません。電圧源は入力に、そして電流源は出力と

仮定されます。回路はシミュレータによって定常状態が検知されるまで走ります。このこ

とはどの様にして定常状態を検知するかという情報を記述する SMPSマクロモデルが必
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要です。通常このことは、エラー・アンプ電流が一つのクロック・サイクルの平均値を取

るとき数サイクルの間に小さい値に減少するように検知されます。そこでクロックの端で

各リアクタンスに蓄えられるエネルギーが書き留められます。そしてシミュレーションは

次の 10サイクルを走ります。しかし全てのデバイスの電力消費を保存していきます。最

後のサイクルにおけるクロックの端で、全てのリアクタンスに蓄えられているエネルギー

が書き留められシミュレーションは止まります。効率は、リアクタンスに蓄えられたエネ

ルギーの変化を調整した後、供給される電力対入力電圧から供給される電力による比とし

て与えられます。各デバイスの消費電力もまた記録されるので、全てのエネルギーの和が

いかにゼロに近いかを見ることが出来ます。

エディット・コマンド・エディター上で”Stop simulating if steady state is detected”を

チェックして描いた SMPS回路の効率を常に計算することが出来ます。シミュレーショ

ン後にメニュー・コマンド View=¿Efficiency Reportを用いて下さい。

定常状態の自動検知は必ず働いているわけではありません。時々定常状態検知基準は、

非常に厳密でしかも時々寛大であります。そこでオプション・パラメータ SSTOLを調整

するか単に効率の制限を設定して下さい。

2.1.5 コマンドライン・スイッチ

フラッグ 記述
-ascii ASCII .rawファイルを用いる。プログラム機能を低下させる。
-b バッチモードで走らせる。例えば”scad3.exe -b deck.cir”は、deck.rawでデータを残す。
-big 最大ウインドウで走らせる。
- モデル・ライブラリを暗号化する。第三者などに対して。
encrypt 詳細な道具を見せびらかすことなくライブラリを用いるようにする。リニア・テクノロジのモデルでは使われていない。
- バイナリ.rawファイルのバッチ変換
FastAccess アクセス・フォーマットを急がせる。
-max -bigと同じ。
-nowine WINE(Linux)の使用を妨げる。
- PCBへのバッチによる回路図変換。
PCBnetlist ネットリストをフォーマットする。
- LTspiceをユーザーの希望値に保存する、MRU
y %EINDIR—%/scad3.iniファイル
-run runボタンを押さずにコマンド・ライン上に回路図を開きシミュレーションする。
-SOI サブサーキット展開でMOSFETが七つのノードまで持つことを許す。
- アンインストールのステップを実行する。
uninstall 過程
-web メニュー・コマンドを実行することに等しい。
update Tools=¿Syncリリース。
-wine WINE(Linux)を実行する。
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第 3章

回路図入力

3.0.6 基本的な回路図編集

回路図入力プログラムは、新しい回路図を作成したり既存の例題回路を変更したりしま

す。回路サイズと階層構造は、使っているコンピュータのリソースのみに依存します。

このソフトウエアは、約 800のシンボルが含まれています。これらのシンボルは、回

路設計のために次のようなものが含まれています。LTCパワー IC、オペアンプ、コンパ

レータ、そして汎用デバイス。このプログラムへインポートしたい自分の素子シンボルを

描くこともできます。

図 3.1 回路図編集

多くの回路図入力プログラムと違って、このプログラムは SPICEシミュレーションを

走らせるために特別に書かれています。つまり対象をクリックするとワイヤ上の電圧や素

子の電流を表示するようになっています。編集のために選択するのではありませんし、シ

ミュレーションを行わないようにビヘービアを選択するのでもありません。そのため移動

する、鏡像を求める、回転させる、素子を消すなどの動作を行うためには、最初にmove、
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drag、deleteコマンドを選択する必要があります。その後素子の上でクリックし、選択す

ることが出来ます。箱をドラッグすることによって、多数の素子を選択することが出来ま

す。右のマウスボタンをクリックするあるいは Escボタンが押されるまで、この状態が続

きます。全ての回路図編集で undo、redoを行うことが出来ます。

Undo 最後のコマンドを Undoします。

Redo 最後の Undoコマンドを Redoします。

Text 回路図上にテキストを配置します。これは単に情報を持った図を反映しているだけ

です。

SPICE Directive 図の上でネットリストに含まれているテキストを配置します。このコ

マンドは、回路図入力と SPICEネットリストとを一緒にします。シミュレーショ

ン・オプションを設定したり、モデルを含んだファイルを含めたり、新しいモデル

を定義したりあるいは他の有効な SPICEコマンドを用いたりします。シンボルを

持たないサブサーキット（SPICE上では X で始まります）を、回路図上にモデル

の特性を記述することによってまた定義を含ませることによって走らせることが出

来ます。

SPICE Analysis シミュレーション・コマンドに入り編集すること。このコマンドでは、

回路合成から直接回路を走らせることは出来ません。始め回路を拡張子.ascで保存

し、再び開いてシミュレーションコマンドを編集します。

Resistor 回路図に新しい抵抗を配置します。

Capacitor 回路図に新しい容量を配置します。

Inductor 回路図に新しいインダクタを配置します。

Diode 回路図に新しいダイオードを配置します。

Component 回路図に新しい素子を配置します。このコマンドは、シンボル・データ・

ベースを示し編集するためのダイヤログボックスを表示します。このダイヤログ

ボックスは、抵抗、容量、インダクタそれとダイオードについてのコマンドの汎用

的な書式となっています。

Rotate 選択された素子を回転します。素子が選択されていないときは、灰色となってい

ることに注意して下さい。

Mirror 選択された素子を鏡映します。素子が選択されていないときは、灰色となってい

ることに注意して下さい。

Draw Wire 左マウスボタンをクリックし、配線をスタートします。各マウスクリック

は、新しいワイヤを定義します。既に存在しているワイヤと新しいワイヤとを接続

するには、存在しているワイヤ上でクリックします。クリック一回は、現在のワイ

ヤ描画をキャンセルします。もう一度クリックしますと、コマンドを中止します。

抵抗の場合と同じように、素子を通過してワイヤを引くことが出来ます。抵抗がワ

イヤと直列になっているこのワイヤは、自動的にカットされます。

Label Net ノード名を特定します。その結果任意のノードは、ネットリストによって示

されません。

Place GND GROUNDシンボルを配置します。ノード 0で、全回路共通となります。

Delete 素子の上でクリックするあるいは、素子の上に Boxをドラッグして素子を消去し

ます。



13

Duplicate 素子の上でクリックし、あるいは boxをドラッグして素子を倍にします。

LTdpice/SwitcherCAD IIIを用いて開いている回路図から別の回路図へ、コピーす

ることが出来ます。最初の回路図ウインドウの Duplicateコマンドで始めます。次

に二番目のウインドウで Ctrl-V を押します。

Move 動かしたい素子周りのボックスをクリックしドラッグし、次に新しい場所へ移動

します。

Paste 素子が Duplicateコマンドで選択されているとき新しい回路図ウインドウに中で、

pasteすることが出来ます。

Drag dragしたい素子の周りの boxをクリックしドラッグします。次に新しい場所へ素

子を移動することが出来ます。そのときワイヤは、新しい位置までラバーバンドし

ます。

Draw => Line 回路図上でラインを引きます。この様なラインは、回路図上で電気的な

影響を与えません。しかしメモの付いた回路として有効です。

Draw => Rectangle 回路図に直角を描きます。直角は、回路図上で電気的な影響を与え

ません。しかしメモの付いた回路として有効です。

Draw => Circle 回路図に円を描きます。円は、回路図上で電気的な影響を与えません。

しかしメモの付いた回路として有効です。

Draw => Arc 回路図に円弧を描きます。円弧は、回路図上で電気的な影響を与えませ

ん。しかしメモの付いた回路として有効です。

Note 回路図へのグラフ的な注釈；ライン、直角、円および円弧；ディフォルトとしてワ

イヤやピンの電気的接触点に用いられている同じグリッドに接触します。この接触

を行わないためには、位置を保ったままコントロール・キーを押し続けて下さい。

3.0.7 ノード名のラベル

各ノードは、回路図の中で単独の名前でなければなりません。ネットリストが付けた

名前と、別の名前を付けることが出来ます。ノード 0は、回路のグローバルな名前です。

ノードの名前 0の代わりに、特別な描画シンボルとして書くことが出来ます。

ノード COMに対して定義された、描画シンボルもあります。これは SPICEのグロー

バルな共通シンボルではありませんし、グローバルなノードでもありません。グランドと

は区別された描画シンボルとして、便利さにより用いられています。

最初の文字として$G を用いる、例えば$G VDD は、ノードがグローバルであり、階層

回路に用いられます。
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図 3.2 ノード名のラベル

入力、出力あるいは両方向の端子であることを示すことが出来ます。これらの端子は、

異なった形状で描かれますが、ネットリストに対しては意味がありません。端子のタイプ

を示すことは、回路図を見やすくするためです。グローバルノードも、異なった形状で描

かれます。これらの名前は、、boxで囲まれた形で描かれます。

図 3.3 ノード

3.0.8 回路図の色

メニュー・コマンド Tools=> Preferences colorsは、回路図表示に用いられる色を設定

します。例題回路図の素子をクリックし、赤、緑、青のスライダーを好みの色に合わせて

下さい。*1

*1 電気的に関係のないグラフ例えばラインや円などは、素子と同じ色で描かれます。
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図 3.4 回路図の色

3.0.9 新しい素子の配置

よく用いられる素子；例えば抵抗、容量そしてインダクタ；これらは、ツールバー・ボ

タンを使って回路図上に配置するべく選ばれます。

ほとんどのシンボルに対して、メニュー・コマンド Edit => Componentを用い、必要

な素子を検索するためのダイヤログ・ボックスをスタートします。
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図 3.5 素子の配置

3.0.10 プログラム用キーボード・ショートカット

メニュー・コマンド Tools=> Control Panel=> Drafting Options=> Hot Keyは、ほと

んどのコマンド用キーボード・ショートカットをプログラムすることが出来ます。コマン

ドの上で単にマウスをクリックし、キーを押すかコマンドにしたいコードのキー・コンビ

ネーションを押します。ショートカットを削除するには、コマンド上でクリックし Delete

キーを押します。

図 3.6 ショートカット・キーの変更
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3.0.11 PCBネットリストの抽出

回路図メニュー・コマンド Tools=> Export Netlistは、PCBレイアウトの ASCIIネッ

トリストを生成します。ピン・ネットリスト順と同じ順番となっているシンボルのセッ

トを作っておかねばなりません。例えば LTspice回路図ネットリストを ExpressPCBへイ

ンポートしたいのであれば、使いたい全てのシンボルと同じ順番を持つネットリストの

LTspiceあるいは ExpressPCBのシンボル・セットを作らなければなりません。その他ダ

イオードは、ネットリストを反映させることが出来ますし、トランジスタの配線の接続

は、入れ替えることが出来ます。

次のフォーマットが使えます：Accel,Algorex, Allegro, Applicon Bravo, Applicon Leap,

Cadnetix, Calay, Calay90, CBDS, Computervision, EE Designer, ExpressPCB, Integraph,

Mentor, Multiwire, PADS, Scicards, Tango, Telesis, Vectron, and Wire List.

3.1 素子の編集

3.1.1 素子編集概要

素子は、素子タイプにより二つあるいは三つの異なった方法で編集することが出来ます。

1. ほとんどの表示される素子の特性は、マウスを用いて右クリックして編集すること

が出来ます。マウスのカーソルは、テキストのカレットに変化しテキストをしめす

ことが出来ます。

2. 多くの素子タイプ、例えば抵抗、容量、インダクタ、ダイオード、バイポーラ・ト

ランジスタ、MOSFETトランジスタ、JFETトランジスタ、独立電圧源、独立電流

源それと階層回路ブロックは、特別な編集機能を持っています。これらの編集機能

は、デバイスの適切なデータ・ベースを扱うことが出来ます。これらの機能を扱う

には、素子本体の上で右のマウス・ボタンをクリックします。

3. 素子シンボルの上にマウスを置き、コントロール・キーを押し下げます、それから

右のマウスボタンをクリックして下さい。ダイヤログ・ボックスが現れ、全てのシ

ンボル特性が表示されます。各々のフィールドの次で、フィールドが回路図上で表

示されるようにしたいところのチェックを入れて下さい。

3.1.2 表示特性の編集

ほとんどの表示される素子特性フィールドは、マウスを用い右クリックすることによっ

て編集することが出来ます。マウス・カーソルは、テキストを示すことによってテキス

ト・キャレットへ変わります。これは、素子の値を変更する種には便利な方法です。
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図 3.7 表示特性の編集

3.1.3 特別な素子編集

多くの素子タイプ、例えば抵抗、容量、インダクタ、ダイオード、バイポーラ・トラン

ジスタ、MOSFETトランジスタ、JFETトランジスタ、独立電圧源、独立電流源それと階

層回路ブロックは、特別な編集機能を持っています。これらの編集機能は、関係している

素子の適切なデータ・ベースにアクセスすることが出来ます。これらの編集機能を用いる

ためには、素子の上で右のマウス・ボタンをクリックして下さい。

図 3.8 特別な素子編集
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3.1.4 一般特性の編集

ときどき素子の内容と可視性を編集するために、全ての素子の特性について直接アクセ

スすることが必要になります。このことを実行するための編集機能は、素子シンボルの上

にマウスを置き、コントロール・キーを押し下げ、右のマウス・ボタンをクリックするこ

とによって実行できます。全ての有効な素子特性を表示するダイヤログ・ボックスが現れ

ます。回路図上に表示するかどうかの各フィールドに対するチェックボックスです。

図 3.9 一般特性の編集

3.2 新しいシンボルの作成

3.2.1 シンボル作成の概要

シンボルは、基本デバイス例えば抵抗あるいは容量；別なファイルにあるサブサーキッ

ト用ライブラリ；あるいは回路図の別のページを表現することが出来ます。ここではどの

様にして自分の新しいシンボルを定義するか、と言うことについて記述しています。新し

いシンボルを始めるに当たって、メニュー・コマンド File=> New Symbolを用います。*2

3.2.2 本体を描く

ライン、直角、円、円弧として、シンボルの本体を描くことが出来ます。描かれたもの

は、回路図上において電気的な特性を持ってはいません。Draw=> Textコマンドを用い

てシンボル上に、これも電気的に影響を及ぼさないテキストを描くこともできます。この

図形のアンカー・ポイントは、小さな赤い円で示されています。このアンカー・ポイント

は、素子をドラッグするときに使われます。メニュー・コマンド View => Mark Object

Anchorsを用いて、この赤い円を表示させたりさせなかったりすることが出来ます。

*2 シンボルを作成している間は、画面がアップデートされるのが遅くなります。使っておられるビデオ・
カードに問題があるようでしたら、画面を再描画する速度を上昇させるためにシンボル編集画面の面積を
小さくするあるいは、スクリーンの解像度を下げて下さい。それによってマウスの動きが改善されます。
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図 3.10 本体を描く

3.2.3 ピンを付け加える

ピンは、シンボルに電気的な節点を付け加えます。メニュー・コマンド Edit => Add

Pin/Portを用いて新しいピンを付け加えます。

図 3.11 ピンを付け加える

Pin Label Positionは、どの様にピンラベルを表示するかを決めます。TOP,BOTTOM,LEFT

および RIGHTは、テキストの並びを示しています。例えばピン・ラベルが TOPとなっ

ていると、ピン（ラベルの位置を決めるアンカー・ポイント）は、ラベルを上にします。

シンボルが SPICEのライブラリにある基本素子あるいはサブサーキットを表していると

き、ピン・ラベルは回路上で電気的な特性を持っていません。しかしシンボルが回路図階

層構造の下のレベルの回路を表しているときには、ピンの名前は回路図の下のレベルの回
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路図における名前として重要となります。

Netlist Orderは、このピンが SPICEのネットリストになる順番を決めます。

3.2.4 特性を付け加える

メニュー・コマンド Edit=> Attributes=> Edit Atributesを用いてシンボルのディフォ

ルト特性を定義することが出来ます。最も重要な特性は、Prefixと呼ばれます。これは、

シンボルの基本タイプを決定しています。シンボルが SPICEの基本的なところを表現し

ているならば、シンボルは適切な prefix、抵抗なら R、容量なら C、MOSFETなら M な

どを持つべきです。LTspiceの完全な SPICEの基本素子については、referenceを参照し

て下さい。ライブラリで定義されているサブサーキットを表現するシンボルを用いたいの

であれば、X という prefixを用いるべきです。

図 3.12 特性を付け加える

シンボルの特性は、回路図の成分としてシンボル特性において上書きされます。例えば

prefixとしてM のMOSFETシンボルがあるとしますと、instance-by-instance基準におい

て prefix Xを上書きすることが出来ます。この結果トランジスタは、サブサーキットとし

てモデル化されます。

特性の特別な結合があります。これは、シンボルとして用いる各回路図において自動的

に含まれる必要なライブラリとなります。

Prefix: X

SpiceModel: <name of file including the spicemodel>

Value: <What ever you want visible on the schematic>

Value2: <The value as you want in the netlist>
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Value2は、spicemodelに含まれるファイルで定義されたサブサーキット名と一致する

ように作られます。そして付加的なパラメータをサブサーキットへ転送することが出来ま

す。シンボルがこの方法で定義されますと、回路図素子としてのシンボルの特性は、異

なった特性を持つため編集することは出来ません。

階層的な回路図の別なページを表示するためのシンボルが必要な場合、全ての特性は、

左ブランクとすべきであってシンボル・タイプは Cellから Blockへ変えるべきです。何

の特性値も設定する必要がありません。

特別なシンボル特性 ModelFile があります。これはライブラリとして、ネッ

トリストに含まれるファイル名として用いられます。symbol/subcircuit pair

./lib/sym/Opamps/1pole.asyお よ び こ の 特 性 の ユ ー テ ィ リ テ ィ の 例 を 見 る た

め/lib/sub/1pole.subを見て下さい。prefix 特性が X であり、モデル・ファイルに定

義されたサブサーキットとしてシンボル特性 SpiceModelが存在する場合、シンボルの特

性が回路図上で編集されるとき全てのサブサーキットのリストは、有効となります。

3.2.5 特性の可視化

メニュー・コマンド Edit => Attributes=> Attribute Windowを用いて、特性の可視化

を編集することが出来ます。このダイヤログで特性を選択した後、シンボルに関係した希

望の位置に置くことが出来ます。

図 3.13 シンボル特性選択

特性を示すテキスト上を左クリックすることにより、既に可視化されたテキストや特性

の内容を編集することが出来ます。
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図 3.14 シンボル特性編集

3.3 階層

3.3.1 階層概論

階層的に回路図を描くことは、非常に大きなメリットがあります。非常に大きな回路

は、紙の上いっぱいに回路図を描くよりも、小さな明確に分かりやすい回路にして描くこ

とが出来ます。繰り返しの多い回路は、特殊な方法で簡単に取り扱えます。回路ブロック

は、別のプロジェクトで再利用するため、ライブラリ化することが出来ます。

3.3.2 階層化の規則

上の階層にあるブロックとして別の回路図として参照する方法は、ブロック図として同

じ名前を持ったシンボルを作成することです。そのシンボルをより上のレベルの回路図上

に置きます。例えば topXYZ.ascと名付けられたトップレベルの回路図 topXYZの回路図

に置きたい preamp.ascと名付けたもう一つの回路があり、それから preamp.asyと呼ぶシ

ンボルを作ります。topXYZの回路図上にそのシンボルを置きます。回路図間の電気的な

接続は、下のレベルの回路図でのノード名に対応した下のレベルでのブロックシンボル上

のピンに上のレベルの回路図のワイヤを接続することによって実現します。
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図 3.15 階層化の規則

LTspiceは、シンボルやブロック図をトップレベル回路図のディレクトリにおいて回路

が完全であることを検知します。

低いレベルを表現するために作ったシンボルは、特性を定義すべきではありません。

3.3.3 階層を見いだす

File => Openコマンドで開かれたファイルは、トップレベル回路と見なされます。そ

のブロックに SPICEディレクトリを付け加え、それと任意の参照したい低い階層の回路

図を使ってシミュレーションすることが出来ます。

より高い階層レベルの回路として回路ブロックを開くためには、最初に高い階層の回路

を開き、マウスを呼び出すブロック回路の本体の上に移動します。シンボルの上で右マ

ウスボタンをクリックすると、回路図を開くための特別なダイヤログボックスが開きま

す。この方法で回路図を開き、ブロックの電圧と電流を見ることが出来ます。コントロー

ル・パネルの Save Default Pane上にあるオプション Save Subcircuit Node Voltagesおよ

び Save Subcircuit Device Currentsをチェックすることに注意して下さい。またトップレ

ベル回路図上のノードを点滅させると、低い階層レベルにおいても点滅します。
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図 3.16 階層を見いだす

ダイヤログは、preamp.asc回路のブロックにパラメータを引き渡すことに注意して下

さい。
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第 4章

画像表示

4.0.4 概要

SwitcherCAD IIIは、シミュレーション結果を表示するための完全な機能を集めた波形

表示となっています。

4.0.5 波形選択

波形を選択する、三つの基本方法があります。

1. 回路図から直接選択する。

2. メニュー・コマンド Plot Settings=> Visible Traces

3. メニュー・コマンド Plot Settings=> Add Trace

どの様な選択方法にも関わらず、選択した異なった描画を再描画するための undoや

redoを行えます。

回路図から直接選択

最も簡単な方法は、単に回路図を選択することです。見たいと思うワイヤ電圧の上でワ

イヤを単にクリックします。任意の素子（抵抗、容量あるいはインダクタ）に流れている

電流が見たいときには、その素子の上でクリックします。この動作は、階層構造のどのレ

ベルでも有効です。多数のピンがある素子で、ある接続点に流れ込む電流を見たいときに

は、その素子のピンの上でクリックします。同じ電圧あるいは電流を二度クリックする

と、表示されているその他の表示は消えてしまい、ダブルクリックした表示だけが描かれ

ます。deleteコマンドを選び描画されたラベル上でクリックすることにより、個別に消去

することが出来ます。次の図は、どの様にピン電流を指し示すかと言うことを示していま

す。電流を示すときに、マウス・カーソルは電流メータのプローブのようなアイコンに変

化します。
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図 4.1 電流プローブの表示

ピン電流を示すとき、電流の正の方向は、通常ピンに流れ込む方向です。

マウスを用いて、電圧差を示すこともできます。一つのノードをクリックし、次にもう

一方のノードへドラッグします。最初のノードで赤い電圧プローブ、二番目では黒いプ

ローブへ変化します。こうすることにより、電圧差を見ることが出来ます。

図 4.2 電圧差の測定

もう一つ別の測定方法は、素子の瞬時電力測定です。これを行うには、素子記号の本体
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をクリックします。瞬時電力が電圧、電流表現として表示されます。この表示は、ワット

です。消費電力を測定しているとき、マウスのカーソルは、温度計のアイコンに変わりま

す。ラベルをクリックすると、平均電力を見ることが出来ます。

図 4.3 電力の測定

メニューコマンド Plot Setting => Visible Traces

メニューコマンド Plot Setting=> Visible Tracesは、シミュレーション・データを最初

に表示するときに見るダイヤログです。描画を始める最初の項目を選択します。描画でき

る全ての軌跡を示しています。

図 4.4 描画選択
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メニュー・コマンド View => Add Trace

メニュー・コマンド View => Add Traceは、Plot Settings=> Visible Traceコマンドに

似ています。しかしそれによって描かれた描画を消去することは出来ません。二つの便利

な方法があります。一つは、ダイヤログのすぐ上にあるボックスを編集することです。そ

れによって特性を入れることが出来ます。そのパターンに適合した描画の唯一の名前がダ

イヤログの中に示されます。これは、部分的に記憶している名前の描画を見つけだすのに

便利です。また描画データの表現を完成するのにも役立ちます。名前をタイプ入力する代

わりに、ダイヤログ上の名前をクリックして動かすことが出来ます。

図 4.5 描画の追加

4.0.6 拡大

LTspice/SwitcherCAD IIIは、新しいデータが表示されるときはいつでも自動的に拡大

されます。ある領域を拡大するとき、拡大して見たい領域の周りをボックスでクリックす

るだけです。
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図 4.6 拡大

拡大、パンニング、それと自動ズームに戻すためのツール・ボタンやコマンドがありま

す。undo、redoは、違った拡大を行った後に用います。

4.0.7 波形の計算

波形のデータを演算するための、三つの数学演算方法があります。

1. 結果表現を描く

2. 描画の平均値や RMS値を計算

3. 描画のフーリエ変換を表示

結果表現を描く

View => Visibleコマンドや View => Add Traceコマンドは、データ表現を入力する

ために使います。有効なシミュレーション・データを描画するもう一つの方法は、描画ラ

ベルへマウスを移動し、右クリックすることです。表示されるダイヤログボックスは、描

画色を設定できますしカーソルを波形に移動することが出来ます。LTspiceは、表示の大

きさの解析を行い、適切な単位で表示される縦軸に対して描画します。同じ単位の表示窓

にある全ての波形は、同じ軸上に描かれます。
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図 4.7 結果表現を描く

電圧の差；例えば V(a)−V(b)；は、V(a , b)と同じです。実データについて、次の関

数が使えます。

名前 関数

abs(x) 絶対値

acos(x) 逆余弦

acosh(x) 逆ハイパブリック余弦

asin(x) 逆正接

asinh(x) 逆ハイパブリック正弦

atan(x) 逆正接

atan2(y , x) y/xの逆正接

atanh(x) 逆ハイパブリック正接

bu f(x) x > .5ならば 1その他は 0

ceil(x) xに等しいか大きい整数

cos(x) 余弦

cosh(x) ハイパブリック余弦

exp(x) 指数

f loor(x) xに等しいか小さい整数

i f (x , y , z) x > .5のとき yその他は z

int(x) ｘを整数へ変換

inv(x) x > .5のとき 0その他は 1

limit (x , y , z) nim(max(x , y) ,z)と同じ

ln(x) 自然対数

log(x) 常用対数

log10(x) 底 10の常用対数

min(x , y) いずれか小さい方

max(x , y いずれか大きい方

rand(x) 0と 1の間の乱数

random(x) 0と 1の間の乱数、滑らかに変化

re(x) 実数部分

表 4.1:予約関数
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sgn(x) 符号；ジグン

sin(x) 正弦

sinh(x) ハイパブリック正弦

sqrt(x) 平方根

table(x , a , b , . . . テーブルとして xに値を付ける

tan(x) 正接

tanh(x) ハイパブリック正接

u(x) 単位ステップ関数

uramp(x) もし x> 0ならば、x、その他は 0

white(x) random()より滑らかな −0.5と 0.5の間の乱数

表 4.1:予約関数

複素数のデータに関しましては、atan2()、sgn( )、u() , bu f()、inv()、uramp()、int()、

f loor()、ceil()、rand()、min()、limit ()、i f (. . .)、table(. . .)は使えません。関数 Re(x)お

よび Im(x)は、複素数として使えます。Re(x)は、複素数の実数部で虚数部はゼロを示し、

Im(x)は、複素数の虚数部で実数部はゼロとして表示します。関数 Ph(x)および Mag(x)

も複素数に対して有効で、位相および絶対値として複素数として示します。関数 con j(x)

も複素数を扱うことが出来、xの複素共役を示します。

次の演算は、適用順位の逆優先順位でグループ化されていますが、実数データに対して

使えます。

記号 演算

& ブール代数の AND

| ブール代数の OR

^ ブール代数の XOR

< 左が右に較べ小さい場合は

> 左が右に較べ大きい場合は真

<= 左が右に較べ大きいか等しい場合は真

>= 左が右に較べ小さいか等しい場合は真

+ 加算

− 減算

∗ 掛け算

/ 割り算

∗∗ 左の数の右の数乗

! 逆

@ ステップ選択

表 4.2 演算子

真の数値は 1、偽の数値は 0です。値が 0.5より大きいと、ブール変換を行うと 1とな

り、以下では 0となります。

ステップ選択演算子@は、複数のシミュレーションが.step .tempあるいは.dc解析にお

いて有効であるときに役立ちます。特別なシミュレーションからのデータを選択すること
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が出来ます。例えば V(1)@3は、どの様なステップ描画しようとも三番目のシミュレー

ションからデータを描きます。

複素数データに対して、唯一 + , − , ∗ , / , ∗∗ , が使えます。複素数データと見なし

て、ブール代数の演算子 XOR；^は、指数演算子 ∗∗と見なされます。
次の定数は、国際的な定義でもあります。

定数記号 値

e 2.7182818284590452354

pi 3.14159265358979323846

k 1.3806503e−23

q 1.602176462e−19

表 4.3 定数

キーワード timeは、過渡解析波形データを表示するときに用いられます。同様に AC

解析では、freqおよび omegaです。wは omegaの代わりに用いられます。

描画の平均値や RMS値を計算

波形表示は、表示領域上の平均値や RMS値を計算することが出来ます。最初に必要な

領域の波形を拡大します。次にグラフの上にカーソルを移動し、コントロールキーを押し

ながら左のマウスボタンをクリックします。

図 4.8 波形の平均値と RMS値

描画のフーリエ変換を表示

メニュー・コマンド View => FFTによって、様々なデータの高速フーリエ変換を求め

ることが出来ます。
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図 4.9 高速フーリエ変換

4.0.8 ユーザ定義関数

メニュー・コマンド Plot Settings=> Edit Plot Defs Fileは、波形表示で用いる自分自身

の関数やパラメータを記入することが出来ます。これらの関数は、SwCAD III が実行で

きる scad3.exeとして、同じディレクトリにファイル名 plot.defsに保存されます。

シンタックスは、パラメータ化された回路に用いる.paramおよび.funcステートメント

と同じです。例えば次の行

.func Pythag(x , y){sqrt(x*x+y*y)}
は、二つの数値の和の平方根として、関数 Pythag()を定義します。

同様に次の行

.param twopi = 2*pi

は、twopiを 6.28318530717959と定義します。波形表示の中で、既に定義済である定数

piを用いていることに注意して下さい。

4.0.9 軸の制御

データが表示されている領域を越えてマウスカーソルを移動したとき、カーソルは定規

に変化します。これは、その軸の特性で表示しようとしています。左クリックするとダイ

ヤログが開き、その軸の範囲や描画の特性を入力できるようになります。例えば実数デー
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タに対して、画面の下へマウスを動かし左クリックすると、水平方向の描画範囲をダイヤ

ログへ入力することが出来ます。パラメトリック・プロットも行えます。

複素数のデータに対して位相、群遅延を描画するように選択できます。右側の縦軸に関

しては、何もしません。複素数による表現を、マウスを複素数データの左縦軸へ移動する

ことにより、ボード線図からナイキスト線図あるいは直角座標へと変換することが出来

ます。

4.0.10 描画画面

複数描画画面は、一つのウインドウ上に表示されます。描画はきちんと分離され、自動

的に座標が表示されます。描画は、ラベルをドラッグすることによりウインドウ間で移動

できます。描画のコピーは、、コントロールキーを押し下げマウス・ボタンを離すことに

より実行されます。

図 4.10 描画について

4.0.11 色の制御

メニュー・コマンド Tools=> Color Preferencesは、描画色を設定することが出来ます。

サンプル描画の対象物をクリックし、赤、緑、青のスライダーを用いて希望の色を調整し

ます。



37

図 4.11 色の制御

4.0.12 カーソルについて

カーソルは、二つまで使えます。描画ラベル上で、左のマウスボタンをクリックし両方

のカーソルを扱えるようになります。描画ラベル上で右クリックし 1st & 2ndを選択し、

一つのカーソルに対し二つのカーソルを扱えるようにします。1stあるいは 2ndあるいは

二つのカーソルを描画上で右クリックしカーソルのドロップダウン・ボックスを用いるこ

とによって使えるようになります。カーソルは、マウスでドラッグするかあるいはカーソ

ルキーで動かすことが出来ます。

図 4.12 二つのカーソル
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使用するカーソルがアクティブであるとき、読み出し可能な表示が、カーソルの場所と

違いが分かるように表示されます。

図 4.13 カーソルの表示

読み出しできるカーソルとは独立して、マウスのカーソルもあることに注意して下さ

い。波形ウインドウ上でマウスを動かしますと、マウスの位置がステータス・バー上に表

示されます。拡大するようにマウスをドラッグしますと、ボックスの大きさがステータ

ス・バー上に表示されます。これはマウスカーソルで、簡単に差を見る場合に便利です。

もし水平軸が時間である場合には、この時間差は周波数へも変換します。

図 4.14 カーソルの扱い

左のマウスボタンを離す前に、Escキーを押すか右のマウスボタンをクリックすること

によって、拡大することなく差を測定することが出来ます。
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図 4.15 カーソルによるステップ情報

カーソルは、.step/.dc/.tempシミュレーションのどの計算に属しているかを見つけるた

めに使うことが出来ます。up/downキーボードによるカーソル・キーをを用いてデータ

ベースからデータベースへとカーソルを移動させることが出来ます。そしてカーソル上で

右クリックしステップ情報を見ることが出来ます。

4.0.13 プロット条件の保存

メニュー・コマンド Plot Settings=> Save Plot Settings/Open Plot Settingsファイルは、

ディスクへのプロット条件の書き込み読み出しを可能にします。プロット設定ファイル

は、ASCII ファイルであり.pltの拡張子を持っています。ディフォルトのファイル名は、

データファイルの.raw拡張子から.plt拡張子を付けて求められます。もしデータファイル

を最初に開いたときこのファイルが存在しますと、プロット設定ファイルは最初のプロッ

ト条件を読み込みます。

各解析タイプ；.tran , .ac , .noiseなど；は、プロット設定ファイルに独自の入力を持っ

ています。一つのタイプから別のタイプを設定することは出来ません。しかし同じシミュ

レーション・タイプの別のシミュレーションからプロット設定ファイルを使うことは出来

ます。

4.0.14 高速アクセスファイル・フォーマット

シミュレーションの間 LTspiceは、圧縮されたバイナリ・ファイルを用います。これは

ファイルの残りを変更することなく、その他のシミュレーションデータを付加することが

出来ます。しかし一度シミュレーションが完了しますと、このファイル・フォーマットは、

ファイルに新しい一つの描画を付け加える速度を緩やかに実行させることが出来ます。

この時間を減らすために、ファイルを高速にアクセスするフォーマット、いつでも変更

することが出来ます。このフォーマットは、、シミュレーションが完了した後にのみ行う

ことが出来ます。そのあとに新しいデータは、何も付け加えられません。しかし一度この
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フォーマットへ変換させられますと、新しい描画に対する負荷時間は、ファイルに保存さ

れる描画データの数に比例して極端に減少します。例えば 2000描画データを持つ 5 [GB]

のファイルがありますと、新しい描画を描くのに４分掛かります。しかし高速ファイル

フォーマットへ変換しますと、４分の負荷時間が１秒間へ減少します。このことは、巨大

なシミュレーション・データであっても大きな回路の間でやりとりが出来るようになるこ

とを意味しています。高速アクセス・フォーマット・ファイルから描画を行う正確な時間

は、ハードディスクの速度よりも物理メモリの大きさに依存します。

波形表示ウインドウを高速アクセス・フォーマットへ変換するには、波形表示ウインド

ウをアクティブとし、メニュー・コマンド Files=> Convertを Fast Accessを実効します。

変換過程は、空きディスク容量が変換しようとしているファイルの大きさより大きい必要

があります。しかし返還後のファイルは、元のファイルよりわずか 11 [bytes]大きいだけ

です。

変換過程は、永い時間と搭載しているメモリの四分の一を使います。実際高速アクセ

ス・フォーマットへの変換は多くの時間が必要で、最初のシミュレーションに対して必要

です。変換に必要な正確な時間は、ハードディスク・フラグメントの状態と搭載している

物理メモリに依存します。変換の間マウスやキーボードの応答が遅くなります。次のシン

タックスを用いれば、バッチでファイル変換をすることが出来ます。

scad3.exe -FastAccess<file>

ここで <file>は、高速アクセス・フォーマットへ変換したい.rawファイルの名前です。

このフォーマットは、実数データに対してのみサポートされています。.ac解析から出

てくる複素数データに対しては、サポートされていません。
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5.0.15 LTspice概要

LTspiceは、SwitcherCAD IIIの回路シミュレータ・エンジンです。LTspiceは、回路図

入力シミュレーション・プログラムです。LTspiceシミュレータは、基本的な部分として

BSIM3v3.3.4その他の新しい MOSFETデバイスを含んだ Berkeley spice 3F4/5に基づい

ています。このシミュレータは、シミュレータ機能改善、バグのフィックスそれとシミュ

レータの拡張が行われ、その結果業界標準の半導体およびビヘービア・モデルとして動作

します。デジタル・シミュレータ機能としては、機能拡張してアナログ spiceシミュレー

タに組み込まれ LTspiceをスイッチング・レギュレータやスイッチド・キャパシタ・フィ

ルタの様な多くの種類の回路に使える優れたボードレベルアナログおよびミックスと・

モードシミュレータとなっています。

多くの Linear Technology製品が、カスタム・マクロモデルである正確で現実的な特性

を持った専門のビルディング・ブロックとしてモデル化されています。これによって電力

システム基板をプロトタイプとして直ちに作成することが出来ます。

LTspiceは、汎用の spiceシミュレータとしても用いることが出来ます。新しい回路は、

組み込まれた回路図入力で描くことが出来ます。シミュレーション・コマンドやパラメー

タは、確立された spiceシンタックスを用いて回路図上にテキストとして置かれます。回

路のノード電圧や素子電流は、シミュレーションの間あるいは後で、回路図のノード点を

マウスでクリックすることによって描くことが出来ます。

LTspiceは、Linear Technology Corporationの登録商標です。

5.1 入門

5.1.1 回路記述

回路は、テキストのネットリストによって定義されます。ネットリストは、回路素子、

ノード、モデル定義および spiceコマンドのリストから出来ています。

ネットリストは、普通グラフを用いて入力されます。新しく回路入力を始めるには、

File => Openメニューから始めます。ウインドウ・ファイル・ブラウザが現れます。既

にある回路を選びそれを新しい名前で保存するか、新しい空の回路を作って新しい名前と

して入力します。LTspiceは非常に多くのファイルや文章を扱います。拡張子.ascを持つ

ファイルを作りたいとします。回路図入力コマンドは、Editメニューにあります。このコ
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マンドに対するキーボード・ショートカットは、Schematic Editor Overviewのところにあ

ります。

回路図をシミュレーションするとき、ネットリスト情報は、回路図と同じ名前を持つ

ファイルへ回路図情報から抽出されます。ただし拡張子は、.netとなります。LTspiceは、

このネットリストで読み込みます。

手書きまたは別の回路図入力によって作られたテキスト形式のネットリストを開き、シ

ミュレーションを行い編集することが出来ます。拡張子.net、.cirあるいは.spのファイル

が、ネットリストとして LTspiceによって認識されます。

このヘルプの章では、ネットリスト上のシンタックスが文章化されています。しかし

時々回路図レベルのデバイスも述べています。

5.1.2 一般構造および用語

解析される回路は、ネットリストと呼ばれるテキスト・ファイルによって記述されてい

ます。ネットリストの最初の行は、無視されます。つまりコメントとなります。最後の行

は普通単に.END行で終わり、これも省略されます。.ENDから後の行は、無視されます。

コメントと.ENDの間にある行の順番は、特に関係がありません。各行は、コメント、

回路素子宣言あるいは、シミュレーション方法から構成されています。例を見てみま

しょう。

• 最初の行は、無視されます。
• 回路が 1 [MHz]方形波で駆動される RC回路を示しています。

R1 n1 n2 1k；ノード n1とノード n2の間の 1 [kΩ]抵抗

C1 n2 0 100p；ノード n2とグランドの間に 100[pF]の容量

V1 n1 0 PULSE(0 1 0 0 0 .5µ 1µ)；1 [MHz]の方形波

.tran 3µ；3 [µs]の過渡解析を実効

.end

最初の二つの行は、コメントです。∗で始まる行は、コメントで、無視されます。R1で

始まる行は、ノード n1と n2に接続された 1 [kΩ]の抵抗です。セミコロン；は、行の途

中でコメントが始まることを意味しています。C1で始まる行は、ノード n2とグランドの

間に 100 [pF]の容量が置かれることを意味しています。ノード 0は、グローバル回路の

共通グランドです。

次に示していますのは、LTspiceの用語概説です。

1. 空白や空欄タブは、無視されます。

2. 行の最初に現れる文字は、回路素子のタイプを示しています。

* コメント

A 特別な関数のデバイス

B 任意のビへービア電源

C 容量

D ダイオード
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E 電圧制御電圧源

F 電流制御電流源

G 電圧制御電流源

H 電流制御電圧源

I 独立電流源

J JFETトランジスタ

K 相互インダクタンス

L インダクタ

M MOSFETトランジスタ

O 損失のある伝送線路

Q バイポーラ・トランジスタ

R 抵抗

S 電圧制御スイッチ

T 無損失伝送線路

U 均一の RCライン

V 独立電圧源

W 電流制御スイッチ

X サブサーキット

Z MESFETトランジスタ

. シミュレーション方法を示します。例えば：.option reltol=1e-4

+ 継続行であることを示します。シミュレーションの中では、＋記号は取り外されそ

の前の継続行として扱われます。

数値は、科学表現；例えば　 1e12；技術表現を用いることが出来ます。1000.0や 1e3

は、1 [k]と書くこともできます。次の表は、よく理解されているサフィックスです。

サフィックス 数値

T 1e12

G 1e9

Meg 1e6

K 1e3

Mil 25.4e−6

M 1e−3

u(or µ) 1e−6

n 1e−9

p 1e−12

f 1e−15

表 5.1 サフィックスと数値

数値や技術表現の後に続く認識できない文字は、無視されます。つまり 10、10V、

10Voltsおよび 10Hzは、全て同じ数値です。また M、MA、MSec、MMhosは全て同じ

スケール 1e−3を示しています。共通のエラーとしてよく行われることは、1 MegaOhm

として 1M を用いることです。しかし 1M は、1 milliOhmとみなされます。不幸なこと
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ではありますが、標準の spiceでは、大切なことです。

LTspiceは、6K34と書かれた数値を 6.34Kと解釈します。この表現は、上記の表現に

おいて用いることが可能です。これは、Tools=> Control Panel=> spiceで、Accept 3K4

as 3.4kのチェックをはずすことによって解除することが出来ます。

ノードの文字は、任意の文字列を使うことが出来ます。グローバル回路の共通ノード

（グランド）は、0ですが特別な GND名称も使えます。ノードは、文字列ですので、0と

00は別のノードです。

マニュアルの次の章から、鍵括弧がデータ・フィールドに現れます。これには、特別な

情報が記載されています；例えば <srcname>は、ある特別な電源の名前です。四角括弧

は、囲まれたデータ・フィールドがオプションであることを示しています。

5.1.3 回路素子のクイック・レファレンス

素子 シンタックス

特別な関数 Axx n1 n2 n3 n4 n5 n6 n7 n8<model> [extra parameters]

任意のビヘービア電源 Bxx n+ n-<V=... or I=...>

容量 Cxx n+ n-<capacitance> [ic=<val.>] [Rser=<val.>]

+ [Lser=<val.>] [Rpar=<val.>] [Cpar=<val.>] [m=<val.>]

ダイオード Dxx A K <model> [area]

電圧制御電圧源 Exx n+ n- nc+ nc-<gain>

電流制御電流源 Fxx n+ n-<Vnam> <gain>

電圧制御電流源 Gxx n+ n- nc+ nc-<transcond.>

電流制御電圧源 Hxx n+ n-<Vnam> <transres.>

独立電流源 Ixx n+ n-<current>

JFET transい stor Jxx D G S<model> [area] [off] [IC=<Vds,Vgs>] [area] [off]

相互インダクタンス Kxx L1 L2 <coeff.>

インダクタンス Lxx n+ n-<inductance> [ic=<val.>] [Rser=<val.>]

+ [Rpar=<val.>] [Cpar=<val.>] [m=<val.>]

MOSFET Transistor Mxx D G S B ,model> [L=<len>] [W=<width>] [AD=<area>]

+ [AS=<area>] [PD=<perim>] [PS=<perim>] [NRD=<value>]

+ [NRS=<value>] [off] [IC= <Vds, Vgs, Vbs>] [temp=<T>]

損失のある伝送線路 Oxx L+ L- R+ R- ,model>

バイポーラ・トランジスタ Qxx C B E [S]<model> [area] [off] [IC=Vbe,Vce] [tem=<T>]

抵抗 Rxx n1 n2<value>

電圧制御スイッチ Sxx n1 n2 nc+ nc-<model> [on,off]

損失のない伝送線路 Txx L+ L- R+ R- ZO=<value> TD=<value>

均一 RC線路 Uxx n1 n2 ncommon<model>

独立電圧源 Vxx n+ n-<voltage>

電流制御スイッチ Wxx n1 n2<Vnam> <model> [on,off]

サブサーキット Xxx n1 n2 n3. . . ] <subckt name>

MESFET transistor Zxx D G S model [area] [off] [IC=<Vda,Vgs>]

表 5.2:クイック・レファレンス
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5.2 ドット・コマンド

シミュレーションを走らせるには、回路が定義されないといけないばかりか実行する解

析のタイプも指定しなければいけません。解析には、六つの異なった解析のタイプがあり

ます：線形小信号交流解析、直流スイープ、雑音、直流動作点解析、小信号直流伝達関数

および過渡解析。これらの六つの解析の一つを、明確な形で指定しなければいけません。

一方回路トポロジーは、常に回路図として描かれます。コマンドは、テキストとして回

路図上に置かれます。この様な全てのコマンドは、ピリオッドで始まります。そのため

ドット・コマンドと呼ばれます。

5.2.1 .AC

直流動作点の周りで、小信号交流線形解析を実行。

LTspiceの小信号（線形）交流解析は、周波数の関数として交流ノード電圧を計算しま

す。最初に回路の直流動作点電圧が計算されます。次に回路の非線形デバイスの線形化さ

れた小信号モデルが、動作点に対して求められます。最後に駆動する信号として、独立電

圧源や独立電流源を用いて、周波数のある範囲についての線形回路が計算されます。

この解析モードは、フィルタ、ネットワーク、安定性解析や雑音解析に対して有効です。

Syntax： .ac <oct, dec, lin> <Nsteps> <StartFreq> <EndFreq>

周波数は、StartFreqと EndFreqの間をスイープします。ステップ数は、次に示します

表に従いキーワード oct, dec, lin,および Nstepsで定義されます。

キーワード Nstep

oct オクターブ（二倍）当たりのステップ数

dec ディケード（１０倍）当たりのステップ数

lin StartFreqと EndFrqの間の等間隔ステップ数

表 5.3 .ACの Nsteps

5.2.2 .BACKANNO

サブサーキットのピン名称を端子電流へ接続する。

Syntax： .backanno

このコマンドは、回路図から自動的に SwitcherCAD IIIによって実行されます。LTspice

は、.rawファイルの情報を取り込み、ピン名称によって端子電流に反映させます。シンボ

ルのピンをマウスによってクリックすることにより、ピンに流れ込む電流を表示させるこ

とが出来ます。
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5.2.3 .DC

直流電源スイープ解析。

これは電源の直流値をスイープし、直流解析を実行します。増幅器の直流伝達関数を計

算したり、トランジスタ・モデルの特性を確認するための曲線を描かせたりするのに便利

です。

Syntax： .dc <srcnam> <Vstart> <Vstop> <Vincr>

[<srcnam2> <Vstart2> <Vstop2> <Vincr2>]

<Vstart>は、<Vstart>から <Vstop>まで、<Vincr>ステップでスイープする独立の

電圧源あるいは電流源です。

* Example .dc sweep

*

M1 2 1 0 0 nbsim

Vgs 1 0 3.5

Vds 2 0 3.5

.dc Vds 3.5 0 -0.05 Vgs 0 3.5 0.5

.model nbsim NMOS Level=8

.save I(Vds)

.end

5.2.4 .END

ネットリストの終わり。

このコマンドは、ネットリストが終わることを示しています。このコマンドの後のライ

ンは、全て無視されます。回路図のテキストとして、このコマンドを置いてはなりませ

ん。ネットリスト抽出が、終わりと判断してしまうためです。

5.2.5 .ENDS

サブサーキット定義の終了。

このコマンドは、サブサーキット定義の終了を示しています。詳しくは、.SUBCKTを

見て下さい。

5.2.6 .FOUR

.TRAN解析の後フーリエ成分を計算します。

Syntax： .four <frequency> [Nharmonics] [Nperiods] <data trace1>

[<data trace2>・・・]

Example: .four 1kHz V(out)
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このコマンドは、過渡解析の後で実行されます。一般に市販されている SPICEシミュ

レータと同じように与えられます。このコマンドの出力は、.logファイルに記述されま

す。出力結果を見るために、メニュー・アイテム View => Spice Error Logを用いて下さ

い。ほとんどの目的に対しては、waveform viewerにあります FFTが役に立ちます。

もし整数値の Nharmonicsが書かれていると、解析はその数だけ実行されます。特に指

定しなければ、高調波のディフォルト数は 9です。

フーリエ解析は、整数 Nperiodが Nharmonicsの後にない場合、最終時間 Tendから

Tend前の一周期分解析されます。Nperiodが −1となっていると、フーリエ解析は全ての

データ範囲で解析されます。

5.2.7 .FUNC

ユーザー定義関数。

Syntax： .func <name> ([args]) {<expression>}

Example: .func Pythag(x,y) {sqrt(x*x+y*y)}

コマンド.funcは、ユーザーによってパラメータ化される回路とビヘービア電源のユー

ザー定義関数を作成することが出来ます。このコマンドは、明確なパラメータ化されたサ

ブサーキットの関数を使うのに役立ちます。その結果抽象的な名前の回路をライブラリと

して登録することが出来ます。

.func記述は、サブサーキット定義の中に記述することが出来ます。このコマンドは、

そのサブサーキットおよびサブサーキットによって呼び出されるサブサーキットに対して

関数という制限を設けることが出来ます。

次の例は、.funcおよび.param記述です。

* Example deck using a .func statement

.func myfunc(x,y) {sqrt(x*x+y*y)}

.param u=100 v=600

V1 a 0 pulse(0 1 0 1n 1n .5^^ef^^bd^^b5 1^^ef^^bd^^b5)

R1 a b {myfunc(u,v/3)}

C1 b 0 100p

.tran 3^^ef^^bd^^b5

.end

全てのパラメータ記述内容は、シミュレーションが始まる前に実行されます。

5.2.8 .GLOBAL

グローバル・ノードの宣言。

Syntax： .global <node1> [node2] [node3] [・・・ ]

Example: .global VDD VCC
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.globalコマンドは、サブサーキットで記述されているあるノードがローカルなサブサー

キット・ノートと言うことばかりでなく絶対的なグローバルなノードを宣言するために用

いられます。

グローバルな共通ノードは、0でありグロ－バル宣言は必要ありません。また$ Gの名

前のノードは、.global statementで記述しなくてもグローバルです。

5.2.9 .IC

初期条件の設定。

.ic コマンドは、過渡解析の特別な初期条件を与えます。ノード電圧やインダクタ電

流の初期化が出来ます。直流解は、制限事項として実行されます。インダクタは通常、

spiceプログラムの直流解析で短絡回路として扱われます。もし初期条件が与えられます

と LTspiceにおいて無限のインピーダンスを持つ電流源として扱われます。

Syntax： .ic [V(<n1>)=<voltage>] [I(<inductor>)=<current>]

Example: .ic V(in)=2 V(out)=5 V(vc)=1.8 I(L1)=300m

5.2.10 .INCLUDE

別のファイルを挿入する。

Syntax： .include <filename>

このコマンドは、そのファイルが.includeコマンドの代わりにネットリストに記入して

いるかのように名前づけられたファイルを含ませます。このコマンドは、モデルやサブ

サーキットのライブラリを含ませるために役立ちます。

絶対パスをファイル名の中に含ませることが出来ます。その他 LTspiceは、最初にディ

レクトリ < SwCADIII >/lib/subを見に行き、次に呼ばれたネットリストを含んだディレ

クトリを見に行きます。ここで < SwCADIII >は、実行可能な scad3.exeを含んだディレ

クトリです。普通は、C:/Program Files/LTC/SwCADIIIにインストールされています。

ファイル名の拡張子は、特に指定していません。ファイルが myfile.libとしていれば、

inc myfileではなく.inc myfile.libを用いる必要があります。

ファイル名として、次の形式の urlを用いることも可能です。

.inc http://www.company.com/models/library.lib

ファイル library.libは、回路ディレクトリへ http転送され保存されます。引き続いたシ

ミュレーションに対して、シミュレーションするたびのダウンロードを避けるには、inc

記述を次のように編集することが出来ます。

.inc library.lib

もし urlが存在しなければ、ほとんどの webサーバーは、エラーを返してきません。し

かしブラウザ上にエラーを示す htmlウエッブ・ページを返してきます。LTspiceは、必

ずこれらのメッセージをエラーだと判断してくれるわけではありません。その結果シミュ
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レーションは、有効な spiceシンタックスとしてシミュレーションに含まれる html言語

エラーを含んだままシミュレーションを実行しようとして、奇妙なエラー・メッセージを

表示します。

もし転送される urlが.pdfファイルであるならば、シミュレーションは、ダウンロード

した後に停止してしまいます。例えば次の命令文は、このマニュアルを.pdfファイルとし

てダウンロードすることになります。

* Dummy simulation to download the help file.

* The simulation will abort with an error, but

* you’ll be left with the file scad3.pdf in the

* same directory containing the netlist.

.inc http://ltspice.linear.com/software/scad3.pdf

.end

5.2.11 .LIB

ライブラリを含ませる。

Syntax： .lib <filename>

このコマンドは、ファイルが.lib コマンドの代わりにネットリストへ記載するように名

前つきファイルのモデルやサブサーキット定義を含めます。グローバルな回路素子は、無

視されます。

絶対パス名が、ファイル名に入れられます。その他 LTspiceは、最初にディレクトリ

<SwCAD III>/lib/cmpを見ます。それから <SwCAD III>/lib/sub、次に呼ばれたネット

リストを含むディレクトリを見ます。<SwCAD III>は、実行可能な scad3.exeを含んで

います。一般には、C:/Program Files/LTC/SwCAD IIIとしてインストールされています。

ファイル名の指定はありません。ファイルをmyfile.libとするなら、lib myfileとすべき

でなく.lib myfile.libとしなければなりません。ファイル名として、次の形式の urlを用い

ることが出来ます。

.lib http://www.company.com/models/library.mod

ファイル library.modは、回路ディレクトリに転送され、ライブラリとして含まれます。

続くシミュレーションに対して、シミュレーションを走らせるたびにファイルをダウン

ロードすることがないように、.lib 記述を次のように編集することが出来ます。

.lib library.mod

もし urlが存在しなければ、ほとんどの webサーバーは、エラーを返してきません。し

かしブラウザ上にエラーを示す htmlウエッブ・ページを返してきます。LTspiceは、必

ずこれらのメッセージをエラーだと判断してくれるわけではありません。その結果シミュ

レーションは、有効な spiceシンタックスとしてシミュレーションに含まれる html言語

エラーを含んだままシミュレーションを実行しようとして、奇妙なエラー・メッセージを

表示します。
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もし転送られる urlが.pdfファイルであるならば、シミュレーションは、ダウンロード

した後に停止してしまいます。例えば次の命令文は、このマニュアルを.pdfファイルとし

てダウンロードすることになります。

* Dummy simulation to download the help file.

* The simulation will abort with an error, but

* you’ll be left with the file scad3.pdf in the

* same directory containing the netlist.

.inc http://ltspice.linear.com/software/scad3.pdf

.end

5.2.12 .LOADBIAS

以前に行った直流解析を呼び出す。

Syntax： .loadbias <filename>

.loadbiasコマンドは、.savebiasコマンドと対をなすコマンドです。最初にシミュレー

ションを走らせ、.savebiasコマンドを実行します。次に。差う゛ぇびあｓコマンドか

ら.loadbiasコマンドに変更します。

5.2.13 .MEASURE

ユーザー定義の電気的特性を展開。

二つの異なったタイプの.MEASURE記述があります。軸に沿った点に関するもの（独

立変数、すなわち.tran解析の時間軸）それと軸の上の範囲に関するものです。軸上の点を

示す最初のバージョンは、特別な点あるいはある条件の点でのデータ値あるいは表現を印

刷するために用いられます。次のシンタックスが用いられます。

Syntax： .MEAS[SURE] [AC|DC|OP|TRAN|TF|NOISE] <name>

+ [<FIND|DERIV|PARAM> <expr>]

+ [WHEN <expr> | AT=<expr>]]

+ [TD=<val1>] [<RISE|FALL|CROSS>=[<count1>|LAST]]

.MEAS記述が適用される解析タイプを、オプション的に述べることが出来ます。ある

解析タイプのみに.MEAS記述を用いることが出来ます。その名前は、結果に対して他

の.MEAS記述で用いることが出来るパラメータ名を与えることを求められます。下記は、

軸に沿った一つの点に対する.MEAS記述の例です。

.MEAS TRAN res1 FIND V(out) AT=5m

Print the value of V(out) at t=5ms labeled as res1.

.MEAS TRAN res2 FIND V(out)*I(Vout) WHEN V(x)=3*V(y)
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Print the value of the expression V(out)*I(Vout) the first time

the condition V(x)=3*V(y) is met. This will be labeled res2.

.MEAS TRAN res3 FIND V(out) WHEN V(x)=3*V(y) cross=3

Print the value of V(out) the third time the condition V(x)=3*V(y)

is met. This will be labeled res3.

.MEAS TRAN res4 FIND V(out) WHEN V(x)=3*V(y) rise=last

Print the value of V(out) the last time the condition V(x)=3*V(y)

is met when approached as V(x) increasing wrt 3*V(y). This will

be labeled res4.

.MEAS TRAN res5 FIND V(out) WHEN V(x)=3*V(y) cross=3 TD=1m

Print the value of V(out) the third time the condition

V(x)=3*V(y) is met, but don’t start counting until the time as

elapsed to 1ms. This will be labeled res5.

.MEAS TRAN res6 PARAM 3*res1/res2

Print the value of 3*res1/res2. This form is useful for printing

expressions of other .meas statement results. It’s not intended

that expressions based on direct simulation data, such as V(3),

are present in the expression to be evaluated, but if they are,

the data is taken from the last simulated point. The result will

be labeled res6.

上の例で、軸に沿った点に関して、要求される結果は、軸上のデータ（従属変数）に基

づいています。何も軸上の情報が要求されなければ、.MEAS記述は、測定条件が発生す

る軸上の点を印刷します。

.MEAS TRAN res6 WHEN V(x)=3*V(y)

Print the first time the condition V(x)=3*V(y) is met.

This will be labeled res6.

.MEAS記述の他のタイプは、軸上の範囲に関することです。次のシンタックスが用い

られます。

Syntax: .MEAS [AC|DC|OP|TRAN|TF|NOISE] <name>

+ [<AVG|MAX|MIN|PP|RMS|INTEG> <expr>]
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+ [TRIG <lhs1> [[VAL]=]<rhs1>] [TD=<val1>]

+ [<RISE|FALL|CROSS>=<count1>]

+ [TRIG <lhs2> [[VAL]=]<rhs2>] [TD=<val2>]

+ [<RISE|FALL|CROSS>=<count2>]

軸の範囲は、TRIGと TARGによって決められます。TRIG点は、省略されるとシミュ

レーションの開始をディフォルトとします。同様に TARG点は、シミュレーション・デー

タの終わりのディフォルトです。TRIG、TARGおよびWHENが省略されますと、.MEAS

記述は全てのデータ点に渡って働きます。ある範囲に渡って実行される測定のタイプは、

キーワード ある範囲での演算

AVG

MAX <expr>の範囲を計算

MIN <expr>の最大値を見つける

PP <expr>の最小値を見つける

RMS <expr>の peak-to-peakを見つける

INTEG <expr>を積分

測定が実施されなければ、.MEAS記述の結果は、TRIG点と TARG点間の軸上距離と

なります。次は、間隔を表す.MEAS記述の例です。

.MEAS TRAN res7 AVG V(NS01)

+ TRIG V(NS05) VAL=1.5 TD=1.1u FALL=1

+ TARG V(NS03) VAL=1.5 TD=1.1u FALL=1

Print the value of average value of V(NS01) from the 1st

fall of V(NS05) to 1.5V after 1.1us and the 1st fall of

V(NS03) to 1.5V after 1.1us. This will be labeled res7.

.AC解析に対して、複素データの条件付き表現は、表現を変換することにより実数条件

をその大きさへ変換されます。この例として

.MEAS AC rel8 when V(out)=1/sqrt(2)

rel8の結果は、V(out)の大きさが 0.7071067811865475に等しくなる周波数です。

また.MEAS記述の結果は、もう一方の.MEAS記述でも用いることが出来ます。この例

では、3 [dB]帯域幅が計算されます。

.MEAS AC tmp max mag(V(out)); find the peak response

; and call it "tmp"

.MEAS AC BW trig mag(V(out))=tmp/sqrt(2) rise=1

+ targ mag(V(out))=tmp/sqrt(2) fall=last

Print the difference in frequency between the two points 3dB



5.2 ドット・コマンド 53

down from peak response. NOTE: The data from a .AC analysis

is complex and so are the .measurement statements results.

However, the equality refers only to the real part of the com-

plex number, that is, "mag(V(out))=tmp/sqrt(2)" is equivalent

to Re(mag(V(out)))=Re(tmp/sqrt(2)).

AVG、RMS、INTEG演算は、.NOISE解析とは違います。と言うのも雑音は、周波数

全体に渡って二乗平均だからです。このことから AVG と RMSは、平均雑音を与えます

し、INTEGは積分した雑音を与えます。もし.noise解析に

.MEAS NOISE out_totn INTEG V(onoise)

.MEAS NOISE in_totn INTEG V(inoise)

SPICE演算付け加えると、全入力および出力の rms雑音が.logファイルに出力され

ます。

.MEAS記述は、シミュレーションが完了した後ポスト・プロッセッサーで実行されま

す。.MEAS記述を記入しデータセットを実行することが出来ます。このため波形表示ウ

インドウをアクティブとし、メニュー・コマンド File=> Execute .MEAS Scriptを実行し

ます。.MEAS記述のもう一方の手順がシミュレーション完了後ポスト・プロセッサーに

おいて実行されます。.MEAS記述の精度は、圧縮後の波形データの精度によって決めら

れます。.MEAS記述出力の精度について圧縮設定を調整することが出来ます。

品質を重要視する when<cond1> = <cond2>のような条件を調べるとき、用いてはな

りません。これは、浮動小数点を用いた等式は、保存された数字に用いられている有限の

精度に基づいているからです。

5.2.14 .MODEL

SPICEモデルの定義

ダイオード、トランジスタ、スイッチ、損失のある伝送線路あるいは均一の RC線路の

モデルを定義します。

ある回路素子例えばトランジスタは、多くのパラメータを持っています。トランジスタ

の多くの特性を決める全てのパラメータを定義する代わりに、トランジスタはモデル名で

グループ化され、共通のパラメータを持っています。同じモデルのトランジスタは、異

なったサイズを持つこともあります。そして電気的な振る舞いは、特性のサイズを変更で

きます。

Syntax: .model <modname> <type>[(<parameter list>)]

モデルの名前は、一つでなければいけません。回路素子の二つの異なったタイプ、例え

ばダイオードとトランジスタは、同じ名前を用いることは出来ません。パラメータのリス

トは、モデルのタイプに依存します。下記表はモデルのタイプのリストです。
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タイプ 対応する回路素子

SW 電圧制御スイッチ

CSW 電流制御スイッチ

URC 均一分布 RCモデル

LTRA 損失のある伝送線路モデル

D ダイオード・モデル

NPN NPN BJTモデル

PNP PNP BJTモデル

NJF Nチャネル JFETモデル

PJF Pチャネル JFETモデル

NMOS NチャネルMOSFETモデル

PMOS Pチャネル MOSFETモデル

NMF Nチャネル MESFETモデル

PMF PチャネルMESFETモデル

VDMOS 縦型二重拡散電力 MOSFETモデル

どのパラメータが特性値であるか、モデルに共通であるかのリストについて、素子の記

述を見て下さい。

5.2.15 .NET

.AC解析で、ネットワーク・パラメータを計算

この記述は、小信号 (.AC)解析で、二端子網の入出力アドミタンス・インピーダンス、

Ｙパラメータ、Ｚパラメータ、ＨパラメータおよびＳパラメータを計算するために用いら

れます。一端子網の入力アドミタンスやインピーダンスも計算することが出来ます。この

記述は、.AC記述と一緒に用いなければいけません。.AC解析は、ネットワーク解析の周

波数範囲を決めます。

Syntax: .net [V(out[,ref])|I(Rout)] <Vin|Iin>

+ [Rin=<val>] [Rout=<val>]

ネットワーク入力は、独立電圧源 <Vin> あるいは独立電流源 <Iin> によって決まり

ます。オプションの出力端子は、ノード <V(out)>あるいは抵抗 <I(out)>によって決ま

ります。端子は、抵抗 Rinおよび Routで終端されます。特に定めなければ、端子のディ

フォルト・インピーダンスは、Rserによって定められる電圧源あるいは抵抗のある出力端

子の場合を除いて 1 [Ω]となります。これら二つの場合終端のディフォルト・インピーダ

ンスデバイスのインピーダンスです。.NET記述で決められた端子の値は、.NETによっ

て計算されたデバイス・インピーダンスを上書きします。しかし通常の.ACノード電圧や

電流には影響を与えません。すなわち.NET記述は、.通常の電圧や電流のネットワーク上

で端子インピーダンスに影響せず、AC解析の部分として計算されます。

C:/Program Files/LTC/SwCADIII/examples/Educations/S-paramのファイルを見て下さ

い。Rserを望ましい電源インピーダンスとして、電圧源 V4を用いること、.NET記述と

して単に.net I(Rout) V4と出力端子を設定することを進めています。Rinあるいは Rout

が.NET記述になければ、入出力デバイスの値が用いられます。これらの設定は、。AC解

析のノード電圧や電流を.NET記述と同じ方法でネットワークを終端します。
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5.2.16 .NODESET

最初の直流解析に対するヒントを与えます。

.nodesetコマンドは、直流動作点解析のためのヒントを与えます。もし回路が例えばフ

リップフロップのように複数の動作点状態を持つならば、直流動作点状態を求める解析は

決して収束しません。.nodesetコマンドは、一つあるいはもう一つのの状態へと回路を導

くために用いることが出来ます。基本的には、.nodesetコマンドで与えられた電圧に解が

到達した後、この制限は繰り返し計算を停止します。

Syntax: .NODESET V(node1)=<voltage> [V(node2)=<voltage [...]]

5.2.17 .NOISE

雑音解析を実行

この解析は、周波数領域で行われます。ジョンソン、ショットおよびフリッカ雑音を計

算します。出力データは、単位帯域幅当たりの二乗信号電圧の平方根です。

Syntax: .noise V(<out>[,<ref>]) <src> <oct, dec, lin>

+ <Nsteps> <StartFreq> <EndFreq>

V(<out>[,<ref>]) は、全出力雑音が計算されるノードです。これは二つのノード間

電圧を表現する V(n1, n2) として計算されます。<src> は、入力雑音が参照する独立

電源の名前です。<src> は、雑音のない入力信号です。パラメータ <oct, dec, lin>、　

<Nsteps>、　 <StartFeq>、および <EndFreq>は、必要な周波数範囲を決め、.ACコマ

ンドを用いて解析されます。

出力データ軌跡 V(onoise)は、上記シンタックスで出力として決められたノードに関す

る雑音スペクトル電圧密度です。もし入力信号が電圧源として与えられていますと、デー

タ軌跡 V(inoise)は、入力に対する雑音電圧密度です。入力が電流源として与えられてい

ますと、データ軌跡 inoiseは、入力電流源に関係しています。各素子の電圧への寄与が描

かれます。これらの寄与は、出力に関係しています。これらをデータ軌跡 gainで割るこ

とにより、入力へ換算することが出来ます。

波形表示は、<Ctrl-Key>と対応するデータ軌跡ラベル上を左マウスボタンをクリック

することにより帯域幅当たりの雑音を積分することが出来ます。

5.2.18 .OP

直流動作点を見いだす。

容量は開放状態、インダクタンスは短絡状態で直流解析を実行します。通常直流解析

は、回路の動作点を見つけるため解析の一部として実行されます。もし動作点だけを求め

たいのであれば、.OPを用いて下さい。.OPシミュレーションの後、ノードあるいはブラ

ンチ上でクリックすると、.OP解がステータス・バー上に表示されます。
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5.2.19 .OPTIONS

シミュレーション・オプションの設定

キーワード データ デフォルト 説明

abstol num. 1 pA 絶対電流誤差余裕

baudrate num. (none) アイ・ダイヤグラムで用いる。

波形描画パッケージに、どの様にしてビットを

重ねるために時間軸をそろえるかを告げる

chgtol num. 10 fC 絶対電荷余裕

defad num. 0. デフォルトMOSドレイン拡散面積

defas num. 0. デフォルトMOSソース拡散面積

def1 num. 100µm デフォルトMOSチャネル長

defw num. 100µm デフォルトMOSチャネル幅

delay num. (none) アイ・ダイヤグラムで用いられる。

ダイヤグラムでビット変化をさせる。

flagloads flag false 負荷として外部電流源を示す。

frain num. (none) 周波数解析の入力端子

fraout num. (none) 周波数解析の出力端子

frastop num. (none) 周波数解析の高周波端

frastart num. (none) 周波数解析の低周波端

fraamp num. (none) 周波数解析の周波数関数振幅

fravref num. (none) 周波数解析の付加的な直流オフセット

Gmin num. 1e−12 収束性改善のために全ての PN接合

に加えられるコンダクタンス

gminsteps num. 25 初期直流解の gminsteppingを使う

ため non-zeroを設定

itll num. 100. 直流繰り返しカウント・リミット

itl2 num. 50. 直流伝達曲線繰り返しカウント・リミット

itl4 num. 10. 過渡解析時間点繰り返しカウント・リミット

itl6 num. 25. 電源ステップで用いられるステップ数

（直流動作点を求めにくいときに用いられる）

srcsteps num. 25. itl6 の変数名

maxclocks num. infin. 保存されるクロックサイクルの最大数

maxsteps num. infin. 過渡解析の最大ステップ・サイズ

measdgt num. 6 .measure記述出力で用いられる重要な図の数

method string trap 数値積分法、台形あるいは道具一式

minclocks num. 10 保存されるクロック・サイクル数

nomarch flag false マーチング・ウエーブフォームを描画しない

noopiter flag false 直接 gminステップへ行く

numdgt num. 6 歴史的に numdgtは、出力データに用いら

れる重要な図の数を設定するために用い

られました。LTsoiceでは、numdgtが 6以上

に設定されると従属変数データで倍精度が

用いられます。

oversample num. (none) 周波数応答解析用

pivrel num. 1e−3 もっとも大きな入力と需要可能な値との相対比

pivtol num. 1e−13 ピボットとして受け入れられる行列入力の最小値
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reltol num. 0.001 相対誤差余裕

startclocks num. 5 定常状態を見いだす待機クロック・サイクル数

sstol num. 0.001 定常状態検知のための rel.誤差

temp num. 27degC 特に指定しないときの素子デフォルト温度

tnom num. 27degC デバイス・パラメータが温度を特別に

指定しないときモデルに対して測定

されるディフォルト温度

topologycheck num. 1 フローティング・ノードおよび電圧源のループの

チェックをスキップするためにゼロを設定します。

trtol num. 1.0 過渡解析誤差余裕の設定。

このパラメータは、実際の過剰見積もりされる

打ち切り要素を見積もる。

trytocompact flag not set シミュレータは、フラッグが立つとき

LTRA 伝送線路の入力電圧、

電流を圧縮しようとします。

vntol num. 1 µV 絶対電圧誤差余裕を設定

plotreltol num. .0025 波形圧縮の相対誤差余裕を設定

plotvntol num. 10 µV 波形圧縮の絶対誤差余裕を設定

plotsbstol num. 1 nA 波形圧縮の絶対電流誤差余裕を設定

plotwinsize num. 300 一つのウインドウで圧縮するデータ点の数。

圧縮を設定

5.2.20 .PARAM

ユーザー定義パラメータ

.paramは、ユーザー定義変数の生成が出来ます。これを用いることによって、分かりや

すくする名前を持たせたり、サブサーキットをパラメータ化することが出来ます。その結

果抽象化された回路をライブラリとして保存することが出来ます。

.param記述は、サブサーキット定義に含ませることが出来ます。サブサーキットおよ

びそのサブサーキットによって呼び出されるサブサーキットのパラメータに制限を加え

ます。

パラメータの記述および展開したものを呼び出すには、丸括弧の表現を閉じます。閉じ

られた表現は、フローティング点の値で置き換えられます。

次に.param記述およびサブサーキット記述上に直接パラメータを転送する例を示し

ます。

*

* This is the circuit definition

.params x=y y=z z=1k*tan(pi/4+.1)

X1 a b 0 divider top=x bot=z

V1 a 0 pulse(0 1 0 .5^^ef^^bd^^b5 .5^^ef^^bd^^b5 0 1^^ef^^bd^^b5)

* this is the definition of the subcircuit
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.subckt divider n1 n2 n3

r1 n1 n2 {top}

r2 n2 n3 {bot}

.ends

*

.tran 3^^ef^^bd^^b5

.end

パラメータ代入の図は、シンボリック宣言言語です。そのパラメータは、展開された値

としてサブサーキットへ送られるのではなく、それ自身の表現や関連性によって送られま

す。丸括弧に出会ったとき、閉じられた表現は、全ての関係に基づいて展開されます。そ

してフローティング点の値に集約されます。

次の関数や演算が使えます。

関数名 記述

abs(x) xの絶対値

asoc(x) arccosの実部　例 asoc(-5)は、3.14159であり 3.14159+2.29243iではない。

arccos(x) acos()と同じ

acosh(x) 双曲線関数 cosの実部　例 acosh(.5)は、ゼロであり 1.0472iではない。

asin(x) sinの逆関数　例 asin(-5)は、-1.57080であり-1.57080+2.29243iではない。

arcsin(x) 亜新（）と同じ

asinh(x) 双曲線 sin逆関数

atan(x) tan()の逆関数

atan2(y, x) y/xの四分の一

atanh(x) 双曲線関数の逆関数

buf(x) x¿.5のとき 1、その他はゼロ

cbrt(x) xの自乗平均

ceil(x) xと等しいか大きな整数

cos(x) 余弦関数

cosh(x) cosの双曲線関数

exp(x) 指数関数

fabs(x) abs(x)と同じ

flat(x) 均一分布をしたランダムな数

floor(x) xと同じか小さい整数

gauss(x) ガウス関数をしたランダムな数

hypot(x,y) sqrt(x**2+y**2)

if(x,y,z) x¿.5のとき yその他は z

int(x) xを整数に変換

inv(x) x¿.5のときゼロその他は 1

limit(x,y,z) x,y,zの中間値

ln(x) 自然対数
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log (x) 常用対数

log 10(x) 底 10の常用対数

max(x,y) x,yの大きい方

mc 均一分布をした x*(1+y) と x*(1-y) のランダムな数

min(x,y) x,yの小さい方

pow(x,y) x**y の実部　例 pow(-.5,1.5)はゼロであり 0.35355iではない。

pwr(x,y) abs(x)**y

pwrs(x,y) sgn(x)*abs(x)**y

rand(x) ｘの整数値に依存したランダムな数

random(x) rand(x)と似ているが値がなめらかに変化する。

round(x) xに一番近い整数

sgn(x) xの符号

sin(x) 正弦

sinh(x) sinの双曲線関数

sqrt(x) xの平方根の実部　例 sqrt(-1)はゼロであり 0.707107iではない。

table(x,a,b,c,d,. . . ) 点のペアの組として与えられたテーブルに xの値を加える。

tan(x) 正接

tanh(x) 正接関数の双曲線関数

u(x) 単位ステップ x¿0のとき 1その他はゼロ

uramp(x) x¿0のとき xその他はゼロ

次の演算は、展開の逆順にグループ化されています。

演算 記述

& ブール代数へ変換する。AND

— ブール代数へ変換する。OR

ˆ ブール代数へ変換する。XOR

¿ 左側が右側より大きいとき真、その他が偽

¡ 左側が右側より小さいとき真、その他が偽

¿= 左側が右側より大きいか等しいとき真、その他が偽

¡= 左側が右側より小さいか等しいとき真、その他が偽

+ 浮動小数点の和

- 浮動小数点の差

* 浮動小数点の掛け算

/ 浮動小数点のわり算

** 左の数が底で右の数が指数実数のみを返す。例-2**1.5はゼロであり 2.82843iではない。
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5.2.21 .SAVE

保存データの質の制限

あるシミュレータ、特に時間領域シミュレータは、非常に多くのデータを発生します。

出力される量は、.saveコマンドを用いることによって制限することが出来ます。その結

果必要なノード電圧やデバイス電流のみを保存することが出来ます。

Syntax: .save V(out) [V(in) [I(L1) [I(S2)]]] [dialogbox]

コマンド.save I(Q2)は、バイポーラ・トランジスタ Q2のベース、コレクタ、エミッ

タ電流を保存します。単体端子電流を保存するには、Ic(Q2)です。

ワイルドカード* and ?を、特定のパターン・マッチしたデータの軌跡を指定するため

用いることが出来ます。例えば.save V(*) Id(*) は、各々全ての電圧および全てのド

レイン電流を保存します。

もしキーワード dialogboxが指定されると、全ての可能なディフォルトの電圧、電流に

ついてのアイヤログ・ボックスが表示され、保存可能なリストから選択することが出来ま

す。ネットリストが回路図から生成されると、ノードおよびデバイスが指定でき、回路図

上でクリックしダイヤログボックス上に指定されたとして点滅します。

5.2.22 .SAVEBIAS

動作点をディスクに保存

Syntax: .savebias <filename> [internal]

+ [temp=<value>] [time=<value> [repeat]] [step=<value>]

+ [DC1=<value>] [DC2=<value>] [DC3=<value>]

このコマンドは、テキスト・ファイルをディスクへ書き込みます。ディスクは、次のシ

ミュレーションで.loadbiasコマンドで再読込します。もし計算することが困難である直

流動作点を持つ回路があると、その解をディスクに保存することが出来、シミュレーショ

ンの残りを進める前に直流解を見いだす時間を節約することが出来ます。

キーワード internalは、あるデバイスの内部ノード電圧も保存されることを指定するた

めに付け加えられます。その結果完全な直流解が保存されます。

.tran解析からある直流解析点を保存したいのであれば、時間を指定することが出来ま

す。決めてある時間点が書き込まれた後、最初にある時間の点を計算します。この時間に

よって規定された全ての期間、変更された繰り返して直流解析を実行します。このファイ

ルは、最後に解析された直流点のみを含んでいます。DC1、DC2、DC3は、.dcスイープ

解析から一つの動作点を抽出して与えられます。

.savebiasコマンドは、.nodesetコマンドの形式でテキスト・ファイルを書き出しま

す。.nodeset記述は、唯一の解に対する推奨記述です。すなわち解析器は、.nodeset記述

で与えられているノード電圧の解を繰り返し求めることから始めます。しかし解が有効な

範囲にはいるまで繰り返し続けます。もし直流動作点から.tran解析を再スタートしたけ
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れば、この直流状態から解析器を強制的に始めるため、.nodesetから.icへ変更してファ

イルを編集することが出来ます。全ての回路に含まれるリアクタンスの現在までの状態

は、.savebiasファイルに保存されませんので、この変更のまま進行します。

5.2.23 .STEP

パラメータ・スイープ

このコマンドは、温度、モデルパラメータ、グローバル・パラメータあるいは独立電源

をステップ上に変化させて解析を実行します。ステップは、線形、対数あるいは特別に選

んだ値のリストとして選ぶことが出来ます。

Example: .step oct v1 1 20 5

この例では、独立電圧源を対数的に 1から 20まで、オクターブ当たり 5ポイントで求

めます。

Example: .step I1 10u 100u 10u

この例では、独立電流源 I1を対数的に 10 µ から 100µ まで、10 µ 間隔で求めます。

Example: .step param RLOAD LIST 5 10 15

この例では、グローバル・パラメータ Rloadを 5、10および 15の値で三回シミュレー

ションを実行します。

Example: .step NPN 2N2222(VAF) 50 100 25

この例では、NPNモデル・パラメータ VAF をステップ 25で 50から 100までシミュ

レーションします。

Example: .step temp -55 125 10

この例では、10 degステップで −55 degから 125degまでシミュレーションします。

ステップの掃引は、三階層までネストすることが出来ます。

5.2.24 .SUBCKT

サブサーキットの定義

回路を定義する補助として、繰り返し回路は、サブサーキット定義に含ませることが出

来、同じ回路の多重回路として用いることが出来ます。シミュレーションを走らせる前

に、回路はサブサーキットで定義された回路素子を持った回路を当てはめ全体の回路を作

成します。サブサーキットの大きさや複雑さに対する制限は、ありません。

サブサーキットの終わりは、.endsコマンドでなければなりません。

次は、サブサーキットを用いた例です。

*

* This is the circuit definition

X1 a b 0 divider
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V1 a 0 pulse(0 1 0 .5^^ef^^bd^^b5 .5^^ef^^bd^^b5 0 1^^ef^^bd^^b5)

* this is the definition of the subcircuit

.subckt divider n1 n2 n3

r1 n1 n2 1k

r2 n2 n3 1k

.ends

.tran 3^^ef^^bd^^b5

.end

Which runs after expanding to

* Expand X1 into two resistor network

r:1:1 a b 1k

r:1:2 b 0 1k

*

v1 a 0 pulse(0 1 0 .5^^ef^^bd^^b5 .5^^ef^^bd^^b5 0 1^^ef^^bd^^b5)

.tran 3^^ef^^bd^^b5

.end

サブサーキット上の単一名称とサブサーキットで定義されている名前が、サブサーキッ

トを回路に適用するときに回路素子として作成されます。

5.2.25 .TEMP

温度掃引

これは温度に対するステップ・コマンドの古典的形式です。示されている各温度に対し

て、シミュレーションを実行します。

syntax .TEMP <T1> <T2> ...

これは、次と同じです。

.STEP TEMP LIST <T1> <T2> ...

5.2.26 .TF

直流小信号伝達関数を見いだす。

これは、独立電源の小変化に対するノード電圧あるいは枝電流の直流小信号伝達関数を

見いだします。

Syntax: .TF V(<node>[, <ref>]) <source>

.TF I(<voltage source>) <source>..
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Examples:

.TF V(out) Vin

.TF V(5,3) Vin

.TF I(Vload) Vin..

5.2.27 .TRAN

非線形過渡解析を実行。

過渡解析を実行します。これは、回路のもっとも直接的なシミュレーションです。回路

に電力が供給されているとき、何が起こるかと言うことを計算します。テスト信号が、独

立電源としてしばしば適用されます。

Syntax: .TRAN <Tstep> <Tstop> [Tstart [dTmax]] [modifiers]

.TRAN <Tstop> [modifiers]

当初の形は、通常の.tran spiceコマンドです。Tstepは、波形の描画間隔ですが、初期ス

テップ・サイズの推定値としても用いられます。LTspiceは、波形圧縮を用います。そこ

でこの値は、小さい値で、省略されたりあるいはゼロに設定されます。Tstopは、シミュ

レーション期間です。過渡解析は、常に時間ゼロから解析されます。しかし Tstartが指定

されていますと、波形データは、ゼロ時間から Tstartまで保存されません。このコマンド

は、最初のシミュレーションを無視することにより波形のファイル・サイズを変更する一

つの方法です。最後のパラメータ dTmaxは、回路方程式を積分する間に行われる最大時

間ステップです。もし Tstartや dTmaxが指定されなければ、Tstepを指定しなければな

りません。

いくつかの変形を、.tran行に置くことが出来ます。

5.2.28 .WAVE

.Wavファイルへ選択するノードを書き込む。

LTspiceは、.wavオーディオ・ファイルを書くことが出来ます。このファイルは、聞く

ことが出来ますし、他のシミュレーションの入力として用いることもできます。

Syntax: .wave <filename.wav> <Nbits> <SampleRate>

　　　　　　　　　 V(out) [V(out2) ...]

example: .wave C:\output.wav 16 44.1K V(left) V(right)

<ファイル名.wav>は、作成したい.wavファイルの完全な絶対パスかシミュレーショ

ン回路図あるいはネットリストを含む相対パスです。ダブル・クオーテーションは、空白

を含むパスを指定することに用いることが出来ます。<Nbits>は、サンプリング・ビット

数です。有効範囲は、1から 32ビットです。<SampleRate>は、一シミュレーション時

間当たりに記載されるサンプル数です。有効範囲は、一秒当たり 1から 4294967285サン

プルです。シンタックスの残りの行は、保存したいノードです。各ノードは、.wavファイ

ルにおいて独立したチャネルです。チャネル数は、一つのチャネルから 65535チャネル
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まで扱えます。ノード電圧と同様にデバイス電流例えば Ib(Q1)を記入することが出来ま

す。.wavアナログからデジタルへの変換は、−1 V( or A)から 1 V( or A)までのフル・ス

ケールです。

パソコンのサウンド・システム上で演奏できない.wavファイルを書くことが出来ます。

と言うのもチャネル数、サンプル数あるいはビット数は、パソコンのコーデックの制限

に依存するからです。しかしこの.wavファイルは、他のシミュレーションの入力として

LTspiceで用いることが出来ます。.wavファイルを LTspiceで演奏するための情報につ

いては、章 LTspice=>Circuit Elements=>V. Voltage Source I. Current Sourceを見て下さ

い。パソコンのサウンド・カードで.wavファイルを演奏したいのであれば、多くの汎用

の.wavファイル・フォーマットは、1あるいは 2チャネル、8あるいは 16bits/channelお

よび 11025、22050あるいは 44100Hzサンプル・レートです。

5.3 過渡解析オプション

5.3.1 .TRAN変形

UIC 直流動作解析をとばし、ユーザーが定めた初期条件を用いる。

steady 定常状態に達したとき、シミュレーションを停止する。

nodiscard 定常状態に達する前に過渡解析シミュレーション部分を消去しない。

startup 独立電圧源や独立電流源を切断して初期動作点を解析する。次に過渡解析をス

タートし、シミュレーションの最初の 20 [µs]でこれらの電源を接続する。

atep 回路のステップ応答を計算する。

5.3.2 UIC

初期条件で用いる。通常直流動作点解析は、過渡解析が始まる前に実行されます。この

コマンドは、この初期値を示します。ある回路素子の初期条件は、特性の初期値という形

で定められます。Uicは、spiceの特に推奨される特性ということではありません。直流動

作点解析をスキップすることは、実際の初期条件からはずれてしまいます。例えば容量に

並列接続された電圧源を考えてみます。ノード電圧は、特に与えられなければゼロです。

そして最初の電圧ステップで、無限大の電流が容量に電荷を蓄積させるため流れます。シ

ミュレータは、電流を極点にするような非常に短い時間ステップを見いだすことが出来ま

せん。そして時間ステップが極端に短く収束しない*1と言うメッセージを出力します。

5.3.3 startup

このコマンドは、spiceのオリジナル・コマンド uicに似ています。独立電源は、シミュ

レーションの最初の 20 [µs]間徐々に立ち上がるべきであることを意味しています。しか

し直流動作点解析は、.icコマンド上で規定された制限を使って実行されます。

*1 time step too small convergence fail.
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5.3.4 steady

定常状態に達したとき、シミュレーションを停止します。これは有効な計算結果報告と

して要求されます。定常状態の検知は、SMPSマクロ・モデルに書き込まれます。一般に

は、これらのことは、誤差アンプの一クロック当たりの平均出力電流がゼロを見つけるよ

うに記述されます。このアルゴリズムは、誤差アンプの出力が境地の範囲となるように

します。ゼロ電流と考えられるようなピーク電流の場合は、sstolオプションで考慮され

ます。

自動定常状態検知は、非常に微妙な状態であるいはそれほど微妙でないような状態で失

敗することがあります。次の方法でインターラクティブに定常状態を定めることが出来

ます。シミュレーションが始まるとすぐに、メニュー・コマンド Simulate=> Efficiency

Calculation=> Mark startを実行します。このコマンドを最初に実行したとき、LTspice

へ手動で制限を加えたいと伝えます。回路が定常状態に達しそうになるとき、このコ

マンドを再び実行します。このコマンドは、過去の履歴を消去し、与えられた条件で再

度シミュレーションを始めます。しばらくの後、10クロック少しして Simulation=>

Efficiency Calculation=> Mark Endを実行します。Simulation=> Efficiency Calculation

=> Mark Startを実行するたびに、制限された計算を再実行し、波形の履歴を消去します。

これはファイル・データを巨大にせず描画表示を加速するための良い方法です。これは

保存したくない蓄積されるデータを消去したいとき、繰り返し Simulation=> Efficiency

Calculation=> Mark Startを実行ことが望まれます。

定常状態を見いだすとき、過渡解析時間を減らすためノード電圧やインダクタ電流の初

期値を与えるために.icコマンドが使われます。

5.3.5 nodiscard

定常状態に達する前に、過渡解析部分を消去しない。

5.3.6 step

回路のステップ応答を計算。この関数は、ステップ電流のリストを持つ負荷として用い

られる電流源と一緒に動作します。手順は、次の通りです。

1. 定常状態を計算し、もし nodiscardが設定されていなければ履歴を消去します。

2. 20 [A/µsの割合で次の電流をステップ状に印可します。

3. 定常状態を計算します。

4. 次のステップへ変更します。もし値がなければ終了します。

回路の複雑さにより、自動的に STEP変化を検知することは出来ません。過渡シミュ

レーションを走らせ必要なステップ負荷応答の出発点終了点を観測するには、.TRANコ

マンドを用いるのがもっとも適切です。出力負荷電流を変化させ希望の時間で異なったレ

ベルへと変更するためには、PWLコマンドを用いて下さい。例えば

PWL(0 0.5 1m 0.5 1.01m 0.1 3m 0.1 3.01m 0.5)
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負荷電流は、時間ゼロにおいて 0.5 Aからスタートします。1 msでは、0.5 Aに留まり

ます。時間 1.01 msで 0.1 Aに切り替わります。3 msまで 0.1 Aに留まります。3.01 ms

で 0.5 Aへと変化し、0.5 Aに留まります。PWLは、（時間、値）の制限はありません。

5.4 回路素子

5.4.1 A 特別な関数

Symbol names: INV, BUF, AND, OR, XOR, SCHMITT, SCHMTBUF,

SCHMTINV, DFLOP, VARISTOR, and MODULATE

Syntax: Annn n001 n002 n003 n004 n005 n006 n007 n008

<model> [instance parameters]

Linear Technology Corporation所有の特別な関数であるミックス・モード・シミュレー

ション・デバイスがあります。これらのモデルやビヘービア・モデルのほとんどが、

LTspiceで度々新しいモデルとして変更されているため、文章化されていません。しかし

これらのモデルは、一般的に注目されているため、いくつかは文章化しています。

INV、BUF、AND、ORおよび XORは、一般化された理想的なビヘービア・モデルで

す。全てのゲートは、８個の端子でネットリストが作られています。これらのゲートは、

外部電力が必要になりません。電流は出力、６および７ pinに出力されたり入力されたり

し、共通端子８ pinへ戻ってきます。１から５ pinは、入力です。使われていない入出力

は、８ pinです。デジタル・デバイス・コンパイラは、その端子が使われておらずシミュ

レーションから取り除くことを知っています。このことは、AND ゲートの入力が接地あ

るいはゼロ電圧となっているとき違った動作をするのではないかと勘違いされます。もし

接地がゲートの共通端子となっていると、接地入力は論理偽として動作しませんが、単に

シミュレーションの素子とは見なされないだけです。これらのゲートがこの様に構成され

ているのは、一つの素子が２，３，４，５端子を真、逆、コンプリメンタリ出力を持ち、

シミュレーション速度に対して使われていないゲートが悪さをしないようにするためで

す。つまり AND デバイスは、AND ゲートの１２の異なったタイプとして動作します。

ゲートは、0.5 V の論理スレッショルドを持ち、伝送遅延無し、1 ohm出力インピーダン

ス、0 V/1 V ロジックがデフォルトとなっています。出力特性は、次のように設定されて

います。

パラメータ デフォルト 意味

Vhigh 1 V 論理高レベル

Vlow 0 V 論理低レベル

Trise 0 上昇時間

Tfall Trise 下降時間

Tau 0 出力 RC時定数

Cout 0 出力容量

Rout 1 出力インピーダンス

Rhigh Rout 論理高レベルでのインピーダンス

Rlow Rout 論理低レベルでのインピーダンス
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全てのパラメータが、同時に同じ特性で定義できるわけではありません。例えば出力特

性は、上昇時間あるいは RC時定数であり同時ではありません。

伝送遅延は、デフォルトでゼロであり、特性パラメータは、Tdです。入力保持時間は

伝送遅延と等しくなります。

入力論理スレッショルドのデフォルトは、0.5 (Vhigh+Vlow)ですが、特性パラメータ

Refに設定することが出来ます。保持時間は、伝送遅延時間に等しくなります。

シュミット・トリガ素子は、ゲートと似たような出力特性を持っています。これらの変

換点は、特性パラメータ Vt と Vhによって決められます。低い方の転換点は、Vt-Vh で、

高い方の転換点は、Vt+Vh です。

ゲートとシュミット・トリガ素子は、時間ステップ情報をデフォルトではシミュレー

ション・エンジンへ伝えません。すなわち状態を変化し状態変化のいずれかのサイドで時

間ステップが閉じていても検知しません。特性パラメータ tripdtは、シミュレータが状態

を変化させる最大の時間ステップを規定するように設定することが出来ます。

VRISTORは、電圧可変バリスタです。ブレークダウン電圧は、端子１と２の間の電圧

によって設定されます。ブレークダウンでのインピーダンスは、特性パラメータ rclampに

よって設定されます。例として与えた図./examples/Educational/varistor.ascを見て下さい。

MODULATE 素子は、電圧制御発振器です。例図./examples/Educational/PLL.ascを見

て下さい。瞬時発振周波数は、FM入力に電圧を掛けて設定します。電圧から周波数への

変換は、線形で二つの特性パラメータ markと spaceによって設定されます。Markは、

FM入力が 1V のときの周波数、spaceは、入力が 0V のときの周波数です。振幅は、AM

入力のときの電圧です。入力が決まっていなかったり（MODULATE commonに接続さ

れていると）デフォルトは、1 V です。

LTspiceの回路図入力を特別な方法でこれらの素子のシンボルを結びつけます。全ての

接続されていない端子は、自動的に端子８に接続されます。また端子８が接続されていな

い場合、ノード０に接続されます。

5.4.2 任意ビヘービア電圧・電流源

Symbol names: BV, BI

Syntax: Bnnn n001 n002 V=<expression> [ic=<value>]

+ [tripdv=<value>] [tripdt=<value>]

+ [laplace=<expression> [window=<time>]

+ [nfft=<number>] [mtol=<number>]]

Bnnn n001 n002 I=<expression> [ic=<value>]

+ [tripdv=<value>] [tripdt=<value>] [Rpar=<value>]

+ [laplace=<expression> [window=<time>]

+ [nfft=<number>] [mtol=<number>] ]

最初のシンタックスは、ビヘービア電圧源、後のシンタックスはビヘービア電流源を定

義しています。電流源に対して、並列抵抗が Rpar特性パラメータとして与えられます。
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tripdvおよび tripdtは、syep rejectionを制御します。電源電圧が、tripdt秒で tripdv電

圧より大きく変化しますと、シミュレーション時間ステップが拒否されます。

Expressionを次のように含ませることが出来ます。

• ノード電圧、例えば V(n001)

• ノード電圧差、例えば V(n001, n002)

• 回路素子電流；例えば I(S1)、スイッチ S1に流れる電流あるいは Ib(Q1)。しかし

回路素子電流は、準静的に変化しています。すなわち参照デバイスに流れる電流と

ビヘービア電源出力の間に瞬間的な帰還はありません。

• キーワード timeは、シミュレーションでの現時点を意味しています。

• キーワード piは、3.14159265358979323846です。

• 関数
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名前 機能

abs(x) 絶対値

acos(x) xのアーク・コサイン

acosh(x) アーク・ハイパブリック・コサイン

asin(x) アーク・コサイン

asinh(x) アーク・ハイパブリック・サイン

atan(x) アーク・タンゼント

atan2(y, x) y/xの四現象アーク・タンゼント

atanh(x) アーク・ハイパブリック・タンゼント

cos(x) コサイン

cosh(x) ハイパブリック・コサイン

exp(x) 指数関数

ln(x) 自然対数

log(x) 常用対数

log10(x) 底１０常用対数

sgn(x) ジグン

sin(x) サイン

sinh(x) ハイパブリック・サイン

aqrt(x) 平方根

tan(x) タンゼント

tanh(x) ハイパブリック・タンゼント

u(x) 単位ステップ、もし x>0なら１，その他は０

buf(x) もし x>0.5なら１，その他は０

inv(x) もし x>0.5なら０，その他は１

uramp(x) もし x>0.5ならｘ，その他は０

!(x) inv(x)の変形シンタックス

int(x) ｘを整数へ変換

floor(x) ｘと同じか小さい整数

ceil(x) ｘと同じか大きい場合整数

rand(x) ｘの整数値に依存する０と１の間の乱数

random(x) rand()に似ているが値が滑らかに変化する

min(x, y) ｘあるいはｙの内小さい方

max(x, y) ｘあるいはｙの内大きい方

limit(x,y,z) min(max(x,y),z)と同じ

if(x,y,z) もしｘ >0.5ならば、ｙまたはｚ

table(x,a,b,c,d,...) 点の組み合わせとして与えられているテーブルに基づいたｘの値

• 演算、展開の逆順でグループ分けしてあります。
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説明

& 表現をブール数へ変換、AND

— 表現をブール数へ変換、OR

^ 表現をブール数へ変換、XOR

< 左が右より小さければ真、その他は偽

> 左が右より大きければ真、その他は偽

<= 左が右より小さいか等しければ真、その他は偽

>= 左が右より大きいか等しければ真、その他は偽

+ 浮動点加算

- 浮動点減算

* 浮動点掛け算

/ 浮動点割り算

** 左の数値に対する右の数値乗

! 次の表示をブール数へ変換し逆数を取る

真の数値は 1，偽の数値は 0です。ブール数への変換は、もし値が 0.5より大きければ

1、その他では 0へ変換します。

オプションのラプラス変換が定義されていれば、ビヘービアの電流あるいは電圧信号

の結果に対してこの変換が適用されます。ラプラス変換は、ｓの関数でなければいけま

せん。周波数ｆでの周波数応答は、sを代入し sqrt(-1)*2*pi*f となります。時間領域の振

る舞いは、インパルス応答から求められ、周波数応答のフーリエ変換から求められます。

LTspiceは、適切な周波数範囲と精度を推測しなければなりません。応答は、高周波で省

略され、エラーが報告されます。LTspiceは、最初にこのことを推測するようにし、retol

を減らして精度をチェックし、明示的にウィンドウの nfft を設定するようにすべきです。

ウインドウ表示値の逆数が周波数解像度です。この解像度の nfft 倍の値がもっとも高い周

波数となります。ブール代数 XOR演算子^は、ラプラス変換で用いられるとき、指数関

数**を意味すると解釈されます。

5.4.3 容量

Symbol names: CAP, POLCAP

Syntax: Cnnn n1 n2 <capacitance> [ic=<value>]

+ [Rser=<value>] [Lser=<value>] [Rpar=<value>]

+ [Cpar=<value>] [m=<value>]

+ [RLshunt=<value>]

容量は、直列抵抗、直列インダクタンス、並列抵抗と直並列容量によって表現されます。

等価回路を、次に示しておきます。
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名前 パラメータ

Rser 等価直列抵抗

Lser 等価直列インダクタンス

Rpar 等価並列抵抗

Cpar 等価並列容量

RLshunt Lserに並列な分流抵抗

m 並列ユニットの数

ic uicが.tranカードでフラッグが立っているときだけに使われる初期電圧

表 5.7 Capacitor Instance Parameter

改めて描くより、容量に寄生の Rpar、Rser、RLshunt、Cpar、Lserを含ませる方が計算

上好ましくなります。LTspiceは、内部ノード無しで物理的容量のこのモデルシミュレー

ションする適切な回路シミュレーション技術を使っています。この方法は、シミュレー

ション行列をより小さくし、計算速度が速く、短時間の時間ステップで異常値をより少な

くします。

容量は、これらの寄生素子を含んでいますので、ピエゾ結晶の基本マクロモデルを使う

のに便利です。

また汎用的な非線形容量もあります。容量を細工する代わりに、電荷の表現を書きま

す。LTspiceは、この表現をコンパイルし、全ての変数に渡って記号的に微分し、容量に

関する偏微分を見いだします。

Syntax: Cnnn n1 n2 Q=<expression> [ic=<value>] [m=<value>]

素子間の電圧を示す特別な変数 xが存在します。そこで 100 pF の容量は、次のように

記載されます。

Cnnn n1 n2 Q=100p*x

ゼロ電圧で 100 pF から 300 pF へと急激に変化する容量は、次のように書くことが出

来ます。

Cnnn n1 n2 Q=x*if(x<0,100p,300p)

この素子は、仮想的な電荷モデルの振る舞いを表現するのに便利です。例えばトランジ

スタ。
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5.4.4 ダイオード

Symbol Names: DIODE, ZENER, SCHOTTKY, VARACTOR.

Syntax: Dnnn anode cathode <model> [area]

+ [off] [m=<val>]

例

D1 SW OUT MyIdealDiode

.model MyIdealDiode D(Ron=.1 Roff=1Meg Vfwd=.4)

D2 SW OUT dio2

.model dio2 D(Is=1e-10)

ダイオードは、その特性を決めるための.modelカードが必要です。二つのダイオード・

タイプがあります。一つは、conduction region-wise linear modelです。これは、線形ダ

イオードの軽量化された表現のモデルです。伝導について、三つの領域を持っています：

on、off と逆電圧でのブレークダウンです。

下記はこのタイプのダイオードのモデル・パラメータです。

名称 パラメータ 単位 デフォルト

Ron 順方向の抵抗 Ohm 1.

Roff off 状態の抵抗 Ohm 1/gmin

Vfwd 伝導状態に入るときの順方向電圧 V 0.

Vrev 逆電圧のブレークダウン電圧 V infin.

Rrev ブレークダウン抵抗 Ohm Ron

この理想的なモデルは、Ron、Roff、Vfwd、Vrevあるいは Rrevのいくつかがモデルの

中で変更されるときに用いられます。

他の有効なモデルは、標準的な Berkeley SPICE semiconductor diodeです。しかし詳細

なブレークダウン特性や再結合電流を扱うことが出来ます。面積ファクターは、このモデ

ルの並列される数を与えます。下記は、このダイオードのモデル・パラメータです。
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名称 パラメータ 単位 デフォルト 例

Is 飽和電流 A 1e−14 1e−7

Rs オーミックな抵抗 Ohms 0 10

N エミッション係数 - 1 1.

Tt トランジット・タイム sec 0 0.1 ns

Cjo ゼロ・バイアス接合容量 F 0 2 p

Vj 接合ポテンシャル V 1 0.6

M 傾斜係数 - 0.5 0.5

Eg 活性エネルギー eV 1.11 1.11Si

0.69Sbd

0.67Ge

XTI 飽和電流温度指数 - 3.0 3.0 jn

2.0 Sbd

Kf フリッカ雑音係数 - 0

Af フリッカ雑音指数 - 1

Fc 順方向電圧空乏層容量式の係数 - 0.5

BV 逆方向ブレークダウン電圧 V infin. 40.

Ibv ブレークダウン電圧の電流 A 1e−10

Tnom パラメータ測定温度 ℃ 27 50

Isr 再結合電流パラメータ A 0

Nr Isrエミッション係数 - 2

Ikf 高注入ニー電流 A infin.

Tikf 線形 Ikf 温度係数 /℃ 0

Trs1 線形 Rs温度係数 /℃ 0

Trs2 二乗 Rs温度係数 /℃/℃ 0

表 5.8 ダイオード・パラメータ

モデルの電圧、電流、電力消費率を決めることが可能です。これらのモデル・パラメー

タは、電気的振る舞いに影響しません。ダイオードが能力を超えて用いられているかど

うかを調べることが、LTspiceでは可能です。次のパラメータがモデルに対して適用でき

ます。

名称 パラメータ 単位 デフォルト

Vpk ピーク電圧率 V (none)

Ipk ピーク電流率 A (none)

Iave 平均電流率 A (none)

Irms RMS電流率 A (none)

diss 最大電力消費率 W (none)

5.4.5 電圧制御電圧源

Symbol Names: E, E2

三つのタイプの電圧制御電圧源があります。

Syntax: Exxx n+ n- nc+ nc- <gain>
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この回路素子は、端子 nc+と nc-の間の入力電圧に依存した端子 n+と n-の出力電圧を

発生します。この素子は、一定の利得によって決められ、線形に入力電圧に依存します。

Syntax: Exxx n+ n- nc+ nc- table=(<value pair>, <value pair>, ...)

伝達関数を決めるために、ルックアップ・テーブルが用いられます。テーブルは、二つ

の数値のペアとなっています。ペアの二番目の値は、制御電圧がペアの最初の値に等しい

ときの出力電圧です。出力は、制御電圧が指定した点の間にあるとき、線形に自動付与

されます。もし制御電圧がルックアップ・テーブルの範囲を超えるときには、出力電圧は

ルックアップ・テーブルの最後の点の電圧と同じ値となります。

Syntax: Exxx n+ n- nc+ nc- Laplace=<func(s)>

+ [window=<time>] [nfft=<number>] [mtol=<number>]

この回路素子の伝達関数は、ラプラス変換によって決められます。ラプラス変換は、s

の関数でなければなりません。周波数 f での応答は、aqrt(-1)*2*pi*f の値の sを代入する

ことによって見いだされます。時間領域の振る舞いは、周波数領域のフーリエ変換から求

められるインパルス応答から求められます。LTspiceは、適切な周波数領域と精度とを推

測する必要があります。応答は、高周波のところで止まるかあるいはエラーを報告する必

要があります。LTspiceが、最初にこの推測を行うことが出来るようにし、reltolを減少さ

せるか、自動的に nfft や windowを調べられるようにすることが望まれます。windowの

値の逆数は、周波数解像度です。この解像度の nfft 倍の値は、考慮している最高の周波数

です。ブール代数式^は、ラプラス表現で用いられるとき、自乗**と見なされます。

Syntax: Exxx n+ n- value={<expression>}

これは、ビヘービア電圧源 Bの変形シンタックスです。

Syntax: Exxx n+ n- POLY(<N>) <(node1+,node1-) (node2+,node2-)

+ ... (nodeN+,nodeN-)> <c0 c1 c2 c3 c4 ...>

これは、多項式を含んだビへービア・モデルの古い形式です。Linear Technologyビヘー

ビア・モデルを含んだ回路をシミュレーションするとき役に立ちます。

E電源を用いるよりも E電源を近似するために、抵抗が並列に挿入された G電源を用

いる方が望ましいでしょう。抵抗が並列に挿入された電圧制御電流源は、電圧制御電圧源

よりも計算が速く、収束の問題があまり生じません。また有限の出力インピーダンスは、

実際の回路を巧く表現しています。

5.4.6 電流制御電流源

Symbol Name: F

Syntax: Fxxx n+ n- <Vnam> <gain>

この回路素子は、端子 n+と n-の間に電流を供給します。電流の値は、<Vnam>で決め

られた電圧源を流れる電流の gain倍の値に等しくなります。
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Syntax: Fxxx n+ n- value={<expression>}

これは、ビヘービア電圧源 Bの変形シンタックスです。

Syntax: Fxxx n+ n- POLY(<N>) <V1 V2 ... VN> <c0 c1 c2 c3 c4 ...>

これは、多項式で記述されるビヘービア・モデルの古い形式です。Linear Technologyビ

ヘービア・モデルを計算するときに役立ちます。

5.4.7 電圧制御電流源

Symbol Names: G, G2

三つのタイプの電圧制御電流源があります。

Syntax: Gxxx n+ n- nc+ nc- <gain>

この回路素子は、ノード nc+と nc-の入力電圧に依存した出力電流をノード n+と n-に

発生します。この出力電流は、一定の利得によって生じます。

Syntax: Gxxx n+ n- nc+ nc- table=(<value pair>, <value pair>, ...)

ここで伝達関数を決めるために、ルックアップ・テーブルが用いられます。ペアになっ

ている二番目の値は、制御電圧がペアの最初の値と等しくなったときの出力電流です。出

力は、制御電圧が規定された点の間にあるとき線形に内挿されます。もし制御電圧がルッ

クアップ・テーブルの範囲を超えたとき、出力電流はルックアップ・テーブルの最後の値

の一定電流として外挿されます。

Syntax: Gxxx n+ n- nc+ nc- Laplace=<func(s)>

+ [window=<time>] [nfft=<number>] [mtol=<number>]

この素子の伝達関数は、ラプラス変換によって決められます。ラプラス変換は、sの

関数でなければなりません。周波数 f での応答は、sqrt(-1)*2*pi*f の sを代入することに

よって求められます。時間領域の振る舞いは、インパルス応答から求められます。それ

は、周波数領域応答のフーリエ変換から求められます。LTspiceは、適切な周波数範囲と

精度を推測する必要があります。応答は周波数の高いところで止まり、エラーを報告す

る必要があります。LTspiceが最初にこの推測が出来るようにし、reltolを減少し精度を

チェックするかもしくは nfft や windowを設定しておくことを薦めます。window値の逆

数は、周波数精度です。精度の nfft 倍は、考慮されているもっとも高い周波数です。ブー

ル代数^は、ラプラス表現で用いられている**を意味しています。

Syntax: Gxxx n+ n- value={<expression>}

これは、ビヘービア・モデル Bの変形シンタックスです。

Syntax: Gxxx n+ n- POLY(<N>) <(node1+,node1-) (node2+,node2-)

+ ... (nodeN+,nodeN-)> <c0 c1 c2 c3 c4 ...>
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これは、多項式を持ったビヘービア・モデルの古典的表現です。Linear Technologyビ

ヘービア・モデルが存在する回路を計算するときに有効です。

5.4.8 電流制御電圧源

Symbol Name: H

Syntax: Hxxx n+ n- <Vnam> <transresistance>

この素子は、ノード n+と n-間の電圧に適用されます。適用される電圧は、電圧源<Vnam>

を流れる電流の利得倍となります。

Syntax: Hxxx n+ n- value={<expression>}

これは、ビヘービア電圧源 Bの変形シンタックスです。

Syntax: Hxxx n+ n- POLY(<N>) <V1 V2 ... V3> <c0 c1 c2 c3 c4 ...>

これは、多項式であるビヘービア・モデルの古典的形式です。Linear Technologyビヘー

ビア・モデルがある回路を計算するときに役立ちます。

5.4.9 電流源

Symbol Name: CURRENT

Syntax: Ixxx n+ n- <current> [AC=<amplitude>] [load]

この素子は、ノード n+と n-に一定の電流を供給します。電源が負荷として用いられて

いる場合、その電源は電力を消費します。すなわちもしノード n+と n-の間の電圧がゼロ

あるいは負の値ですと流れ出す電流はゼロです。この目的は、出力電圧がゼロであるなら

電流が流れ出さない電力源の電流負荷となります。

交流解析に対して、ACの値は解析周波数点での電源の振幅として用いられます。

Syntax: Ixxx n+ n- PULSE(Ioff Ion Tdelay Trise Tfall Ton

Tperiod Ncycles)

時間依存パルス電流源

名称 パラメータ 単位

Ioff 初期値 Amps

Ion パルスの値 Amps

Tdelay 遅延 seconds

Tr 立ち上がり時間 seconds

Tf たち下がり時間 seconds

Ton パルス幅 seconds

Tperiod 周期 seconds

Ncycles サイクルの数 cycles

表 5.9 時間依存パルス電流源
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Syntax: Ixxx n+ n- SINE(Ioffset Iamp Freq Td Theta Phi Ncycles)

時間依存性正弦波電流源

名称 パラメータ 単位

Ioffset 直流オフセット Amps

Iamp 振幅 Amps

Freq 周波数 Hz

Td 遅延 seconds

Theta ダンピング・ファクター 1/seconds

Phi 正弦波の位相 degrees

Ncycles サイクル数の数 cycles

表 5.10 時間依存性正弦波電流源

Td より遅い時間あるいは Ncyclesより後の時間に対して出力電流は、Ioff-

set+Iamp*(pi*phi/180)で与えられます。その他の場合には Ioffset+Iamp*exp(-(time-

Td)*Theta)*sin(2*pi*freq*(time-Td)+pi*phi/180)で与えられます。

damping Factorあるいは Thetaは、減衰時定数の逆数です。

Syntax: Ixxx n+ n- Ixxx n+ n- EXP(I1 I2 Td1 Tau1 Td2 Tau2)

時間依存性指数関数型電流源

名称 パラメータ 単位

I1 初期値 Amps

I2 パルスの値 Amps

Td1 立ち上がり遅延時間 seconds

Tau1 立ち上がり時定数 seconds

Td2 立ち下がり遅延時間 seconds

Tau2 立ち下がり時定数 seconds

表 5.11 時間依存性指数関数型電流源

Td1より小さな時間に対して、出力電流は I1です。Td1と Td2の間の時間に対して電

流は、次のように与えられます。

I1+(I2-I1)*(1-exp(-(time-Td1)/Tau1))

+(I1-I2)*(1-exp(-(time-Td2)/Tau2))

Syntax: Ixxx n+ n- SFFM(Ioff Iamp Fcar MDI Fsig)

時間依存性単一周波数 FM電流源
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名称 パラメータ 単位

Ioff 直流オフセット Amps

Iamp 振幅 Amps

Fcar 搬送波周波数 Hz

MDI 変調指数 (none)

Fsig 信号周波数 Hz

表 5.12 時間依存性単一周波数 FM電流源

電流は次のように与えられます。

Ioff+Iamp*sin((2.*pi*Fcar*time)+MDI*sin(2.*pi*Fsig*time))

Syntax: Ixxx n+ n- tbl=(<voltage, current>,

<voltage, current>, ...)

電流は、ルックアップ・テーブルでの出力ノード電圧の関数として決められます。これ

は負荷の特性をモデル化するのに役立ちます。

Syntax: Ixxx n+ n- <value> step(<value1>, [<value2>],

[<value3>, ...]) [load]

これは電流源の特別な形式です。電流は、過渡解析ステップ負荷応答で用いられる電流

のリストとして決められます。このモードでは、シミュレーションは、定常状態がリス

ト <value1>の最初の電流に達するまで計算し続けます。電流は、リスト <value2>の次

の値で変化します。シミュレーションは、定常状態がその電流値になるまで進行します。

電流は、次のステップへ移動します。それからリストが完了するまで繰り返します。も

し.tranコマンドが stepを規定していなければ、最初の <value>が用いられます。

Syntax: Ixxx n+ n- R=<value>

これは電流源では無く、抵抗です。負荷が電流源として用いられるとき、抵抗負荷をモ

デル化するために用いられます。

Syntax: Ixxx n+ n- PWL(t1 i1 t2 i2 t3 i3...)

任意のピースワイズ・リニア電流源

t1時間の前で、電流は i1です。時間 t1と t2では、電流は i1と i2の間を直線変化しま

す。任意の時間では、その点の電流を与えます。最後の時間の後は、電流は最後に指定し

た時間のままです。

Syntax: Ixxx n+ n- wavefile=<filename> [chan=<nnn>]

LTspiceへの入力として用いられる.waveファイルが使えます。<filename>は、.wave

ファイルへのフルパス、絶対パスであるかシミュレーションしている回路図もしくはネッ

トリストを含むディレクトリからの相対パスです。ダブル・クオテーションは、パスを含

むスペースを規定するために用いることが出来ます。.waveファイルは、65536チャネル、
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0から 65535まで含ませることが出来ます。Chanは、どのチャネルを用いるかを規定す

ることが出来ます。デフォルトは、最初のチャネル、0が用いられます。.waveファイル

は、−1 Aから 1 Aまでのフルスケールを持つとして変換されます。

この電源のみ、.tran解析で意味があります。

5.4.10 JFETトランジスタ

Symbol Names: NJF, PJF

Syntax: Jxxx D G S <model> [area] [off] [IC=Vds, Vgs] [temp=T]

例

J1 0 in out MyJFETmodel

.model MyJFETmodel NJF(Lambda=.001)

J2 0 in out MyPJFETmodel

.model MyPJFETmodel PJF(Lambda=.001)

JFETは、その特性を表現するために.modelカードが必要です。モデル・カードのキー

ワード NJFと PJFは、トランジスタの極性を示しています。area factorは、モデルがいく

つ並列に接続されているかと言うことを決めています。

JFETモデルは、ゲート再結合電流、インパクト・イオン化を含むように拡張された

Shichman and Hodgesの FETモデルから導かれています。直流特性は、パラメータ VTO

および BETA によって定義されています。それらは、ドレイン電流のゲート電圧による

変動；LAMBDA を決め、出力コンダクタンスを決めます。そして Is、二つのゲート接合

の飽和電流を決めます。電荷の蓄積は、二つのゲート接合の非線形空間電荷総容量によっ

てモデル化されています。これは、接合電圧の-1/2乗で変化し、パラメータ Cgs、Cgd、

PBによって定義されます。最適化パラメータ B が付け加えられています。次の文献を

見て下さい。A. E. Parker and DDDDD. J. Skellern, AnImproved FET Model for Computer

Simulators, IEEE Trans CAD vol. 9, no. 5, pp. 551-553, May 1990

名称 パラメータ 単位 デフォルト 例

Vto スレッショルド電圧 V -2.0 -2.0

Beta トランスコンダクタンス・パラメータ A/V/V 1e-4 1e-3

Lambda チャネル長変調パラメータ 1/V 0 1e-4

Rd ドレイン抵抗 Ohm 0 100

Rs ソース抵抗 Ohm 0 100

Cgs ゼロバイアス G-S接合容量 F 0 5pF

Cgd ゼロバイアス G-D接合容量 F 0 1pF

PB ゲート接合ポテンシャル V 1 0.6

Is ゲート接合飽和電流 A 1e-14 1e-14

B ドーピング・テイル・パラメータ - 1 1.1

KF フリッカ雑音係数 - 0

AF フリッカ雑音指数 - 1
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FC 順方向空間電荷容量係数 - 0.5

Tnom パラメータ測定温度 ℃ 27 50

betatce トランスコンダクタンス・パラメータ指数温度係数 0 %/℃

vtotc スレッショルド電圧温度係数 V/℃ 0

N ゲート接合エミッション係数 - 1

Isr ゲート接合再結合電流 A 0

Nr Isrのエミッション係数 - 2

alpha イオン化係数 1/V 0

Vk イオン化ニー電流 V 3

xti 飽和電流温度係数 -

表 5.13: JFETパラメータ

5.4.11 相互インダクタンス

Symbol Names: None

これは、回路図上のテキストとして配置されます。

Syntax: Kxxx L1 L2 [L3 ...] <coefficient>

L1と L2は、インダクタの名前です。相互結合係数は、−1と 1の間の値でなくてはな

りません。

K1 L1 L2 L3 L4 1.

は、次の６個の宣言と同じことです。

K1 L1 L2 1.

K2 L2 L3 1.

K3 L3 L4 1.

K4 L1 L3 1.

K5 L2 L4 1.

K6 L1 L4 1.

値 1の相互結合係数から始める方がよいようです。これはダンピングが行われていなく

シミュレーションを遅くする漏れインダクタンスを少なくします。しかしもし uicコマン

ドか.tranカードが実行されていると、−1あるいは 1の相互インダクタンス値は、シミュ

レーションを難しくします。

5.4.12 インダクタ

Symbol Names: IND, IND2

Syntax: Lxxx n+ n- <inductance> [ic=<value>]

+ [Rser=<value>] [Rpar=<value>]
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+ [Cpar=<value>] [m=<value>]

等価直列抵抗、直列インダクタンス、並列抵抗それと並列容量とを規定することが出来

ます。等価回路は、次のようになります。

図 5.1 インダクタンス等価回路

名称 パラメータ

Rser 等価直列抵抗

Rpar 等価並列抵抗

Cpar 等価並列容量

m 並列になっている数

ic 初期電流（uicが.tranカードで使われているときのみ）

tc1 線形インダクタンス温度係数

tc2 温度係数第２項

temp 素子温度

表 5.14 インダクタンス・パラメータ

別の形で描くよりもインダクタンスの中に寄生素子 Rparや Rser、Cparを含ませておく

ほうが役に立ちます。LTspiceは、任意の内部ノード無しで物理的なインダクタをシミュ

レーションするために、専用のシミュレーション・テクノロジーを使っています。こうす

ることによってシミュレーション行列を小さくし、計算を早くできます。そして全ての時

間ステップに渡って正常に動作します。

デフォルトでは、LTspiceは SMPS過渡解析に対してインダクタに損失を持たせます。

SMPSに対してこれらの損失は、一般に付属しているわけではなく場合によっては取り

除くことが出来ます。Tools=>Control Panel=>Hacks!ページで Supply a min. inductor

damping if no Rpar is givenチェックをはずします。この設定は、プログラムが起動し

ている間記憶しています。またインダクタに対して１ミリオームのデフォルト直列抵

抗もあります。これは相互インダクタンス記述では述べられていません。この Rserは、

SwitcherCAD IIIが回路の線形行列の大きさを減少させるためテブナン回路の代わりに

ノートン等価回路としてインダクタに含まれるようにします。もし LTspiceにこの最小値

の抵抗を含ませたくないならば、そのインダクタに対して明示的に Rser=0と設定しなけ

ればいけません。このことは、LTspiceに過渡解析の間インダクタ二の複雑なテブナン等

価回路を用いることを要求します。
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LTspiceで有効な非線形インダクタの二つの型があります。一つは、フラックスの表現

を持ったビヘービア・インダクタです。インダクタの電流は、キーワード xによって与え

られます。次にしますのは、ネットリストの例です。

*

L1 N001 0 Flux=1m*tanh(5*x)

I1 0 N001 PWL(0 0 1 1)

.tran 1

.end

上の例で I1は、単一の dI/dTを与えます。その結果インダクタは、ノード N001の電圧

として読み飛ばされます。

LTspiceには、もう一つの非線形インダクタがあります。これは、John Chan et al. in

IEEE Transactions On Computer-Aided Design, Vol. 10, No. 4, April 1991によって最初に

提案されたヒステレシス・コア・モデルです。このモデルは、僅か三つのパラメータでヒ

ステレシスを定義しています。

名称 パラメータ 単位

Hc 強制力

Br 残存フラックス密度

Bs 飽和フラックス密度

表 5.15 ヒステレシスがあるインダクタ

上側および下側のヒステレシス・ループは、次のように与えられます。

Bup(H) = Bs
H +Hc

|H +Hc|+Hc(Bs/Rr −1)
+µ0H

Bdn(H) = Bs
H −Hc

|H −Hc|+Hc(Bs/Rr −1)
+µ0H

これらの関数は、次の図のように描かれます。Hcおよび Br は、主ヒステレシス・ループ

と Hおよび B軸との交点です。Bsは、漸近線と B軸との交点です。Bsat(H) = Bs+µ0H

は、Hが無限になるにつれ近づいていきます。

図 5.2 ヒステレシス・ループ
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初期磁化曲線は、次のように与えられます。

Bmag(H) = .5[Bup(H)+Bdn(H)]

マイナー・ループは、引用する参照点当たり上の式の様々な変更によって得られます。

コアの絶対あるいは相対パーミアビリティは、Hの関数および Hの値の履歴です。典型

的な電力用フェライト (Hc=16 A-turns/m, Bs=.44T, Br=.10T)の非対称マイナー・ループ

の例が、下の図に示してあります。

図 5.3 非対称マイナー・ループ例

Hc、Brと Bsのコア特性パラメータに加えて、コアの機械的寸法が必要です。

名称 パラメータ 単位

Lm 磁気長 (excl. gap) meter

Lg ギャップ長 meter

A 断面積 meter**2

N 巻き数 –

表 5.16 機械寸法

磁場の有限ギャップを規定したい場合、Hは巻き線の電流には比例しません。LTspice

は、均一な断面積および薄くて均一に広がっているギャップを仮定してコアおよびギャッ

プの磁場を計算します。

下記の内容は、ギャップのあるインダクタ L1に対するインダクタンスと電流の例を示

しています。電流源 I1は、単一の dI/dtを供給していますので、インダクタンスを読みと

ることが出来ます。コアは、初期磁場曲線に従います。そしてパーミアビリティは、最初

に電流が上昇するにつれ増加し、飽和に達したところで止まります。ギャップは、インダ

クタンスをコアのパーミアビリティ対して敏感にしなくします。その増加を観察するため

には、V(n001)上で拡大する必要があります。コアの中で Hが Hcに等しいとき最大とな

ります。

*

L1 N001 0 Hc=16. Bs=.44 Br=.10 A=0.0000251

+ Lm=0.0198 Lg=0.0006858 N=1000

I1 0 N001 PWL(0 0 1 1)
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.tran .5

.options maxstep=10u

.end

5.4.13 MOSFET

Symbol Names: NMOS, NMOS3, PMOS, PMOS3

LTspiceでは、二つの基本的に異なったMOSFETがあります。モノリシックMOSFET

と新しい垂直二重拡散パワー MOSFETです。

モノリシックMOSFET

Syntax: Mxxx Nd Ng Ns Nb <model> [m=<value>] [L=<len>]

+ [W=<width>] [AD=<area>] [AS=<area>]

+ [PD=<perim>] [PS=<perim>] [NRD=<value>]

+ [NRS=<value>] [off] [IC=<Vds, Vgs, Vbs>]

+ [temp=<T>]

例

M1 Nd Ng Ns 0 MyMOSFET

.model MyMOSFET NMOS(KP=.001)

M1 Nd Ng Ns Nb MypMOSFET

.model MypMOSFET PMOS(KP=.001)

垂直二重拡散パワーMOSFET

Syntax: Mxxx Nd Ng Ns <model> [L=<len>] [W=<width>]

+ [M=<area>] [m=<value>] [off]

+ [IC=<Vds, Vgs, Vbs>] [temp=<T>]

例

M1 Nd Ng Ns Si4410DY

.model Si4410DY VDMOS(Rd=3m Rs=3m Vto=2.6 Kp=60

+ Cgdmax=1.9n Cgdmin=50p Cgs=3.1n Cjo=1n

+ Is=5.5p Rb=5.7m)

MOSFETモデルカードは、どのタイプのモデルを使うかと言うことを示さねばなりま

せん。モデル・カード・キーワード NMOSと PMOSは、モノリシック Nあるいは Pチャ

ネルMOSFETを示しています。モデル・カード・キーワード VDMOSは、垂直二重拡散

パワー MOSFETを示しています。

モノリシック MOSFETは、四端子デバイスです。Nd、Ng、Nsそれと Nbは、ドレイ

ン、ゲート、ソースそれとバルクを示しています。L およびWは、メータ単位のチャネル
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長とチャネル幅を示しています。AD と ASは、平方メータで示したドレインおよびソー

ス拡散の面積です。サフィックス uは、µmを示し、pは、µmの平方を示しています。

L、W、AD および ASが示されていない場合、デフォルトの値が用いられます。PDおよ

び PSは、メータで表したドレインおよびソースの周囲長です。NRDおよび NRSは、ド

レインあるいはソース拡散の正方形の数を示しています。これらの値は、.MODEL制御

において決められシート抵抗 RSHに掛けられます。PDPSのデフォルトはゼロ、NRD、

NRSのデフォルトは 1です。OFFは、直流解析のデバイス初期条件を与えます。過渡解

析が定常状態の直流値よりも別の点で始めたいとき、IC=VDS、VGS、VBSを用いて与え

られる初期条件は、.TRAN制御上において UID オプションで用いるためです。オプショ

ン TEMP値は、素子が動作するときの温度で、.OPTION制御の規定されている温度を上

書きします。温度の規定は、レベル１，２，３および６ MOSFETでのみ有効で、レベル

４，５，あるいは８ BSIM素子では使えません。

LTspiceは、七つの異なったタイプのモノリシック MOSFETと一つの垂直二重拡散パ

ワー MOSFETが含まれています。

七つのモノリシックMOSFET素子モデルがあります。モデル・パラメータ LEVEL は、

使われるモデルを規定します。デフォルト LEVEL は、１です。

LEVEL モデル

1 Shichman-Hodges

2 MOS2*2

3 MOS3　半経験モデル（LEVEl2の文献参照）

4 BSIM*3

5 BSIM2*4

6 MOS6*5

8 BSIM3v3.2.4 from University of Calfornia, Berkeley as of December 2001

9 BSIMSOI3.2 (Silicon on insulator)*6

12 EKV 2.6 based on code from Ecole Polytechnique Federale de Lausanne*7

14 BSIM4.4.0 from University of Calfornia, Berkeley as of March 4, 2004

表 5.17 LEVEL of MOSFET

Level 1から Level 3MOSFETの直流特性は、デバイス・パラメータ VTO、KP、LAMBDA

および GAMMA によって定義されています。これらのパラメータは、もしプロセスパラ

メータ NSUB、TOX...が与えられているならば計算されますが、ユーザー定義の値も上書

きすることが可能です。VTOは、エンハンス・モードでは正（負）、デプレッション・モー

ド Nチャネル（Pチャネル）では負（正）です。電荷蓄積は、三つの一定の値を持つ容量

CGSO、CGDOおよび CGBOによってモデル化されています。これらは、オーバーラッ

プされた容量を表しています。またこれらの非線形薄酸化膜容量は、ゲート、ソース、ド

レインおよびバルク領域の間に分布しています。二つのサブストレート接合の非線形空間

電荷層容量は、底辺と周囲とに分割されます。これらの容量は、接合電圧の MJ、MJSW

によって変化します。そしてパラメータ CBD、CBS、CJ、CJSW、MJ、MJSWおよび PB

によって決められます。電荷蓄積効果は、Meyerによって提案されたピーシワイズ・リニ

ア電圧依存性容量によってモデル化されています。薄膜酸化電荷蓄積効果は、Level=1モ

デルでは少し違った形で与えられています。これらの電圧依存容量は、TOXが規定され
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るときのみ含まれます。

接合を記述しているパラメータには、あるオーバーラップがあります。飽和電流は、

Is [Amp] あるいは Js [Amp/m/m]を通じて規定されます。一方最初のパラメータは、絶

対値であり、二番目の値はドレインもしくはソース接合の逆電流を与えるため各々 Ad、

Asを掛けることによって得られます。同じ考えがゼロ・バイアス接合容量 CBDと CBS

[Farad]それと CJ [Farad/m/m]にも適用されています。寄生ドレインおよびソース直列抵

抗は、RD、RS [Ohms]あるいは RSH [Ohms/square]として表現されます。後者は、NRD

および NRSの平方を掛けます。

MOSFET Level１，２，３および６のパラメータ

名称 パラメータ 単位 デフォルト 例

VTO ゼロ・バイアス・スレッショルド電圧 V 0. 1.

KP トランスコンダクタンス sqrt(V) 2e-5 3e-5

GAMMA バルク・スレッショルド・パラメータ V 0. 0.37

PHI 表面ポテンシャル V 0.6 0.65

LAMBDA チャネル長変調（レベル１，２のみ） 1/V 0. 0.02

Rd ドレイン抵抗 Ohms 0. 1.

Rs ソース抵抗 Ohms 0. 1.

Cbd ゼロ・バイアス B-Ｄ接合容量 F 0. 20f

Cbs ゼロ・バイアス B-S接合容量 F 0. 20f

Is バルク接合飽和電流 A 1e-14 1e-15

N バルク・ダイオード・エミッション係数 - 1.

Pb バルク接合ポテンシャル V 0.8 0.87

Cgso 単位チャネル幅当たりのゲート・ソース容量 F/m 0. 4e-11

Cgdo 単位チャネル幅当たりのゲート・ドレイン容量 F/m 0. 4e-11

Cgbo 単位チャネル幅当たりのゲート・バルク容量 F/m 0. 2e-10

Rsh ドレイン・ソース拡散シート抵抗 Ohms 0. 10

Cj 単位接合面積当たりのゼロ・バイアス
バルク容量 F/m/m 0. 2e-4

Mj バルク接合傾斜係数 - 0.5 0.5

Cjsw 接合周囲の単位長当たりのゼロ・
バイアス壁面容量 F/m 0. 1e-9

Mjsw 壁面接合傾斜係数 (Level 1) - 0.50

壁面接合傾斜係数 (Level 2, 3) - 0.33

Js 単位接合面積当たりのバルク接合飽和電流 A/m 0. 1e-8

Tox 酸化膜厚 m 1e-7 1e-7

Nsub サブストレート・ドーピング 1/cm/cm/cm 0. 4e15

Nss 表面状態密度 1/cm/cm 0. 1e10

Nfs 高速表面状態密度 1/cm/cm 0. 1e10

TPG ゲート材料の型 - 1.
+1 opp. to substrate
-1サブストレートと同じ
0 Al ゲート

XJ 金属接合深さ m 0. 1µ
LD カテラル拡散 m 0. 0.8µ
UO 表面移動度 cm*cm/V/s 600 700

Ucrit 移動度減衰の境界場（MOS2のみ） V/cm 1E4 1e4

Uexp 移動度減衰指数の境界場（MOS2のみ） - 0. 0.1

UTRA 逆方向場係数（移動度）（MOS2では削除） - 0. 0.3

Vmax キャリアの最大ドリフト速度 m/s 0. 5e4

Neff 全チャネル電荷（固定および可動）
係数（MOS2のみ） - 1. 5.0

KF フリッカ雑音係数 - 0. 1e-26

AF フリッカ雑音指数 -. 1. 1.2



5.4 回路素子 87

FC 順方向バイアス空間電荷層の係数 - 0.5

DELTA スレッショルド電圧上の幅の影響
（MOS2およびMOS3） - 0. 1.

THETA 移動度変調（MOS3のみ） 1/V 0. 0.1

ETA 静的帰還（MOS3のみ） - 0. 1.

KAPPA 飽和場要因（MOS3のみ） - 0.2 0.5

Tnom パラメータ測定温度 ℃ 27 50

表 5.18: MOSFET Level１，２，３および６のパラメータ

図 5.4 VDMOS

ボード・レベル・スイッチ・モード電力源で一般的に用いられている個別の垂直二重拡

散 MOSFETトランジスタ (VDMOS)は、上記のモノリシック MOSFETモデルとは質的

に異なった振る舞いをします。特に

1. VDMOSトランジスタに含まれるダイオードは、モノリシック MOSFETのサブス

トレート・ダイオードとは違う外部端子に接続されています。

2. 非線形ゲート・ドレイン容量 (Cgd)は、モノリシック MOSFETモデルの簡単な傾

斜型容量でモデル化することは出来ません。

VDMOSトランジスタにおいて、Cgdは、ゼロ電圧ゲート・ドレインのところで急激に

変化します。Vgdが負のとき、Cgdは、一つの電極のゲートともう一つの電極としての基

板上のドレインとの容量に物理的に基づいています。この容量は、伝導性がない基板の厚

みにはあまり依存していません。しかし Vgdが正のとき、基板は伝導性となり、Cgdは

ゲート酸化膜圧の容量に物理的に依存します。

伝統的に巧く作られたサブサーキットが、パワー MOSFETを複製するために用いられ

てきました。新しい本来の spice素子が、計算速度を向上するため、収束性の信頼度を向

上させるため、モデルの記述を簡単にするために記述されています。直流モデルは、デ

フォルトで長さと幅を１にする場合を除いてレベル１モノリシック MOSFETと同じで

す。その結果トランスコンダクタンスは、スケーリングしなくても直接規定することが出

来ます。交流モデルは、次のようになっています。ゲート・ソース容量は、一定と考えら

れます。このことはゲート・ソース電圧が負の方向に駆動されていると、パワーMOSFET

の良い近似となっていることが経験から分かります。ゲート・ドレイン容量は、次の経験

的に観察される形に従います。
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図 5.5 ドレイン・ゲート容量

正の Vgdに対して Cgdは、Vgdのハイパブリック・タンゼントで変化します。負の

Vgdに対して Cgdは、Vgdのアーク・タンゼントで変化します。モデル・パラメータ a、

Cgdmin、Cgdmaxは、ゲート・ドレイン容量のパラメータです。ソース・ドレイン容量は、

ソース・ドレイン端子に接続された基板ダイオードの傾斜容量によって決められ、ソー

ス・ドレイン抵抗の外側にあります。

名称 パラメータ 単位 デフォルト 例

l 長さ m 1. 2.

w 幅 m 1. 1.

Rg ゲート抵抗 Ohms 0.

Rds ドレインーソース・シャント抵抗 Ohms 0.

VTO ゼロバイアススレッショルド電圧 V 0. 1.

KP トランスコンダクタンス A/V 1/ 3.

PHI 表面ポテンシャル V 0.6 0.65

LAMBDA チャネル長変調 1/V 0. 0.02

Cbd ゼロバイアス B-D接合容量 F 0. 20f

Cbs ゼロ・バイアス B-S接合容量 F 0. 20f

Rd ドレイン抵抗 Ohms 0.

Rs ソース抵抗 Ohms 0.

Cgs ゲート・ソース・オーバーラップ容量 F 0. 4e-11

Cgdmin 最少非線形 G-D容量 F 0. 4e-11

Cgdmax 最大非線形 G-D容量 F 0. 4e-11

a 非線形 Cgd容量パラメータ l 1. .5

Is 基板ダイオード飽和電流 A 1e-14 1e-15

Rb 危難ダイオード抵抗 Ohms 0.

n 基板ダイオード・エミッション係数 - 1/

Cjo 基板ダイオード接合容量 F 0. 4e-11

Vj 基板ダイオード接合ポテンシャル V 0.75

m 基板ダイオード傾斜係数 - 0.5 0.5

Fc 基板ダイオード順方向バイアス

接合適合パラメータ - 0.5

tt 基板ダイオード遷移時間 sec 0.

Eg Isの温度効果に対する基板

ダイオード活性エネルギー eV 1.11

Xti 基板ダイオード飽和電流温度指数 - 3

nchan[*] nチャネル VDMOS - true
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pchan[*] Pチャネル VDMOS - false

Tnom パラメータ測定温度 ℃ 27

Kf フリッカ雑音計数 - 0

Af フリッカ雑音指数 - 0

表 5.19: VDMOSパラメータ

VDMOSという名称は、N チャネルおよび Pチャネル素子に対して用いられます。デ

フォルトの極性は、N チャネルです。Pチャネルとするためには、キーワード pchanに

モデルのフラッグを立てなければ行けません。例えば.model xyz VDMOS(Kp = 3 pchan)

は、pチャネル・トランジスタを示します。

5.4.14 損失のある伝送線路

Symbol Names: RES, RES2

Syntax: Oxxx L+ L- R+ R- <model>

例

O1 in 0 out 0 MyLossyTline

.model MyLossyTline LTRA(len=1 R=10 L=1u C=10n)

これは単一線路の損失がある伝送線路です。N1および N2は、端子対１のノードです。

N3と N4は、端子対２のノードです。モデル・カードは、この回路素子の電気的特性を

定義します。

名称 パラメータ 単位/型 デフォルト

R 単位長当たりの抵抗 Ohm/unit 0.

L 単位長当たりのインダクタンス Henrys/unit 0.

G 単位長当たりのコンダクタンス mhos/unit 0.

C 単位長当たりの容量 Farads/unit 0.

LEN ライン長 none

REL ブレーキング・ポイントの制御 - 1

ABS ブレーキング・ポイントの制御 1

NOSTEPLIMIT 線路遅延より少ない時間ステップを禁止 flag not set

NOCONTROL 複雑な時間ステップを禁止 flag not set

LININTERP 線形近似を行う flag not set

MIXEDINTERP 履歴を圧縮するための特別な reltol flag not set

COMPACTABS 履歴を圧縮するための特別な rabstol flag RELTOL

TRUNCNR 時間ステップ制御に Newton-Raohson法

を用いる ABSTOL

TRUNCDONTCUT インパルス応答のエラーを少なくす

るため時間ステップを制限しない flag not set

表 5.20 損失のある伝送線路のパラメータ
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5.4.15 バイポーラ・トランジスタ

Symbol Names: NPN, PNP, NPN2, PNP2

Syntax: Qxxx Collector Base Emitter [Substrate Node] model

+ [area] [off] [IC=<Vbe, Vce>] [temp=<T>]

例

Q1 C B E MyNPNmodel

.model MyNPNmodel NPN(Bf=75)

バイポーラ・トランジスタは、その特性を規定するためにモデル・カードが必要です。

モデル・カードのキー NPN、PNPは、トランジスタの極性を示しています。areaファク

ターは、指定されたトランジスタが何個並列に接続されているかを示しています。

バイポーラ接合トランジスタ・モデルはガンメルとプーンの積分型電荷制御モデルを採

用しています。この変形されたガンメル・プーン・モデルは、オリジナルを拡張し高電圧

でのいくつかの効果、準飽和、サブストレート伝導を含んでいます。このモデルは、ある

パラメータが規定されていないとき自動的に簡略化されエバース・モル・モデルとなりま

す。直流モデルは、次のパラメータによって定義されます。Is、Bf、Nf、Ise、Ikf、Neな

どは、順方向電流利得特性を決めます。Is、Br、Nr、Isc、Ikr などは、逆方向電流利得特性

を決めます。Vafや Varは、順方向および逆方向の出力コンダクタンスを決めます。三つ

の抵抗 Rb、Rcおよび Reが含まれます。ここで Rbは、高電流依存性があります。ベー

ス電荷蓄積は、順方向逆遷移時間 Tf、方向遷移時間 Tr によってモデル化されています。

順方向遷移時間 Tf は、必要ならばバイアス依存性を持たせることが出来ます。非線形空

間電荷層容量は、B-E接合では Cje、Vje、Mje、B-C接合では Cjc、Vjc、Mjc、C-S接合

では Cjs、Vjs、Mjs、によって決められます。飽和電流 Isの温度依存性は、エネルギー

ギャップ Egと飽和電流温度指数 XTI によって決められます。加えてベース電流温度依

存性は、新しいモデルでベータ温度指数 XTB によってモデル化されています。規定され

る値は、温度 TNOMで測定されると規定しています。これは、オプションで決められる

か.model上で規定されています。

変形ガンメル・プーンモデルで用いられている BJTパラメータは、次のリストで示して

あります。

名称 パラメータ 単位 デフォルト

Is 飽和電流 A 1e-16

Bf 理想最大順方向ベータ - 100

Nf 順方向エミッション係数 - 1.0

Vaf 順方向アーリー電圧 V infinite

Ikf 順方向ニー電流 A infinite

NE B-Eリーク・エミッション係数 A 1.5

Br 理想最大逆ベータ - 1

Nr 逆電流エミッション係数 - 1

Var 逆方向アーリー電圧 - infinite
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Ikr 逆方向ベータが落ち始める電流値 V infinite

Isc B-Cリーク飽和電流 A 0

Nc B-Cリーク・エミッション係数 A 2

Rb ゼロバイアスベース抵抗 - 0

Irb 逆方向ニー電流 Ohm infinite

Rbm 高電流での最少ベース抵抗 A RB

Re エミッタ容量 Ohm 0

Rc コレクタ抵抗 Ohm 0

Cje B-Eゼロバイアス空間電荷層容量 Ohm 0

Vje B-Eビルトイン・ポテンシャル F 0.75

Mje B-E接合ポテンシャル要素 V 0.33

Tf 理想順方向遷移時間 sec 0

Xtf TFのバイアス依存性係数 - 0

Vtf TFの VBC依存性 V infinite

Itf TFの高電流パラメータ A 0

PTF freq=1.0/(TF*2PI) Hzでの過剰位相 deg 0

Cjc B-Cゼロバイアス空間電荷層容量 F 0

Vjc B-Cビルトイン・ポテンシャル V 0.75

Mjc B-C接合指数要素 - 0.33

Xcjc 内部ベースノード接続 B-C空間容量要素 - 1

Tr 理想逆遷移時間 sec 0

Cjs ゼロ・バイアス C-S容量 F 0

Vjs サブストレート接合ビルトイン・ポテンシャル V 0.75

Mjs サブストレート接合指数要素 - 0

Xtb 順逆ベータ温度指数 - 0

Eg Isの影響によるエネルギーギャップ eV 1.11

Xti Isの影響による温度指数 - 3

Kf フリッカ雑音係数 - 0

Af フリッカ雑音指数 - 1

Fc 順バイアス空間容量式の係数 - 0.5

Tnom パラメータ測定温度 ℃ 27

cn ホール移動度の準飽和温度係数 2.42 NPN

2.2 PNP

d 散乱飽和速度の準飽和温度係数 .87 NPN

.52 PNP

gamma エピタキシャル領域ドーピング要素 1e-11

qco エピタキシャル領域電荷要素 Cou1 0

quasimod 温度依存性の準飽和フラッグ - 0

rco エピタキシャル領域抵抗 Ohm 0

vg 0Kでの準飽和推定バンドギャップ電圧 V 1.206

vo キャリア移動度ニー電圧 V 10.

Tre1 Re第１項温度係数 /℃ 0

Tre2 Re第２項温度係数 /℃/℃ 0

Trb1 Rb第１項温度係数 /℃ 0

Trb2 Rb第２項温度係数 /℃/℃ 0

Trc1 Rc第１項温度係数 /℃ 0

Trc2 Rc第２項温度係数 /℃/℃ 0

Trm1 Rmb第１項温度係数 /℃ 0

Trm2 Rmb第２項温度係数 /℃/℃ 0
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Iss サブストレート接合飽和電流 A 0

Ns サブストレート接合エミッション係数 - 1

表 5.21:変形ガンメル・プーン BJTパラメータ

モデル・パラメータ levelは、LTspiceのその他の BJTと区別するために用いられてい

ます。Dr. -Ing. Dietmar Warning of DAnalyse GmbH, Berlin, Germanyの寛大な貢献によ

り、LTspiceは VBIC を含んでいます。このデバイスを用いるには、Level=9と設定しま

す。Level=4は、Level=9と同じです。次の資料は、Dr. Warningから提供されています。

VBIC - Vertical Bipolar Inter Company model

ＶびＣモデルは、現代の半導体技術における集積バイポーラ・トランジスタに注目した

標準のガンメル・プーン (SGP)モデルを拡張したモデルです。Kull や Nagelによって研

究された準飽和モデルを含み、スイッチング・トランジスタの特別な出力特性をモデル化

することが出来ます。シリコン、SiGeそして III-V HBT 素子の SGPモデルに広く用いら

れています。

VBIC の優位性が、標準のガンメル・プーン・モデルと比較されています。

• 集積回路の寄生素子であるサブストレート・トランジスタが組み込まれています。
• 弱い雪崩現象とベース・エミッタ・ブレークダウン・モデル
• アーリー効果の改善
• Icと Ibの物理的な分離

• 改良された空間電荷容量モデル
• 自己加熱モデル（このバージョンでは含まれていない）

図 5.6 モデルの構造
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パラメータ

VBIC は、SGPモデルに基づいていますので、SGPパラメータから始めていくつかの変

換を行うことができます。次のパラメータは、VBIC version 1.2です。これらは、過剰位

相回路および自己加熱効果を含んでいませんが、LTspiceに組み込まれています。SGPか

ら BVIC へ切り替えるには、Levelを 9に設定しなければ行けません。

名称 パラメータ 単位 デフォルト

tnom パラメータ測定温度 deg C 27.0

rcx 外部コレクタ抵抗 Ω 0.1

rci コレクタ抵抗 Ω 0.1

vo エピ・ドリフト飽和電圧 V 8

gamm エピ・ドーピング・パラメータ 0.0

hrcf 高電流 RC要素 8

rbx 外部ベース抵抗 Ω 0.1

rbi ベース抵抗 Ω 0.1

re エミッタ抵抗 Ω 0.1

rs サブストレート抵抗 Ω 0.1

rbp 寄生ベース抵抗 Ω 0.1

is 転送飽和電流 A 1e-16

nf 順方向エミッション係数 1.0

nr 逆方向エミッション係数 1.0

fc 順方向バイアス空間電荷容量制限 0.9

cbeo 外部 B-Eオーバーラップ容量 F 0.0

cje ゼロバイアス B-E空間電荷容量 F 0.0

pe B-Eビルトインポテンシャル V 0.75

me B-E接合傾斜係数 0.33

aje B-E容量滑らかさ要素 -0.6

cbco 外部 B-Cオーバーラップ容量 F 0.0

cjc ゼロバイアス B-C空間電荷容量 F 0.0

qco エピ電荷パラメータ C 0.0

cjep B-C外部ゼロバイアス容量 F 0.0

pc B-Cビルトインポテンシャル V 0.75

mc B-C接合傾斜係数 0.33

ajc B-C容量滑らかさ要素 -0.5

cjcp ゼロバイアス S-C容量 F 0.0

ps S-C接合ビルトインポテンシャル V 0.75

ms S-C接合傾斜係数 0.33

ajs S-C容量滑らかさ要素 -0.5

ibei 理想 B-E飽和電流 A 1e-18

wbe Vbeiから IBEI、Vbexから 1-WBEの部分 1.0

nei 理想 B-Eエミッション係数 1.0

iben 非理想 B-C飽和電流 A 0.0

nen 非理想 B-Cエミッション係数 2.0

ibci 理想 B-C飽和電流 A 1e-16

nci 理想 B-Cエミッション係数 1.0

ibcn 非理想 B-C飽和電流 A 0.0

ncn 非理想 B-Cエミッション係数 2 1.0
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avc1 B-C弱アバランシェ・パラメータ 1 1/V 0.0

avc2 B-C弱アバランシェ・パラメータ 2 1/V 0.0

isp 寄生転送飽和電流 A 0.0

wsp ICCPの部分 1.0

nfp 寄生順方向エミッション係数 1.0

ibeip 理想寄生 B-E飽和電流 A 0.0

ibenp 非理想寄生 B-E飽和電流 A 0.0

ibcip 理想寄生 B-C飽和電流 A 0.0

ncip 非理想寄生 B-Cエミッション係数 1.0

ibcnp 非理想寄生 B-C飽和電流 A 0.0

ncnp 非理想寄生 B-Cエミッション係数 2.0

vef 順方向アーリー電圧 8

ver 逆方向アーリー電圧 8

ikf 順方向ニー電流 A 8

ikr 逆方向ニー電流 A 8

ikp 寄生ニー電流 A 0

tf 理想順方向転移時間 sec 0.0

qtf ベース幅変調に関する TF変化 0.0

xtf TFのバイアス依存係数 0.0

vtf TFの VBC電圧依存 V 8

itf TFの高電流依存 A 8

tr 理想逆転移時間 sec 0.0

td 順方向過剰位相遅延時間 sec 0.0

kfn B-Eフリッカ雑音係数 0.0

afn B-Eフリッカ雑音指数 1.0

bfn B-Eフリッカ雑音 1/f依存性 1.0

xre REの温度指数 0.0

xrbi RBIの温度指数 0.0

xrci RCIの温度指数 0.0

xrs RSの温度指数 0.0

xvo VOの温度指数 0.0

ea ISの活性エネルギー V 1.12

eaie IBEI の活性エネルギー V 1.12

eaic IBCI/IBEIPの活性エネルギー V 1.12

eais IBCIPの活性エネルギー V 1.12

eane IBENの活性エネルギー V 1.12

eanc IBCN/IBENPの活性エネルギー V 1.12

eans IBCNPの活性エネルギー V 1.12

xis ISの温度指数 3.0

xii IBEI、IBCI、IBEIP、IBCIPの温度指数 3.0

xin IBEN、IBCN、IBENP、IBCNPの温度指数 3.0

tnf NFの温度指数 0.0

tavc AVC2の温度指数 0.0

rth 温度抵抗 K/W 0.0

cth 温度容量 Ws/K 0.0

vrt 内部 B-C接合パンチスルー電圧 V 0.0

art 滑らかさパラメータ 0.1

ccso 固定 C-S容量 F 0.0
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qbm SGP qb式の選択 0.0

nkf 高電流ベータ。ロールオフ 0.5

xikf IKF 温度指数 0.0

xrcx RCX温度指数 0.0

xrbx RBX温度指数 0.0

xrbp RBP温度指数 0.0

isrr 順逆方向分離 IS 1.0

xisr ISR温度指数 0.0

dear ISRRデルタ活性エネルギー 0.0

eap ISPの励起エネルギー 1.12

vbbe B-Eブレークダウン電圧 V 0.0

nbbe B-Eブレークダウン・エミッション係数 1.0

ibbe B-Eブレークダウン電流 1e-06

tvbbe1 VBBEの線形温度係数 0.0

tvbbe2 VBBEの２次温度係数 0.0

tnbbe NBBEの温度係数 0.0

ebbe exp(-VBBE/(NBBE*Vtv) 0.0

dtemp ローカル温度差 dec 0.0

vers リビジョン・バージョン 1.2

vref レファレンス・バージョン 0.0

表 5.22: VBICパラメータ

参照

C. C. McAndrew et al., "Vertical Bipolar Inter Company 1995:

An Improved Vertical, IC Bipolar Transistor Model",

Proceedings of the IEEE Bipolar Circuits and Technology

Meeting, pp. 170 ・177, 1995

C. C. McAndrew et.al., VBIC95, "The Vertical Bipolar

Inter-Company Model", IEEE Journal of Solid State Circuits,

vol. 31, No. 10, October 1996

C. C. McAndrew, VBIC Model Definition, Release 1.2, 18.

Sep. 1999

5.4.16 抵抗

Symbol Names: RES, RES2

Syntax: Rxxx n1 n2 <value> [tc=tc1, tc2, ...]

抵抗は、ノード n1、n2に簡単な線形抵抗を供給します。温度依存性は、パラメータ tc

で各々の抵抗に対して定義することが出来ます。抵抗 Rは、次のように記述されます。
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R = R0 * (1. + dt * tc1 + dt**2 * tc2 + dt**3 * tc3 + ...)

ここで R0は、通常の温度での抵抗です。dtは、抵抗の温度と通常温度との差です。

5.4.17 電圧制御スイッチ

Symbol Names: SW

Syntax: Sxxx n1 n2 nc+ nc- <model> [on,off]

例

S1 out 0 in 0 MySwitch

.model MySwitch SW(Ron=.1 Roff=1Meg Vt=0 Vh=-.5 Lser=10n Vser=.6)

ノード nc+とノード nc-の間の電圧は、ノード n1とノード n2の間のスイッチインピー

ダンスを制御します。モデル・カードは、スイッチの振る舞いを定義するために必要で

す。回路ファイル./examples/Educational/Vswitch.ascを見て下さい。これは、spiceコマ

ンドとして回路図上に直接置くことの出来るモデル・カードの例を示しています。

名称 パラメータ 単位 デフォルト

Vt スレッショルド電圧 Volts 0.

Vh ヒステレシス電圧 Volts 0.

Ron オン抵抗 Ohms 1.

Roff オフ抵抗 Ohms 1/gmin

Lser 直列インダクタンス Henry 0.

Vser 直列電圧 Volts 0.

ilimit 電流制限 Amps infin

表 5.23 電圧制御スイッチ・モデル・パラメータ

スイッチは、電圧制御による三つのモードがあります。この電圧とは、ヒステレシス電

圧 Vhの値に依存しています。Vhがゼロの場合、入力電圧がスレッショルドの値より高

いかどうかによって、いつでもオンまたはオフとなります。Vhが正の場合、Vt-Vh およ

び Vt+Vh の点でシュミット・トリガによって制御されているかのようにスイッチはヒス

テレシスとなります。Vhが負の場合には、スイッチは滑らかにオンとオフのインピーダ

ンスの間を移動します。移動は、Vt-Vh と Vt+Vh 制御電圧の間で起こります。滑らかな

変化は、スイッチ伝導の対数に一致した低い次数に従います。

5.4.18 無損失伝送線路

Symbol Name: TLINE

Syntax: Txxx L+ L- R+ R- Zo=<value> Td=<value>

L+および L-は、一端子網のノードです。R+と R-は、もう一方の端子網のノードです。

Zoは、特性インピーダンスです。線路の長さは、伝送遅延 Tdによって与えられます。
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この素子は、伝送モードのみをモデル化しています。全ての四つのノードが実際の回路

で区別されているとすれば、二つのモードが励起されます。この様な状況をシミュレート

するには、二つの伝送線路が必要となります。

5.4.19 均一 RC線路

Symbol Names: URC

Syntax: Uxxx N1 N2 Ncom <model> L=<len> [N=<lumps>]

N1と N2は、RC線路が接続している二つの素子ノードです。一方 Mcomは、容量が

接続されているノードです。MNAME は、モデル名で、LENは、RC線路をメータで表示

する長さです。もし規定するつもりであるならば、Lumpsは、RC線路をモデル化するた

めに用いる集中素子の数を示しています。用いられる適当な集中定数素子の数は、規定す

ることが出来ます。

URCモデルは、L. Gertzberrg in 1974によって提案されたモデルから導かれています。

このモデルは、内部によって生成されているノードによって集中定数 RC素子の回路網

となる URC線路のサブサーキット・タイプの拡張によって実現されています。この RC

素子は、URC線路の中心に向かって増加するように幾何学的に拡張され、比例定数 K を

持っています。

URC線路は、ISPERLパラメータが非ゼロの値に設定されていなければ、厳密に抵抗

と容量とで構成されています。この場合容量は、ゼロ・バイアス接合容量の値を持った逆

向きダイオードの容量で置き換えられます。それと単位伝送線路当たり ISPERL ampsの

飽和電流とオプションの単位長さ当たり RSPERL ohmsに等しい直列抵抗で置き換えられ

ます。

名称 パラメータ 単位 デフォルト

K 伝搬定数 none 2.

FMAX 取り扱う最大周波数 Hz 1 G

RPERL 単位長の抵抗 Ohm/m 1000

CPERL 単位長の容量 F/m 1e-15

ISPERL 単位長当たりの飽和電流 A/m 0

RSPERL 単位長当たりのダイオード抵抗 Ohm/m 0

表 5.24

5.4.20 電圧源

Symbol Names: VOLTAGE, BATTERY

Syntax: Vxxx n+ n- <voltage> [AC=<amplitude>]

+ [Rser=<value>] [Cpar=<value>]

この素子は、ノード n+と n-に一定の電圧を供給します。交流解析に対して AC の値

は、解析周波数での電源の大きさとして用いられます。直列抵抗と並列抵抗が、定義でき
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ます。等価回路は、次の図として与えられます。

図 5.7 電圧源等価回路

電圧源は、SPICEで歴史的に電流メータとして、電流制御素子の電流センサとして使わ

れていました。Rserが規定されていると、電圧源は F、HあるいはW素子の感応素子と

して用いることは出来ません。しかし任意の回路素子の電流は、電圧源を含んで描画する

ことが出来ます。

Syntax: Vxxx n+ n- PULSE(V1 V2 Tdelay Trise Tfall Ton Tperiod Ncycles )

名称 パラメータ 単位

Voff 初期値 Volts

Von パルス値 Volts

Tdelay 遅延 seconds

Tr 立ち上がり時間 seconds

Tf 立ち下がり時間 seconds

Ton オン時間 seconds

Tperiod 期間 seconds

Ncycles サイクル波の数 cycles

表 5.25 時間依存性パルス電圧源

Syntax: Vxxx n+ n- SINE(Voffset Vamp Freq Td Theta Phi Ncycles)
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名称 パラメータ 単位

Voffset 直流オフセット Volts

Vamp 振幅 Volts

Freq 周波数 Hz

Td 遅延 seconds

Theta ダンピング・ファクタ 1/seconds

Phi 位相 degrees

Ncycles サイクル波の数 cycles

表 5.26 時間依存性正弦波電圧源

Tdより短い時間あるいは Ncyclesが完了した後に対して、走ります。出力電圧は、次

のように与えられます。

Voffset+Vamp*sin(pi*Phi/180)

その他電圧は、次のようになります。

Voffset+Vamp*exp(-(time-Td)*Theta)*sin(2*pi*Freq*(time-Td)

+pi*Phi/180)

ダンピング・ファクタ Thetaは、遅延時間定数の逆数です。

Syntax: Vxxx n+ n- EXP(V1 V2 Td1 Tau1 Td2 Tau2)

名称 パラメータ 単位

V1 初期値 Volts

V2 パルス値 Volts

Td1 立ち上がり遅延時間 seconds

Tau1 立ち上がり時定数 seconds

Td2 立ち下がり遅延時間 seconds

Tau2 立ち下がり時定数 seconds

表 5.27 時間依存性指数電圧源

Td1より少ない時間に対して、出力電圧は、V1です。Td1と Td2の時間の間で、電圧

は次のように与えられます。

V1+(V2-V1)*(1-exp(-(time-Td1)/Tau1))

Td2の後の時間では、電圧は次のようになります。

V1+(V2-V1)*(1-exp(-(time-Td1)/Tau1))

+(V1-V2)*(1-exp(-(time-Td2)/Tau2))

Syntax: Vxxx n+ n- SFFM(Voff Vamp Fcar MDI Fsig)
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名称 パラメータ 単位

Voff 直流オフセット Volts

Vamp 振幅 Volts

Fcar 搬送波周波数 Hz

MDI 変調度 none

Fsig 周波数 Hz

表 5.28 時間依存性単一周波数 FM電圧源

電圧は、次のように与えられます。

Voff+Vamp*sin((2.*pi*Fcar*time)+MDI*sin(2.*pi*Fsig*time))

Syntax: Vxxx n+ n- PWL(t1 v1 t2 v2 t3 v3...)

任意のピース・ワイズ線形電圧源

T1より前の時間に対して、電圧は V1です。時間 T1と T2の間では、電圧は V1と V2

の間を線形に変化します。任意の数の時間と電圧をとることが出来ます。最後の指定時間

の後、電圧は最後の時間のままです。

Syntax: Vxxx n+ n- wavefile=<filename> [chan=<nnn>]

この記述は、.waveファイルに対して LTspiceへの入力として用いることが出来るよう

にします。.waveファイルへの絶対パスあるいは相対パスは、シミュレーション回路図あ

るいはネットリストに含まれるディレクトリから計算されます。ダブル・クオーテイショ

ンは、空白を含むパスを指定するために用いられます。

.waveファイルは、65536チャネルまで、0から 65535までの数値を含むことが出来ま

す。Chanは、どのチャネルが用いられるか設定するために用いられます。デフォルトは、

最初のチャネル 0です。.waveファイルは、フルスケール範囲-1 Vから 1 Vまでになるよ

うに変換されます。

この電源は、過渡解析だけで意味があります。

5.4.21 電流制御スイッチ

Symbol Names: CSW

Syntax: Wxxx n1 n2 Vnam <model> [on,off]

例

W1 out 0 Vsense MySwitch

Vsense a b 0.

.model MySwitch CSW(Ron=.1 Roff=1Meg It=0 Ih=-.5)

名前が付けられた電圧源を流れる電流は、スイッチのインピーダンスを制御します。モ

デル・カードは、電流制御スイッチの振る舞いを定義するために必要です。
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名称 パラメータ 単位 デフォルト

It スレッショルド電流 Volts 0.

Ih ヒステレシス電流 Volts 0.

Ron オン抵抗 Ohms 1.

Roff オフ抵抗 Ohms 1/gmin

表 5.29 電流制御スイッチ・モデル・パラメータ

このスイッチは、電流制御、ヒステレシス電流の値依存性、Ihの三つの違うモードがあ

ります。Ihがゼロの場合、スイッチは制御電流がスレッショルドを越えるかどうかによっ

てオンまたはオフになります。Ihが正の場合、スイッチは It-Ih または It+Ih の電流点を

持つヒステレシスを示します。Ihが負の場合、スイッチはオンとオフのインピーダンスの

間を滑らかに変化します。変化は、It-Ih と It+Ih の制御電流の値で起こります。滑らかな

変化は、スイッチ・コンダクタンスの対数に適合した低次元の多項式となります。

5.4.22 サブサーキット

Symbol Names:

LT1001 LT1006 LT1028 LT1070 LT1071

LT1072 LT1074 LT1109-12 LT1109-5 LT1109

LT1109A-12 LT1109A-5 LT1109A LT1112 LT1124

LT1169 LT1170 LT1170HV LT1171 LT1171HV

LT1172 LT1172HV LT1211 LT1227 LT1300

LT1301 LT1302-5 LT1302 LT1303-5 LT1303

LT1304-3.3 LT1304-5 LT1304 LT1305 LT1307

LT1307b LT1309 LT1316 LT1317 LT1317b

LT1351 LT1371 LT1372 LT1375-5 LT1375

LT1376-5 LT1376 LT1377 LT1413 LT146

LT1490 LT1498 LT1533 LT1610 LT1611

LT1613 LT1614 LT1627 LT1676 LT1735

LTC1047 LTC1174-3.3 LTC1174-5 LTC1174 LTC1174HV-3.3

LTC1174HV-5 LTC1174HV LTC1625 LTC1628 LTC1736

(and others)

Syntax: Xxxx n1 n2 n3... <subckt name> [<parameter>=<expression>]

サブサーキットは、名前によって後から呼び出されるため、ライブラリに定義され保存

された回路です。下記は、電圧分割回路として定義され呼び出される回路で、回路の中で

呼び出します。

* calling a subcircuit

*

* This is the circuit
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X1 in out 0 divider top=9K bot=1K

V1 in 0 pulse(0 1 0 .5m .5m 0 1m)

* This is the subcircuit

.subckt divider A B C

R1 A B {top}

R2 B C {bot}

.ends divider

.tran 3m

.end

5.4.23 MESFETトランジスタ

Symbol Names: MESFET

Syntax: Zxxx D G S model [area] [off] [IC=<Vds, Vgs>]

MESFETトランジスタは、その特性を規定するためのモデル・カードが必要です。

モデル・カードのキーワード NMF と PMFは、トランジスタの極性を規定します。

MESFETモデルは、H. Statz et al., GaAs FET Device and Circuit Simulation in SPICE,

IEEE Transactions on Electron Devices, V34, Number 2, February, 1987 pp160-169に記載

されている GaAs FETモデルを用いています。

二つの抵抗 Rdと Rsが、含まれています。電荷蓄積は、ゲート・ドレインとゲート・

ソースの関数として全ゲート電荷によってモデル化されています。それは、パラメータ

CGS、CGDと PBによって定義されています。

名称 パラメータ 単位 デフォルト

VTO ピンチオフ電圧 V -2.

BETA トランスコンダクタンス A/V/V 1e-4

B ドーピング拡張パラメータ 1/V .3

ALPHA 飽和電圧パラメータ 1/V 2

LAMBDA チャネル長変調 1/V 0

RD ドレイン抵抗 Ohms 0

RS ソース抵抗 Ohms 0

CGS ゼロバイアス G-S接合容量 F 0

CGD ゼロバイアス G-D接合容量 F 0

PB ゲート接合ポテンシャル V 1

KF フリッカ雑音係数 none 0

AF フリッカ雑音指数 none 1

FC 順バイアス空間電荷係数 none .5

表 5.30 MESFETパラメータ
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コントロール・パネル

6.1 コントロール・パネルの起動

コントロール・パネルを起動するには、メニュー・コマンド Tools=>Control Panelを

使います。そこで LTspice/SwitcherCAD IIIの多くの点を変更できます。

6.2 圧縮

LTspiceは、再生できるように生のデータファイルを圧縮します。圧縮されたファイル

は、圧縮前のファイルに較べ５０分の一にすることが出来ます。この圧縮は、削減される

圧縮です。コントロールパネルのこれについての窓は、どの様に削減して圧縮するかを制

御します。

Window Size(No. of Points): 二つの終端点へ圧縮する点の最大数

Relative Tolerance: 圧縮データと非圧縮データで許容される相対誤差

Absolute Voltage tolerance[V :] 圧縮アルゴリズムで許容される電圧誤差

Absolute Current tolerance[A :] 圧縮アルゴリズムで許される電流誤差
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これらの圧縮に関する設定は、デフォルトの設定が用いられるため、プログラムを起

動し直すと再現されません。これらは、修復目的のコントロール・ウインドウ上で有効で

す。許容とウインドウのサイズは、回路図上の spiceコマンドとして置かれている.option

記述の中のオプションパラメータ plotreltol、plotvntol、plotabstol、plotwinsizeで設定で

きます。

図 6.1 File Size Vs Fidelity study

6.3 機能

図 6.2 機能パネル

アステリスクが付いている設定は、プログラムが起動している間記憶されています。
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Marching Waveforms シミュレーションが進行しているとき、進行するたびに結果を表

示することが出来ます。

Generate Expanded Listing サブサーキットを展開した後、フラットなネットリストを呼

び出します。

Open Demo circuits as regular schematics /SwCADIII/lib/app/*.appのデモ回路を開く

ため [File][Open]を用います。全ての SPICEコマンドは、可視状態となります。

回路図は、編集できるようになり、新しいファイルとして保存できます。ダブル・

ドット..は、デモ回路表示制御用途です。一つのドットは、編集のために必要です。

Don’t warn when using preliminary models 以前の全てのモデルに対して警告メッセー

ジを出しません。全ての SMPSモデルは、認められないとして予備のモデルと同

じように警告されます。

Automatically delete .raw files シミュレーションを閉じた後に自動的に波形データ・

ファイルを消去します。これは LTspiceによって用いられたディスク・スペースを

劇的に減少させます。しかしシミュレーションを再開するとき、もう一度走らせる

必要があります。

Automatically delete .net files 回路図が閉じられるときに、自動的に回路図ネットリス

トを消去します。これらのファイルは、小さなテンポラリ・ファイルと見なされ

ディレクトリが閉じられるときに消去されます。これらは、LTspiceシミュレータ

に対し電気的接続を定義します。さらにそれらの回路を用いたいと思っている人

は、それらを消去したがりません。

Automatically delete .log files シミュレーションが閉じられるときに、自動的にシミュ

レーション・ログを消去します。これらのファイルは、様々なシミュレーションの

計算時間などの統計データや step/.temp/.dc解析で用いられたステップ・パラメー

タなどが含まれています。

Directory for Temporary Files 波形の一時的な蓄積データやアップデータファイルなど

のディレクトリです。

6.3.1 デフォルトの保存

これらの設定は、どのノードがシミュレーションで保存されたかを明示的に示さな

いときに用いられます。便利な設定は、”Save Device Currents”、”Save Subcircuit Node

Voltages”および”Save Subcircuit Device Currents”です。デバイス電圧や内部素子電圧は、

内部プログラム生成において役立ちます。
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図 6.3 デフォルト設定

Save Device Currents これをチェックしますと、素子および端子の電流を描くことが出

来ます。

Save Subcircuit Node Voltages 階層設計で電圧を描くときにはチェックする必要があり

ます。

Save Subcircuit Device Currents これは出力.dataファイルの大きさを減少必要があると

き、トランジスタのコレクタ（ドレイン）電流のみを保存します。この機能は IC

設計において役に立ちます。しかしトランジスタの消費電力を計算するのに十分な

データがないときの手段として用います。

Don’t save IB(), Ie(), Is(), Ig() これをチェックしますと、素子および端子電流を描くこ

とが出来ます。消費電力を描くためにも用いられます。

6.3.2 SPICE

この窓は、LTspiceの様々なデフォルトを定義できます。これのデフォルトは、シミュ

レーションのオプションを規定することによって、任意のシミュレーションにおいて上書

きされます。通常これらのオプションをそのままの状態でほっておくことが出来ます。も

しウエッブ上でしばしばプログラムをアップデートするなら、現状推薦の設定へリセット

するため Reset to Default Valuesを押す必要があります。
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図 6.4 SPICE

変更したいと思う一つのデフォルトは、Trtolでしょう。ほとんどの市販 SPICEプログ

ラムのデフォルトは、この値を 7としています。LTspiceでこのデフォルトは、1です。

その結果MSPSマクロを用いたシミュレーションは、その波形でのシミュレーション結果

を示すよりも少ない結果となります。シミュレーションに直接影響するよりも、Trtolは

時間ステップにより多くの影響を与えます。トランジスタ・レベルでのシミュレーション

に対して、1より大きな値は、通常良い結果を全体の解に与えます。シミュレーション精

度に影響を与えることなく Trtol を増加したいのであれば、速度が 2xとなることが分か

るでしょう。Trolは、プログラムを起動する間記憶しています。しかし通常の SPICE許

容パラメータ gmin、abstol、reltol、chgtol、vntolのほとんどは、プログラム起動の間記憶

していません。もしデフォルト値とは違うパラメータを用いたいのであれば、用いたい値

を規定するため.optionを書かねばなりませんし、回路図上にそれを置く必要があります。

あるいはファイル.incを設定する必要があります。

またどの解析器が用いられるかと言うことに興味があります。LTspiceは、SPICEの二

つの完成されたバージョンが含まれています。一つは、通常の解析器で、もう一つは変形

された解析器です。変形された解析器は、丸め誤差を少なくする異なったスパース行列

パッケージを用いています。特に変形された解析器は、通常の解析器より半分の速度でシ

ミュレーションしますが、千倍の内部精度を持っています。これは、役に立つ手法となり

ます。解析器が用いている特別な.optionはありません。選択はネットリストが、展開さ

れる前に行われなければなりません。というのも二つの解析器は、別の構文解析を行うか

らです。

LTspiceが 4K99を 4.99Kとして認識するように Accept 3K4 as 3.4Kにチェックを入れ

て下さい。通常の SPICEは、このことを認識しません。しかし LTspiceは、一般的な要

求として認識が可能です。
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6.3.3 ネットリスト・オプション

Convert µ to u 全ての µ を uへ変換します。餅ウインドウがギリシャ語の Mu（例えば

中国語のウインドウズ版では、デフォルトのフォントで表示できません）を表示す

ることが出来ません。1e-6倍として µ 文字を認識しない SPICEシミュレーターの

ネットリストを生成します。

Reverse comp. order 回路素子は、通常順番にネットリストに変換され回路図に付け加

えられます。このボックスをチェックしますと、この順番が逆になります。

Default Deviceダイオードが LTSPICE回路図に用いられているときはいつでもデ

フォルト・モデル記述 .model D Dは、ネットリストに付け加えられ、デフォルト・

モデルを用いることについてのメッセージを抑圧します。このオプションのチェッ

クをはずすことによりバイポーラ、MOSFETおよび JFETトランジスタと同様に

この記述を含まないようになります。

Default Devices ダイオードが LTspice回路図において用いられるときはいつでも、デ

フォルト・ライブラリ standard.dioは、.lib 記述によってシミュレーションに含ま

れます。このチェックをはずしますと、バイポーラ、MOSFETおよび JFETトラ

ンジスタのアナログ・ライブラリと同様にこのライブラリを含まなくなります。

Convergence Aids 内部プログラムに対してのみの用法

図 6.5 ネットリスト・オプション

6.3.4 ハック

この窓は、内部プログラム展開のために用いられます。しかし現在ではほとんど使われ

ていません。

通常このままの状態で放って置くことが出来ます。ウエッブ上でアップデートを度々行

うようでしたら、現状の推奨設定をリセットするために Reset to Default Valuesを押すこ
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とが出来ます。

図 6.6 Hacks

6.3.5 描画オプション

図 6.7 描画オプション

Allow direct component pin shorts 通常素子に直接ワイヤを描くことが出来ます。ピン

を短絡している部分のワイヤを消去します。これをチェックしますと短絡したワイ

ヤは、自動的に消去されることはありません。

Automatically scroll the view このボックスをチェックしますと回路図スクロールを見え

るようにし、回路図を編集する間、端を閉じます。
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Mark text Justification anchor points テキスト・ブロックの参照点を示すための小さい

円を描きます。

Mark unconnected pins 接続されていないことを示すため接続されていないピンに小さ

な四角を表示します。

Show schematic grid points 可視グリッドを開始します。

Orthogonal snap wires Force wiresが、描いている間に垂直および水平に描かれます。

チェックをしなければワイヤは任意の角度で描くことが出来任意のグリッドにス

ナップします。コントロール・キーを押さえますと、ワイヤを描いている間現在の

設定を繰り返します。

Cut angled wires during drags 度絡・コマンドの間直交していない線がワイヤの間にそっ

てクリックすると二つの接続されたワイヤを切断します。

Undo history size undo/redoバッファの大きさを設定します。

Draft with thick lines 全てのライン幅を広げる。出版するイメージを作成するのに役立

ちます。

Show Title Block 内部の用法

6.3.6 インターネット・オプション

図 6.8 インターネット・オプション

コントロール・パネルのこの窓は、ウエッブからのアップデートに用いられます。

LTspiceは、新しい機能とモデルのためにしばしばアップデートされます。現在のバー

ジョンにアップデートするには、メニュー・コマンド Tools=> Sync Releaseを用いて下

さい。もし数ヶ月の間アップデートしないと、LTspiceはアップデートをチェックしない

のですかと尋ねてきます。LTspiceは、許可がなければウエッブに決して接続したりはし

ません。LTspiceは、スパイウエアを含んではいませんし、アップデート中にいかなる

データも転送されることはありません。
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Don’t cache files キャッシュしたりアップデートのためにマシン上のキャッシュ・ファ

イルを用いないようにします。

Don’t verify checksums セキュリティのために LTspiceは、所有のしかも秘密の 128bit

チェックサム・アルゴリズムを用います。それによってアップデートのためウエッ

ブからのファイルを認証します。この認証は、アルゴリズムにエラーがある場合無

効に出来ます。しかしこのエラーについての問題は報告されることはありません。

よってこのセキュリティの設定をはずすことは推奨できません。

LTspiceは、インターネット・アクセスに対して呼ばれる高機能演算システムを用

います。まれな場合を除いてこれらの設定に何らかの調整を加える必要はありませ

ん。プロキシーやパスワードを規定する必要があるとき、LTspiceはインターネッ

ト・アクセスを扱うのではなく、コンピュターやオペレーティング・システムを扱

います。このウインドウ上で設定することは、起動し直すと記憶されません。
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第 7章

FAQ

7.0.7 インストール問題

どの様にして SwitcherCAD IIIをインストールするか

1. http://www.linear.com/softwareへ行き、swcadiii.exeを自分のパソコンの一次ディ

レクトリへダウンロードします。

2. swcadiii.exeを走らせますとインストールできます。

ウインドウの中国語版を使っています。ギリシャ語のMuが巧く表示できません。どうし

たらよいでしょうか。

この問題については、LTspice/SwCAD IIIの現在のバージョンで完全に解決していま

す。メニュー Tools=>Control Panel=>Netlist Optionsの Convertµ to uをチェックする

ことが出来ます。このオプションはネットリストに適用されるばかりでなく、スクリーン

上に表示するときにギリシャ語の Muを uとして描画します。

7.0.8 プログラム・アップデート

もっとも新しいバージョンをどうしたら手に入れることが出来るでしょうか。

一度インストールしてしまいますと、最新のバージョンを手に入れる二つの方法があり

ます。Installattion Problemsに記述してある同じ方法で再インストールすることが出来ま

す。インストールする前に、古いバージョンを取り除く必要はありません。もしパソコン

がインターネットに接続されていれば、Sync Releaseを用いて最新のバージョンを簡単に

インストールすることが出来ます。

新しい機能が追加されたことは、どの様にすれば分かりますか

最新のバージョンにアップデートした後、ルート・ディレクトリの changelog.txtファ

イル、通常 c:\Program Files\ltc\swcadiii\Changelog.txt\verb、は詳細なプログ

ラム変更リストが記述されています。

Sync Release の後古いバージョンへ戻すことが出来ますか

元に戻すことは、出来ません。全てのシンボル、モデルやプログラムは、新しいモノに

アップデートされています。SyncReleaseを始める前に、バックアップ・コピーを取って
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おく必要があります。部品データベース、標準は新しいモノで置き換えられます。もし新

しいインダクタや容量を付け加えたとき、この素子が保存されプログラム・アップデート

によって新しいモノに置き換えられます。ローカルで動作しているファイルは影響されま

せん。

7.0.9 トランスフォーマ・モデル

どの様にしてトランスフォーマ・モデルを構築するか

回路図上で SPICE素子として置かれている相互インダクタンス記述を持った結合イン

ダクタのモデルを描くのがもっとも良い方法です。詳細は、mutual Inductanceの所を見

て下さい。相互インダクタンスのインダクタンスは、位相表示用のドットを付加して描か

れます。

次の例は、1 : 3巻き線比（1 : 9インダクタンス比）のトランスフォーマを正弦波入力、

0.1 [ms]時間シミュレーションを行った例です。K は、1としトランスフォーマには漏れ

インダクタンスがないことを示しています。

7.0.10 他社モデル

ここでは、他社のモデルを LTspice/SwitcherCAD IIIに付け加えるための基礎について

説明しています。

基本的に他社モデルには、二つのタイプがあります。.MODEL 記述となっている

か.SUBCKT記述で定義されています。

.MODEL記述で与えられるモデルは、ダイオードやトランジスタのような本来の SPICE

素子です。.MODEL記述は、規定された成分のパラメータを与えます。素子の振る舞い

は、あらかじめ SPICEによって分かっています。素子の電気的特性を規定する必要があ

ります。

一方.SUBCKTによって与えられているモデルは、SPICE素子の回路の集まりによっ

てモデル化された素子を定義しています。例えば、opampの SPICEモデルは、サブサー

キットとして与えられます。

LTspiceにモデルを組み込む方法は、そのモデルが.MODEL記述あるいは.SUBCKT記

述であるかと言うことに依存します。

.MODEL記述を用いて定義される NPNトランジスタの例

1. シンボル NPNの特性を.MODEL記述に付け加える。

2. 値 NPNを編集し、目標の.MODEL記述に用いられている名前に近い BC547Cと
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する。

3. 次のいずれか

（a）回路図上で SPICE指標として.MODEL BC547C...記述を付け加えるか

（b）.MODEL BC547C...（その他のモデルは、このファイルに多数含まれている）

を含んでいる bipol.lib ファイルを持っているなら、回路図上の SPICE指標

に.INCLUDE bipol.libを付け加えます。bipol.lib は、拡張子を持った完全な

ファイルでなくてはなりません。ウインドウズ・エクスプローラは、デフォル

トでは拡張子を表示しません。もし bipol.lib.txt、これは notepadで演習・閲

覧が出来ます、ウインドウ・エクスプローラが、そのファイルを bipol.lib.sub

と表示している場合、SPICE表示がこのファイルを.inc bipol.sub.txtとインク

ルードしますとこのファイルを用いるときファイルが見つからないと言うエ

ラー・メッセージを受け取ることになります。あるいは

（c）代わりに.MODEL BC547C...記述を次の既にあるファイルに付け加えること

が出来ます。C:\Program Files\LTC\SwCADIII\lib\cmp\standard.bjt.

もし付け加えたるとすると、NPNトランジスタを編集にため選択するときに、

自動的にモデルを見ることが出来るでしょう。もしこの standard.bjtファイル

を LTspiceの外部で編集するならば、ファイルが変更されたと言うことを検知

させるため LTspiceを再起動する必要があります。

５ピン opampの例

この回路は、.SUBCKT記述で定義されます。

1. 回路図にシンボル opamp2の図を付け加えます。

2. 値 opamp2を編集し.SUBCKTの名前と一致する TL072とします。

3. あるいは

（a）.SUBCKT TL072 ... .ENDS定義を回路図上に複数行の SPICE記述として張り

付けます。

（b）サブサーキット TL072（.SUBCKT TL072...として始まる行を含んでいる）

の定義を含んだ TI.lib と呼ばれるファイルがあるならば、SPICEディレクト

リ.INCLUDE TI.lib を回路図に加えます。

新しいシンボルを作成し、シミュレーションに必要なモデルを自動的に含ませるため

プログラムすることが出来ます。ヘルプセクション Schematic Capture=>Creating New

Symbolsを見て下さい

３ピン NPNトランジスタの例、.SUBCKT記述で定義されている。

1. シンボル NPNを回路図に付け加えます。

2. 新しく置かれたNPNシンボルの上にカーソルを移動します。<Crtl>RightMouseButton

を押します。ダイヤログボックスが現れます。プレフィックス QNをプレフィッ

クス X へ変更します。これはバイポーラ・トランジスタをサブサーキットとして

ネットリストへ認識させます。

3. 値 NPNを編集し、BFG135とし、.SUBCKT行の名前と一致させます。

4. それから

（a）回路図に.SUBCKT BFG135行を付け加えるかあるいは
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（b）.SUBCKT BFG135...を含む Phil.libファイルがあるなら（このファイルに多

数の素子が含まれていても構わない）コマンド行.INCLUDE Phil.libを付け加

えなければいけません。

LTspiceに.SUBCKTモデルを付け加える一つの点は、同じピンや端子を持つネットリ

ストのサブサーキットやモデルを呼び出すために用いるシンボルがあることです。上記の

例では、一般的なピン番号順となっている他社のモデルを仮定しています。

さらに詳しい情報は、Schematic Captureや LTspiceヘルプにあります。基本的な考えは、

回路図描画プログラムは、LTspiceが読み込むシミュレーション用のネットリストを作成し

ます。他社モデルをインポートするいくつかの点は、SPICEネットリスト・シンタックス

を理解することによって解決することが出来、どの様に回路図入力プログラムがそのシン

タックスを発生しているかを理解することが出来ます。このトピックスについてのチュー

トリアルが、独立のユーザー・グループ http://groups.yahoo.com/group/LTspiceに

あります。

7.0.11 インダクタ・モデル

どの様に結合インダクタを設計すればよいか

最初に少なくとも二つのインダクタを描きます。次の二つのインダクタの係数 K を定

義します。mutual inductanceを参照して下さい。

どの様にインダクタンス寄生抵抗を制御するか

デフォルトでは、LTspiceは SMPS過渡解析を補助するためインダクタに損失を挿入し

ます。SMPSに対して、これらの損失は、一般にそれほど重要ではありません。もし必要

であるならこの機能を止めることが出来ます。Tools=>Control Panel=>Hacks!のところ

で、Supply a min. inductor damping if no Rpar is givenのチェックをはずして下さい。こ

の設定は、プログラムが起動の間記憶されています。インダクタに対して１ミリオームの

デフォルト直列抵抗もあります。これは相互インダクタンス記述の所では述べられていま

せん。この Rserは SwitcherCAD IIIに対して、回路の線形行列の大きさを減少させるた

めテブナンの等価回路の代わりにノートンの等価回路としてインダクタンスに組み込まれ

ています。この最少抵抗を LTspiceに導入したくなければこのインダクタの Rserをゼロ

に設定しなければなりません。このことは過渡解析の間インダクタの煩わしいテブナン等

価回路を用いるよう LTspiceに要求します。

自分のインダクタ・モデルを付け加え、編集できますか。

C:\Program Files\LTC\SwCADIII\lib\cmp\standard.ind としてインストールさ

れているファイルを開き、インダクタ・モデルを付け加え、編集します。

7.0.12 MOSFETモデル

SwitcherCAD III MOSFETと標準 SPICE MOSFETモデルの違いは何ですか

標準 SPICE MOSFETモデルに対し、SwitcherCAD IIIも他の SPICEプログラムに組み

込まれていない独自の MOSFETモデルを含んでいます。垂直二重拡散 MOSトランジス
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タの電荷動作を直接包含しています。このため他の SPICEプログラムでサブサーキット

として扱っているのとは異なり、VDMOS素子でモデル化された電力素子として扱えま

す。詳細は、models定義を見て下さい。

自分のMOSFETモデルを付け加えられますか

はい。C:\Program Files\LTC\SwCADIII\lib\cmp\standard.mos ファイルのモデ

ルを付け加えることが出来ます。このファイルは、.model記述で定義される素子に対に

てのみ使うことが出来ます。サブサーキットには使えません。もしサブサーキットを用い

たいのでしたら、次のステップに従って下さい。

1. シンボル X の素子特性について、プレフィックス特性を変更します。シンボルは

変更しません、回路図上の成分としての特性を変更します。コントロール・キーを

押して素子の上でマウスを右クリックすればこの特性が見えます。

2. 用いたいサブサーキットの名前を持つ素子の特性値を編集します。

3. .inc filenameのように回路図上の SSPICEディレクトリを付け加えます。このファ

イル名は、サブサーキットの定義が含まれているファイルの名前です。これは拡張

子を含んだ完全な名称でなければなりません。この拡張子は、ウインドウ・エク

スプローラのデフォルトでは表示されません。mylib.sub.txtという名称のファイル

であれば、notepadで編集閲覧することが出来ます。ウインドウ・エクスプローラ

は、mylib.subとしてファイルが存在していることを示します。このファイルを含

む SPICEディレクトリは、.inc mylib.sub.txtです。もし.inc mylib.subを使うとす

ると、ファイルが見つからないと言うエラー・メッセージを受け取るでしょう。

7.0.13 ライセンスと配布

ソフトウエアを再配布できますか

はい、Linear Technologyのお客であってもなくても、このソフトウエアを配布するこ

とが出来ます。詳細は、licenseの所を見て下さい。Linear Technologyのお客様でないと

きの技術サポートは、自由裁量となっています。

シェアウエア、フリーウエアそれともデモ

このプログラムは、シェアウエアやデモではありません。このプログラムは全ての機能

を備えたフリーウエアです。このソフトウエアの目的は、我々の製品を使っているお客を

助けることです。汎用の回路図入力とシミュレーションがある回路設計ソフトウエアとし

て用いることもできます。アナログ回路設計に親しんでもらうため、学生にこのプログラ

ムを用いるよう推奨しています。Linear Technologyに関係のない用法についてのサポー

トは出来ません。しかし全ての一般的なプログラムのバグをなくしたり、そのレポートは

行っています。社内でテストもしておりこのプログラムが優れた収束性を持っていると信

じています。知りうる限りのバグは含まれていません。
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ヘルプのために Linear Technologyとコンタクトできますか

全てのソフトウエア問題については e-mailscad3@linear.com ハードウエア問題につ

いて、例えば Linear Technology ICのアプリケーション・ノート、電話　 Linear Technology

application department (408)954-8400通常営業時間

7.0.14 有効な計算

*.APPと*.ASCの差は何ですか

APPファイルは、回路図ファイルで、計算効率を補助する制御記述が組み込まれその他

の製品情報が含まれています。ASCファイルは、いくつかの SPICEコマンドが無い汎用

の回路図ファイルです。ASCファイルは、より一般的で強力なファイル形式です。設計

を保存するとき、ASC拡張子で保存することを推薦します。

回路図に対して効率のレポートを作ることが出来ますか

回路図上に.TRAN <Time> steady記述を付け加える必要があります。プログラムは、

自動的に LTCマクロモデルの内部状態を調べて、定常状態を検知します。LTCスイッチ

ング・レギュレータ部分が、存在しなければ働きません。回路の中に一つの電圧源がなけ

ればなりません。入力についても同様です。回路の中に一つの電流源がなければなりませ

ん。これは負荷と同じです。シミュレーションが完了した後、回路図上のレポートを見る

ため Viewメニューの Efficiency Reportを選ぶことが出来ます。

7.0.15 カスタム・シンボル

自分のシンボルを作れますか

勿論作れます。

どの様にしてシンボルを作るのでしょうか

メニュー・コマンド File=>New Symbolから始めて下さい。

自分のスイッチング・レギュレータ・モデルを作れますか

簡単ではありません。LTspice/SwitcherCAD IIIと共に出荷されているスイッチング・

レギュレータ・モデルは、LTC のスイッチング・レギュレータ製品の振る舞いを表現す

るため、新しい SPICE素子を使っています。標準的な SPICEモデルを使うとなると、シ

ミュレーション時間は大きくなるでしょう。ある人々は、この様なスイッチング・レギュ

レータ・モデルを標準的 SPICE素子を用いています。LTspiceは、これらのモデルを走

らせることが出来ますが、目標としているシミュレータとは違うパフォーマンスとなり

ます。
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7.0.16 メモリ問題

プログラムを走らせるには、どのくらいのメモリが必要ですか

ウインドウズ　 95, 98, NT4.0, Me,あるいは 2000を走らせるのに十分なメモリが必要

です。ウインドウズ・システムを動かすことが出来れば SwitcherCAD IIIが基本的に動き

ます。このプログラムに必要なメモリを最小にするように多大の努力をしました。典型的

なシミュレーションでは８ギガバイトの生データを生成します。このデータは、４００メ

ガバイトでディスクに圧縮保存されます。一つの軌跡を見るには、６５メガバイト以下の

RAM が必要です。勿論メモリが多いほどパフォーマンスは向上します。またウインドウ

ズ NTや 2000の改善されたメモリ管理は、SwitcherCAD IIIにも有益です。その様なわ

けで、もしメモリが足りなくなるようであれば OSのアップグレードも考えるべきです。

シミュレーション中波形データはどこに保存されていますか

全ての波形データは、ハードディスクに保存されています。マーチング・ウエーブ

フォームをはずすと RAM メモリが少なくて済みます。ほとんどの解析方法で、ファイ

ルの大きさについての制限はありません。非常に大きなギガバイト・ファイルとなる.raw

ファイルを生成し見ることが出来ます。

十分なディスク容量が無く長時間シミュレーションをするとどうなりますか

波形データは、圧縮されます。しかし計算時間に比例し軌跡の数が保存されます。メモ

リ消費を少なくする簡単な方法は、シミュレーションが始まる前に保存する希望の軌跡を

選んでおくことです。

全てを実行しました。メモリを越えて走らせています。どうすればよいでしょうか

過渡解析の間、過去の波形データを 0keyを押すことによってその都度消すことが出来

ます。これは現在の時間としてシミュレーション時間を t = 0とします。

7.0.17 モデル互換性

新しいモデルは、古いモデルと互換性がありますか

常にマクロモデルを改良しています。これらの変更は、通常より正確な素子振る舞いを

するようになります。ユーザには気が付かないで変更がなされています。例えば動作点や

ピン電流が印可されますが、過渡解析波形の変化はそれほどありません。場合によって

は、記号がある特定の環境に対して変更されます。記号の前のバージョンに対して描かれ

た回路図に影響するでしょう。用いた設計やシンボルのバックアップを保存しておくべき

でしょう。

スイッチング・レギュラー・モデルは、PSPICEやその他のモデルと互換性はありますか

シミュレーションをスピードアップするためあるいは収束性を制御するためスイッチン

グ・レギュレータ・モデルに独自のビルディング・ブロックを用いています。一方基本的

に独自のビルディング・ブロックを標準的な SPICE等価ブロックへ変換することが出来
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ます。シミュレーションは数百分の一まで速度が落ちます。パフォーマンスに関して、全

てのスイッチング・レギュレータは、独自のブロックで組み立てられています。そこに変

換器はありません。LTspiceは、Pspice半導体やビヘービア・モデルモデルを走らせるこ

とが出来、高機能なシミュレータです。そこで Pspiceシミュレーションを LTspiceへ移

動することが出来ます。

7.0.18 SPICEネットリスト

SPICE ネットリストをどの様にして作成するか

ネットリストは、ASCIIファイルを作成することが出来る任意のテキスト・ファイル・

エディターで作成することが出来ます。コマンド View=>SPICE netlistで SwitcherCAD

III の任意の SPICEネットリストを見ることが出来ます。この窓から全てのテキストを選

択しネットリストをクリップボードへコピーすることが出来ます。そして Ctrl-Cとタイ

プして、違うエディターへネットリストを持ってくることが出来ます。

どの様にネットリストを走らせるか

最初にテキストファイルを開き、走らせます。LTspice/SwitcherCAD IIIは、.cirの拡張

子が有ればネットリストとしてファイルを認識します。

7.0.19 波形データの出力

他の応用のために波形データを出力できますか

波形表示窓をアクティブとし、Ctrl-Cとタイプすることで描画をビットマップファイ

ルとしてコピーできます。ビットマップを受け入れる wordや Paintの様なソフトウエア

にクリップボードから張り付けるため Crtl-V とタイプします。これは回路図上のビット

マップとしても動きます。これらのイメージはウインドウズ・メタファイルとしても出

力できます。（メニュー・コマンド Tools=>Writeは、.wmfファイルへ）これは様々な

desktop publishing toolsへインポートすることが出来る.wmfファイルへベクター・グラフ

として記述します。波形データのメタファイルを出力するとき、最初に Tools=>Control

Panel=> Waveform=>Fontへ行き、Arial を選んで下さい。デフォルトでは CRTに適切

なフォントが選んでありますが、メタファイルでは正しくスケールされない固定フォント

です。

ビットマップとして動くようですが、Excelの様なアプリケーションにデータそのものを

持ってこれますか

エキスポート・ユーティリティがあります。(Waveform Menu: File=>Export)こ

れはデータを ASCII ファイルで出力します。このほかに Helmut Sennewaltによっ

て書かれた無料のユーティリティがあります。これは独立のユーザー・グループ

http://groups.yahoo.com/group/LTspice から入手できます。このユーティリティ

は、様々な形で出力できます。その結果異なったシミュレーションからの結果を合成する

ことが出来ます。
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7.0.20 Linuxで走らせる

このプログラムの Linux版はありますか

別の特別なプログラムではなく、このプログラムは WINE 上で動きます。このプロ

グラムは、WINE バージョン 20030219を用いて Linux RedHat 8.0、WINE バージョン

20040716を用いて Linux RedHat 9.0、20040716を用いて Linux SuSE 9.1でテストされ

ています。

今までWINEを使ったことがありません。どの様にインストールするのでしょう

使っているシステムに対して WINE の現在のバージョンを見つけるため

http://www.winehq.com をチェックして下さい。これが書かれているとき Red-

Hat 8.0に対して、http://mecano.gme.usherb.ca/~vberon/wine に指摘されていま

す。適切な.rpmファイルをパソコンにコピーして nautilusからそれを開いて下さい。

http://www.linear.com/software から swcadiii.exeをダウンロードします。xterm

で wine swcadiii.exeと実行し、LTspiceをインストールします。gnomeデスクトップ上

に Linear Technology Logoが現れます。それをクリックしてスタートさせるかあるいは

xtermから wine scad3.exeと入力してプログラムをスタートします。

回路図のフォントは、ウインドウズの場合と同じようにWINE 上で滑らかに変更できな

いのはどうしてでしょうか

ウインドウ・システムから native Windows .dllを使ってみて下さい。WINEから LTspice

起動して wine -dll commctrl,comctl32=n scad3.exe

ウインドウズの場合と違ってWINE/Linuxでは少し違っているようですが

LTspiceは、WINE上で動いているかどうかを検知します。もしそうならば、いくつか

のWINEコマンドで動きます。コマンドライン switch -wineで LTspiceをWINEの上で

動かすように出来ます。WINEコマンドとは関係がないようにするには、switch -nowine

とします。

7.0.21 紙のマニュアル

http://LTspice.linear-tech.com/software/scad3.pdf からこのヘルプファイ

ルの pdfファイルをダウンロードすることが出来ますまた必要なら印刷することもでき

ます。

7.0.22 ユーザーグループについて

http://groups.yahoo.com/group/LTspiceに独立のユーザーグループがあります。

このグループは、他のチュートリアル、ライブラリ、例のファイルがあります。





123

付録 A

シンボルの概要

この付録は、LTspiceによって供給されている回路シンボルについて述べています。

A.1 電力製品

A.2 演算増幅器

A.3 その他

A.4 光学アイソレータ

A.5 特別な関数

A.6 フィルタ製品

A.7 デジタル

A.8 比較器




